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PC/FRAM, Version 3.2

User Mgmual

1. Introduction

This section contains general information about the PC/FRAM program, the prerequisites for running that
program, and the contents of the distribution kit.

1.1. General

This manual describes the use of version 3.2 of the PC/FRAM plutonium isotopic analysis software
developed in the Safeguards Science and Technology Group, NIS-5, Nonproliferation and International
Security Division, Los Alamos National Laboratory. The software analyzes the gamma ray spectrum from
plutonium-bearing items and determines the isotopic distribution of the plutonium, >*'Am content, and
concentration of other isotopes in the item. The software can also determine the isotopic distribution of
uranium isotopes in items containing only uranium.

The body of this manual describes the generic version of the code. Special facility-specific enhancements,
if they apply, will be described in the appendices. The information in this manual applies equally well to
version 3.3, which has been licensed to ORTEC.

The software can analyze data that is stored in a file on disk. It understands several storage formats
including Canberra's S100 format, ORTEC's ‘chn’ and ‘spc’ formats, and several ASCII text formats. The
software can also control data acquisition using an MCA and then store the results in a file on disk for later
analysis or analyze the spectrum directly after the acquisition. The software currently only supports the
control of ORTEC MCB’s. Support for Canberra’s Genie-2000 Spectroscopy Systems will be added in the

future. Support for reading and writing CAM files will also be forthcoming.

A versatile parameter file database structure governs all facets of the data analysis. User editing of the
parameter sets allows great flexibility in handling data with different isotopic distributions, interfering
isotopes, and different acquisition parameters such as energy calibration, and detector type.

1.2. Audience

This manual is intended for the system supervisor or the local user who is to be the resident expert.
Excerpts from this manual may also be appropriate for the system operator who will routinely use the
instrument.

1.3. Other Documentation

Various manuals for commercially available electronic and computer components of the data acquisition
and analysis system may be required to support other aspects of data acquisition and analysis. These
manuals are supplied only if the PC/FRAM software is delivered as part of a complete data acquisition
system.
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1.4.

Conventions Used in this Document

The pictures in this document were captured on a system running Windows NT version 4.0.

Most of the text and all of the headings in this document are written with the Times New Roman font.

Names of the menu choices will be written within the text in bold using the Arial Rounded MT font, for
example, File, Edit, Measure, Analyze, etc. -

Placing a vertical bar between the individual choices will denote a sequence of menu selections. For
example, choose the File | Open option.

Directory and file names will be written in bold using the Courier New font, for example, c: \pcfram
and pcfram.ini.

Text that is reproduced from a text file will be written using the Courier New font.

Text that is displayed on the screen either as a message, a dialog box title, or prompt for a control within a
dialog box will be written in bold using the Arial Rounded MT font.

Key combinations are indicated with a plus sign, e.g. Shift+Tab or Ctrl+F4.

1.5. Definitions and Acronyms

CAM Configuration Access Method

CPU Central Processing Unit

DLL Dynamic Link Library.

FRAM Fixed energy, Response function Analysis with Multiple efficiencies. Also, a word of
Scandinavian origin meaning “forward” or “onward.”

FWHM Full Width at Half Maximum.

MCA Multi-Channel Analyzer.

MCB Multi-Channel Buffer.

NIM Nuclear Instrumentation Module.

Parameter Set The group of parameters, constants, and text strings that govern all facets of the analysis.
Each parameter set is stored in the PC/FRAM database during analysis.

Parameter File A parameter set may be exported as ASCII text to a DOS disk file. This disk file is
called a parameter file. It has a default file extension of .pst.

PC Personal Computer, an IBM (or compatible) computer with an Intel-based CPU.
RAM Random Access Memory.
UMCBI Unified MCB Interface.

1.6. New Features in Version 3.2

The users familiar with version 2.2 of PC/FRAM will note the following new features and upgrades in

version 3.2.

1. 32-bit. This is a 32-bit version of FRAM. 1t is designed to run under Windows 95, Windows 98, and
Windows NT.
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2. New user interface. The user interface now has a 3-D look and feel similar to what is used in
Windows 95.

3. New Measure Menu. There is a new option under the Measure menu called Analyze Data. This
combines and replaces the old Analyze | Single Spectrum and Analyze | Autocycle options.

4. Bi-lingual support. There is a new option called Language under the Options menu. It allows the
user to choose one of two languages to be used when displaying information on the screen. The
character strings to be displayed are stored in one of two language files. Currently we support English
and Russian as the two languages. But this can be easily extended to other European languages.

5. New Database format. The analysis parameters are stored in a database using a different format.

This format is not compatible with previous versions of FRAM. The distribution kit does not contain
an “empty” database as it did for version 2.2. The new version of PC/FRAM creates the necessary
files when it is first executed.

6. New results display. The results are displayed in a different type of window.

1.7. System Requireinents

PC/FRAM is designed to run best on an IBM (or compatible) PC with a Pentium processor running at a
speed of 200 MHz or greater. PC/FRAM has run successfully on lower end machines and machines with a
slower CPU.

A math coprocessor is required.
The PC should have at least 32 MB of RAM

The program requires a minimum of 4Mb of free space on the disk. In order to have room for saving
spectra and results, the system disk should have several hundred Mb of space.

The system must have a 3.5” diskette drive.

The system must be running under Microsoft Windows 95, Windows 98, or Windows NT.

1.8. Distribution Kit

The distribution kit for PC/FRAM consists of three diskettes.

Diskette #1 contains a batch file (install .bat) for installing PC/FRAM, a self-extracting compressed
file (Eram. exe) containing all the necessary files for munning PC/FRAM, and a text file (readme. txt)
containing instructions for installing PC/FRAM. These instructions are reproduced below.

Diskette #2 contains a collection of fonts with Cyrillic character support in case you need to “Russify” your
American computer. Instructions for doing so are found in the file readme. txt.

Diskette #3 contains an electronic copy of this User Manual and a collection of special parameter sets. The
information for each parameter set is stored in textual form in a separate file.

Instructions for instaliing PC/FRAM version 3.2
1. All the files will be placed in a directory "c:\fram32".
If you already have such a directory, you are advised to

rename it.

2. Place diskette #1 into the appropriate drive.
Click on the Start button in the lower left-hand corner of the
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screen. Then select the Run... option. Type a:\install then
click on the OK button.

3. The batch file install.bat will be executed within a special
DOS window. When the installation is complete, you will need to
close this window.

Instructions for "Russifying" your American computer if you are
running Windows 95 or Windows 98

1. Copy all the font files from Diskette #2 to the folder
c:\fram32\fonts

2. Close Windows and startup in DOS-mode.
The prompt "C:WINDOWS>" will appear.

3. Type the command "cd fonts" and press the Enter key.
The prompt "C:\WINDOWS\FONTS>" will appear.

4. Type the command "mkdir savefon" and press the Enter key.
5. Type the command "attrib ~h -s *.fon" and press the Enter key.
6. Type the command "copy *.fon savefon\*.*" and press the Enter key.

7. Type the command "copy c:\fram30\fonts\*.fon *.*" and press the
Enter key. The message "Overwrite 8514FIX.FON (Yes/No/All)?" will
appear. Type A and press the Enter key.

8. Type the command "attrib +h +s *.fon" and press the Enter key.

9. Type the command "cd .." and press the Enter key.

10. Type the command "win" and press the Enter key.

1.9. Configuration

There is a configuration file, pecfram. ini that contains much of the default information needed for
running PC/FRAM. It contains information of a general nature such as the maximum size of spectral data
arrays, default path names, the type of MCA to expect, and the template for reporting dates. All the
information in this file can be accessed and modified within the PC/FRAM program. The file is in text
format and can be edited directly by using Windows Notepad or Wordpad programs.

The language files provide some configuration information with regard to the display of character strings.
They specify the font to be used for displaying strings in various situations. This file is also in text form
and can be easily edited.

The user authorization file contains a list of authorized users, their passwords (in encrypted form), and the
level of access granted to each. The information in this file can be modified by means of the Edit | User
List option (cf. Section 3.4.8).
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2.

Getting Started

This section describes the steps required for installing and configuring PC/FRAM for the first time. These
initial actions seldom require any changes once the software is in operation. In this section references are made
to other sections of the manual that contain more detailed information.

Before Running PC/FRAM

The first step is to install the software. Then you need to consider several issues connected with
customizing the software.

2.1.1. Installing Software

Please read the instructions for installing PC/FRAM. If you already have a directory labeled

c: \fram32 you are advised to rename it to something else. The batch file that does the installation
creates a directory by this name along with several subdirectories and then copies some files to the
main directory.

Follow the instructions by invoking the batch file install .bat on diskette #1 of the distribution
kit. Then close the DOS window and remove the installation diskette. PC/FRAM is now installed on
your system! '

Before you every run PC/FRAM, there are several questions you should ask. Do you need to change
the default fonts used for displaying text on the screen? Do you need to establish a different working
directory? Do you want a shortcut, or icon, for invoking the program?

2.1.2. Selecting Fonts

The distribution kit provides support for either English or Russian. This is done by storing all the
character strings in a language file. English strings are found in the file pcfram. 1st while Russian
strings are found in the file pefram.2nd. The names of the fonts to be used for displaying strings
are retrieved from the corresponding language file. There are four different situations where strings
can be displayed. The first and most important is the display of text in the menus and in each of the
dialog boxes. The second is the display of the results of an analysis in a special text window. The
third is the display of titles within a special plot window. The fourth is the printing of text on your
system printer. Four lines in each language file specify the font to be used in each of these situations.
The following is a copy of the lines in pcfram. 1st that specify the default fonts used for displaying
text in English.

szFonDialog, "MS Sans Serif, 10"

szFonDisplay,Courier
szFonPlot,MS Sans Serif

szFonPrint, "Courier, 8"

In the Russian language file, the default font specified for printing is FixHelvDL (with a size of 10)
instead of Courier. If you are going to run PC/FRAM in English, the default fonts will work just fine.
However, if you want to run PC/FRAM in Russian you must do one of two things. The first
alternative is to change these fonts so that they support Cyrillic characters. See the section 2.1.3 for
information on how to do this. The second alternative is to edit the language file so as to specify a
different font. The next paragraph contains information helpful in doing this.

The information in a language file is divided into several groups. Each individual piece of information
in a group is a line that consists of an identifier followed by a comma then followed by a text string.



PC/FRAM-UM-006 PC/FRAM User Manual February 23, 1999

250

The four lines reproduced above serve as an example. In the “font” section the text string following
the comma will be the name of the font to use. The language file is in text format, so you can edit this
file with Notepad or Wordpad and substitute another font name for the one provided for you.
Remember that the font with the name you supply must be installed on your system. If this is not the
case, PC/FRAM will use a default system font.

2.1.3. “Russifying” Your Computer -

The system fonts that come with American computers do not have support for Cyrillic characters. If
you want to have a Russian version of PC/FRAM that utilizes the common system fonts, you will need

to replace your system fonts with ones that do support Cyrillic characters. To do this, follow the
instructions in the file readme. txt that is reproduced in section 1.8.

2.1.4. Changing the Working Directory

If you move the PC/FRAM files to a different directory or rename the working directory to something
else, use Notepad or Wordpad to edit the configuration file, pcfram.ini. You need to modify the
following four lines by replacing c: \ fram32 with the path name of the new directory.

mcb_log path = "c:\fram32\mcberr.log"
pcfram path = "c:\fram32\"
save_spectrum path = "c:\fram32\spectra"
save_results _path = "c:\fram32\results"

You could also accomplish this from within PC/FRAM by invoking the Edit | General Defaults
option. See section 3.4.2 for more details on using this option.

2.1.5. Creating an Icon

You can create a shortcut to PC/FRAM by using Explorer to locate the file fram32.exe in the
working directory. Select this file then drag it to the desktop. Now use the right mouse button to click
on this icon. Choose the Rename option from the menu. Use the keyboard to enter “PC FRAM V3.2”
then press the Enter key.

Running PC/FRAM for the first time

Run PC/FRAM by double clicking on its icon that was established during the installation procedure. The
first time you run PC/FRAM two information dialog boxes will appear. The first will tell you that a user

authorization file was created for you. The second will tell you that a database was created for you.
Eventually, the following window will appear on the screen.

S PC/FRAM 3.2 ' T ®EFE

x
b
3
i

File - Edit - Measure - p

2.2.1. Main Menu Overview

Presented below is a brief description of the functions provided by PC/FRAM’s main menu.

File This menu allows you to open a spectral data file and read it into memory and to save
spectral data into a file on disk. It also allows you to exit from PC/FRAM.
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Edit

This menu allows you to edit the parameters in the parameter sets, to establish default
values for various dialog boxes, and to establish passwords and access rights for different
users.

Measure This menu allows you to acquire a spectrum from a multi-channel analyzer under the

Options

control of the PC/FRAM program. This ¢ould be followed by an analysis of the
spectrum collected. These operdtions require the installation of the appropriate hardware
and its associated software drivers. This option also allows you to analyze spectra from a
disk file or a series of disk files. .

This menu allows you to view a display of the spectral data being analyzed or opened by
the program. It also allows you to display, region by region, the calculated background
and fit to the net data for the last spectrum analyzed. You can also choose to view the
relative efficiency curve and its fitting residuals while another suboption permits you to
print the results of the last analysis at any desired print level. You can also retrieve the
results files from previously analyzed spectra as well as run a program that updates and
decay corrects a plutonium isotopic distribution. There is also an option for choosing
one of two languages to be used for the display of information on the screen.

Help This menu allows you to see a screen with the name and version number of the program
along with copyright information.
2.2.2. Importing Parameter Sets

When PC/FRAM is run for the very first time an “empty” database is created. It is very important that
you populate the database with some parameter sets. The distribution kit comes with several sets of
analysis parameters each in its own text file. These files all have an extension of “.pst”. These
parameter sets and their applicability are described in Appendix C. The following procedure shows
you how to import one or more of these parameter sets into the database.

From PC/FRAM’s main menu select the Edit | Parameters option.

| File. [0 Measite”.Op

arameters

P

fions:- Help

B General Detault
R t»"’,'“"‘:ff
[ File Open Defaults:

File Saye Defaults -,..", -

Measiire Sample Defaits

# Acguire Data Defauits .

S8

0yt Aty g

el o Sl as - “

A dialog box entitled User Validation will appear on the screen.
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Click on the OK button to dismiss this dialog box. A password is not required because the user

authorization file created by FRAM contains a record with a “null” user name and a “null” password
(cf. Section 3.4.8).

You will now be in the Change Parameter Utility, and it has its own menu. From this menu select
the File | Import option.

2 C e Parameter Utilit

Click on the Browse... button. Windows will activate the standard File Open dialog box. Use it to
select one of the parameter set files supplied with the distribution kit. Note that during installation all
the parameter sets on the distribution diskette were copied to the subdirectory
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c:\fram32\paramset. Now click on the OK button to dismiss the File Open dialog box. The
dialog box entitled Import Parameter Set will reappear. Click on the OK button to dismiss this
dialog box. Another dialog box entitled Save Parameter Set will appear on the screen. The
picture below serves as an example.

= Save Parameter Set l
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Fill in the name you wish to use to identify the parameter set. The name may be any combination of
alphanumeric characters (up to 30). Names longer than 18 characters may not be displayed fully in
some of the dialog boxes. You may also change the description that is associated with the parameter
set, but this is not recommended. Then click on the OK button. An information dialog box will
appear telling you that the parameter set has been saved. Either click on the OK button or wait 5
seconds for the dialog boxes to disappear.

If you want to import another parameter set, choose the File | Close option, then repeat the preceding
steps starting with the selection of the File | Import option. See section 4.1.10 for more information
on importing parameter sets into the database.

Select the File | Exit option return to PC/FRAM’s main menu.

2.2.3. Setting General Defaults

You also need to make sure that the general defaults are set properly. From PC/FRAM’s main menu
select the Edit | General Defaults option. A dialog box entitle User Validation will appear on
the screen. Click on the OK button to dismiss this dialog box.

A dialog box entitled Edit General Defaults will appear on the screen. The following picture will
serve as an example. The information in this window proved the default settings. You may change
any of these to suit your own situation. The picture below shows the dialog box that appears in
version 3.2. In version 3.3, licensed to ORTEC, the set of radio buttons at the bottom is replaced by a
single button with the title ‘Default MCB’.

You should change the system ID to something more meaningful.
You should choose the MCA type to match the hardware on your system.

You might want to change the date template if you are used to displaying dates in a different manner.
The template provided specifies dates with a two-digit day followed by a dash followed by a three-
character month abbreviation followed by a dash followed by a four-digit year. You must specify a
four-digit year in your template. See section 3.4.2 for more information about modifying fields in this
dialog box.
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224 Setting Passwords

‘When PC/FRAM is run for the very first time, a user authorization file is created with four default user
records. These are described in section 3.4.8. If for some reason you need to modify these or if you

need to add other user records, select the Edit | User List from PC/FRAM’s main menu. A dialog
box entitled User Validation will appear on the screen. You need to enter the name and password of
a user that has Manager privileges. Then click on the OK button to dismiss this window.

A table will appear on the screen. It will display information about all the user records that are in the
user authorization file. You may edit the information in this table to reflect your own situation. Then
click on the OK button to dismiss the dialog box and have the changes take effect. See section 3.4.8
for more information on how to modify the information in this table.

2.3. Analyzing Spectral Data

The following procedure shows how to analyze a spectrum stored in a disk file. Itis assumed that you
have already imported the appropriate parameter sets into the database.

Choose the Measure | Analyze Data option.

EX PCIFBAH 3.2 s §

10
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The Analyze Data dialog box will appear on the screen. The initial settings of the parameters may vary
depending on how the default parameters have been set.

f = Analyze Data

7 Starage Format NIS-S standard [}

ParameterSet coaxamés ‘ {;"" ‘
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In the input section, enter the filename in the File: box or click on the Browse... button to find the
filename for the spectrum to be analyzed.

Choose the Storage Format from the pull down list or keep the default.
Choose the Parameter Set from the pull down list or keep the default.

This completes the minimum required information to analyze data from a disk file. The short output that
appears on the screen will be described later. If you want a printout of the results, check the Print
Results box in the Output section and select the Short radio button.

The Sample Power box in the Input section is used only if you wish to analyze a spectrum from an item
previously measured in a calorimeter. Otherwise you ignore and leave the default value of zero alone.

For uranium analyses both the Sample Power and the Pu242 by comrelation entries should be ignored.

To proceed with the analysis click on the OK button. Just below this button you will see information about
the analysis as it progresses. When the analysis is done, a summary of the results will be displayed on the
screen in a special text window. An example of a results window is shown in section 3.6.4. To dismiss this
window you need to click on the X in the upper right hand corner of the window or press the key
combination Ctrl+F4.

NOTE! with appropriate use of defaults, an analysis can be initiated with only two data entries —
File and Operator ID.

1
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3. Operations Reference

3.1. Startup

To invoke the program from the desktop, double-click on the icon that was established during the
installation procedure. The alternative to use Explerer to locate the file fram32.exe in your working
directory and then double clicking on that entry.

3.2. Software Controls

The major software controls provided by the program are implemented in terms of a menu system. You
may choose any of the options presented by the menus. These options are grouped into five top-level
menu headings. The following is the top-level menu structure presented to you after invoking the program.

The main features of the five top-level menu options have been discussed in section 2.2.1. The sections
below describe these options in detail.

3.3. File

The File menu can be expanded by clicking on the word File with the mouse or by pressing the key
combination Alt+F. The following picture shows the options available under the File menu.

ES PC/FRAM 3

2

33.1 File | Open

This option allows you to read spectral data from a disk file into memory. The following dialog box
will appear on the screen.

12



PC/FRAM-UM-006

PC/FRAM User Manual February 23, 1999

I W -~y gl
+ S Ziom b SR i o ¢ 95

[Efietpen [ K

RSP L P S

IS

-5 standard

N S T

File:

Storage Format:

Open

Cancel/Exit

Enter the specification (including path, name, and extension) for the
file to be opened. You may click on the Browse... button and use the
standard Windows dialog to search for the file to be opened.

You must select the data storage format of the selected file from the
choices given. If the wrong format is chosen an error message will
appear when the program attempts to read the data from the file.

Click on this button to open the specified data file. If there is an error
in opening the file, a message will appear in the large box at the bottom
of the window. If the file is opened successfully, the Cancel button
will be renamed to Exit. Information about the spectrum will also
appear in the large status box at the bottom of the window.

Click on this button to exit from the dialog box and return to
PC/FRAM’s main menu.

If you choose the ORTEC “spc’ storage format, a miessage box will appear on the screen asking you if
you want to load the parameter values stored in the file into memory. If you answer yes, an active
worksheet will be created and filled with that parameter information. A flag will also be set indicating
that there is an active worksheet open. The effect is the same as if you had opened a parameter set and
chosen the Edit | Postpone Editing option. See sections 3.3.3 and 4.2.6 for the consequences of

this.

After opening a file, you can plot the spectrum by choosing the Plot Spectrum option from the
Options menu or perhaps save the data in a disk file using a different format with the Save As
option. The principle uses of these options are to preview spectra before analysis and to convert among

data formats.

3.3.2. File | Save As

This option allows you to write spectral data from memory to a disk file. It brings up the following

dialog box.

13
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File:

Storage Format:

OK

Cancel

Enter the specification (including path, name, and extension) for the
file where the spectral data will be stored. You may click on the

Browse... button and use the standard Windows dialog to search for a
file name.

You must select the data storage format of the selected file from the
choices given. If you want the spectral data stored in text form, choose
the ASCII storage format. In this case, you need to specify the
character used in separating entries in each row. You also need to
specify how many columns you want.

Click on this button to store the spectral data.

Click on this button to exit from the dialog box and return to
PC/FRAM’s main menu without saving the spectral data.

If you choose the ORTEC ‘spc’ storage format, a dialog box entitle ‘FRAM Parameter Sets’ will
appear on the screen. If you want to store parameter set information with the spectral data, select the
name of the parameter set then click on the OK button. If you do not want to store any parameter
information with the data, click on the Cancel button.

The Save As option allows you to use the program as a data format translation utility, especially
useful because of the flexible ASCII formatting allowed. For example, selecting ASCIl and one
column causes the data to be written in a way that allows you to import it into a spreadsheet program.

3.33. File | Exit

This option closes the PC/FRAM code and returns you to the Windows Desktop. There are two
alternatives to closing PC/FRAM. You may click on the X in the upper right hand comer of the
window. You may also click on the small box in the upper left-hand corner of the window to bring up
a small system menu and then choose the Close option. None of these options will succeed if you
had opened a parameter set in the Change Parameter Utility and then chosen the Postpone Editing
option. Instead the following message will appear on the screen.

14
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= FRAM Message _ ; __H|

In this case you must get back into the Change Parameter Utility and exit in the normal way.

34. Edit

The Edit menu can be expanded by clicking on the word Edit with the mouse or by pressing the key
combination AIt+E. The following picture shows the options available under the Edit menu.

\Geﬁeral Defau:lté'.

F;Ie _pen Defaults e
File Save Defaulis

Acgmre Data Deféuﬁs
Measuré Sarqﬁlé” D’e{éi,xj_i,’ ;
Analﬂe Data Defaults

RERATRRSIN e i - s ¢

3.4.1. Edit | Parameters

NOTE! This password-protected option controls all the analysis parameters and their default
values. This option will be discussed in detail in the Change Parameter Utlhty, section 5, in this
manual.

3.4.2. Edit | General Defaults

General defaults refers to the configuration parameters which govern the environment in which this
program runs. They are stored in the configuration file, pefram. ini. This option allows you to
view and modify these parameters.

This option is protected by the password mechanism (see section 3.4.8). A dialog box entitled User
Validation will first appear on the screen. '
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= User Validation | | X ‘

Enter the User Name and Password of an account, which has been, granted supervisory access and
then click on the OK button. If access is permitted, the General Defaults will appear in a dialog box
just like the one below. You may now edit their values. The picture below shows the dialog box that
appears in version 3.2. In version 3.3, licensed to ORTEC, the group box labeled ‘MCA type’ along
with the enclosed set of radio buttons is replaced by a single button with the title ‘Defanlt MCB”.

x::x Edlt General Defaults

,,‘»Dlskwammgleve! Q\db) 5000' O
1»Drskéntic”ai Ievel (Mb) = 4[][]0 ;

{ RN

""“—-w'w)‘;

Disk warning level (Mb):

Disk critical level (Mb):

Maximum number channels:

Maximum number iterations:

This is the level of free space, in megabytes, on the disk below
which warning messages will appear before new space is
allocated for the creation of output files.

This is the level of free space, in megabytes, on the disk below
which error messages appear and no new space is allocated for
the creation of output files.

The value displayed is set with the horizontal scroll bar. You

may analyze spectra with fewer channels than the setting, but
not more. This is usually set to 8192.

The background, relative efficiency, peak area, and isotopic
results calculations are repeated or iterated. Leave the setting
at 3.
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PC FRAM default path:

Path for Saving Spectra:

Path for Saving Results:

System ID:

date template:

MCA Type:

This is the path to the PC FRAM directory. A default path is
provided when the software is installed. If you change this
path, you must create or make sure the appropriate directory
exists. The program does not create the directory from this
option.

This is the path for storing spectral data files. A default path is
provided when the software is installed. If you change this
path, you must create or make sure the appropriate directory
exists. The program does not create the directory from this
option.

This is the path for storing results files. A default path is
provided when the software is installed. If you change this
path, you must create or make sure the appropriate directory
exists. The program does not create the directory from this
option.

This is a user-specified name (with a maximum of 59
characters) describing the computer/measurement system. It
is used as identification on the printed output.

You may enter a custom template to be used for displaying
dates. The default template shown above specifies a two-digit
day followed by a dash followed by a three-character month
abbreviation followed by a dash followed by a four-digit year.
In this template, a lowercase ‘d’ represents day of the month, a
lowercase ‘m’ represents month of the year as a digit, an
uppercase ‘M’ represents month of the year as a character, and
a lowercase ‘y’ represents the year. Other characters in the
template are reproduced without interpretation.

Note! It is required that you specify a four-digit year in your
date template.

Select the radio button corresponding to type of MCA
connected to your system. If your choice ORTEC MCB, a
dialog box will appear with a list of the MCB’s available to
the system; choose one of these. If you select any of the other
buttons, the error message “This MCA type is not
implemented” will appear in the upper right-hand corner of
the window. If your system is used for analysis only, with no
data acquisition control, the choice of MCA type is irrelevant.

3.43. = Edit | File Open Defaults

The dialog box, which appears, is a replica of the one that appears when you select the Open option
under the File menu. The only difference is that the OK button is labeled Save. You may modify

any information in this dialog box. If you then click on the Save button, these values become the
defaults any time this dialog box is invoked again.

17
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344. Edit | File Save Defaults

The dialog box, which appears, is a replica of the one that appears when you select the Save As
option under the File menu. The only difference is that the OK button is labeled Save. You may
modify any information in this dialog box. If you then click on the Save button, these values become
the defaults any time this dialog box is invoked again.
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3.45. Edit | Acquire Data Defaults

The dialog box, which appears, is a replica of the one that appears when you select Acquire Data
option under the Measure menu. The only difference is that the OK button is labeled Save. You
may modify any information in this dialog box. If you then click on the Save button, these values
become the defaults any time this dialog box is invoked again.
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3.4.6. Edit | Measure Sample Defaults

The dialog box, which appears, is a replica of the one that appears when you select the Measure
Sample option under the Measure menu. The only difference is that the OK button is labeled
Save. You may modify any information in this dialog box. If you then click on the Save button,
these values become the defaults any time this dialog box is invoked again.
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3.4.7. Edit | Analyze Data Defaults

The dialog box, which appears, is a replica of the one that appears when you select Analyze Data
option under the Measure menu. The only difference is that the OK button is labeled Save. You
may modify any information in this dialog box. If you then click on the Save button, these values
become the defaults any time this dialog box is invoked again.
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3.4.8.  Edit | UserList

This option allows you to view and modify the information about the user accounts that is stored in the
User Authorization File. This option is protected by the password mechanism. The following dialog

box will first appear.

. E User Uahdatlon . I

Enter the User Name and Password of an account that has been granted access to the user list then
click on the OK button. If access is permitted, a table similar to the one below will appear on the

screen
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When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <, —>, T, and { keys. You can use the vertical scroll bar at the right of the screen to
view more of the table. Clicking on a cell with a yellow box in it will cause an auxiliary dialog box to

appear on the screen.

The first column displays an index, which serves as a row number for the table.

User Name

password

access rights

This column contains the name associated with each user account. You can
replace the contents of a cell in this column by selecting the cell then typing in
new characters into that cell.

This column contains the encrypted password associated with each user account.
You cannot change the contents of a cell in this column directly. You must
click on the yellow button to the left of the cell you want to change. An
auxiliary dialog box will appear which will allow you to change the password.

This column indicates what access rights are granted to each user. You cannot
change the contents of a cell in this column directly. You must click on the
yellow button to the left of the cell you want to change. An auxiliary dialog box
will appear which will allow you to change the access rights. There are three
levels of access rights designated as manager, supervisor, and operator.
Operator rights have a value of 1, supervisor rights have a value 2, and manager
rights have a value of 4. These access rights may be combined. If this is done,
the number in this column will be the sum of the values associated with the
individual rights used in the combination
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Row Operations:  Rows may be added, deleted, or shifted in the user list. See section 4.2.2.1 for
information on doing this. When editing the user list, the Move this row up
and Move this row down commands can be used to rearrange the rows. See
section 4.2.2.2 for instructions on increasing the number of rows in this table.

To modify a user’s password, click on the yellow box to the left of the appropriate cell in the
password column. The following dialog box will appear.

| 5 Password Change [ X]

Enter the new password in the box labeled New Password then enter the exact same password in the
box labeled Verification. The passwords are case sensitive and the typed characters will be echoed
as asterisks. Click the OK button. If the passwords do not match, an information box will appear with
the error message Passwords do not match. In this event click on the OK button to dismiss the
box, and try again. When the password entry is successful, the above dialog box will disappear and
the encryption of the new password will show up in the cell. If you click the Cancel button to abort
this operation and return to the table, the old password remains intact.

-New Password

To modify a user’s access rights, click on the yellow box to the left of the appropriate cell in the
access rights column. The following dialog box will appear. ’

Check the boxes on the left for the access rights that you want to grant to the user. You may check
more than one box. Then click on the OK button to dismiss this dialog box and return to the user list.
The number in the access rights column will reflect the new access rights that you chose. If you click
on the Cancel button in the dialog box shown above, it will disappear and the old access rights will
remain in effect.

The user authorization file contains a list of authorized users, their passwords (in encrypted form), and
the level of access granted to each. The following records are present in this file when first created

Name Password Access Level

manager manager Manager (can edit list of users)

supervisor supervisor Supervisor (can edit parameters & defaults)
operator operator Operator

“null” “null” Supervisor (can edit parameters & defaults)

where “null” means a string with no characters in it. The picture of the user list shown above reflects
these default settings.
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3.5. Measure

The Measure menu can be expanded by clicking on the word Measure with the mouse or by pressing the
key combination Alt+M. Two options in this menu control acquisition of the spectral data with subsequent
analysis (Measure Sample) and without analysis (Acquire Data). The third option (Analyze Data)
allows you to analyze spectral data that is stored in a file on disk.

3.5.1. Measure | Acquire Data

This option controls all aspects of a data acquisition with data storage, but no analysis. The following
dialog box will appear on the screen. Its defaults are set under the Acquire Data Defaults option in
the Edit menu. Its title reflects the type of MCA chosen in the General Defaults option under the
Edit menu.

Numberof cycles -

coax8k1253 ;g{

e e e e

i :
% ] Parameter Set:
|

Acquire
Count time (s):
Live Time

True Time

Number of Cycles:

Enter the data acquisition time in seconds.

The amount of time during which the analyzer is actively engaged in
counting pulses from the detector/preamplifier. The time during which
the analyzer is unable to count pulses is referred to as “dead time”.

The elapsed clock time during the data acquisition. This is the sum of
the live time and the dead time.

Enter the number (between 1 and 99) of repeated data acquisition and
storage cycles. More than one cycle is typically called an Autocycle.
The acquisitions will be repeated without operator intervention.
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Parameter Set:

Output

Save Spectra ...

Start

Cancel

You must select a named set of analysis parameters from the list of the
parameter sets in the database. This is used for display purposes during
acquisition.

Check this box if you want the spectral data saved to disk. The path to
the storage directory is given. The file name for the spectral data
should be a legal DOS file name with a maximum of 8 characters. If
the measurement is an autocycle (Number of Cycles > 1) the last
two characters of the extension to the file name will be replaced by a
two-digit cycle number. If you do not supply an extension, the letter s
will be used for the first character. The default path shown above the
box is set during installation and may be changed in the General
Defaults option under the Edit menu. The data storage format will be
determined by the type of MCA connected to your system. If the MCA
is a Canberra S100, the format will be the S100 format. If the MCA is
a LANL M>CA, the format will be the NIS-5 Standard. If the MCA is
an ORTEC MCB the format will be the ORTEC ‘chn’ format in

version 3.2 and the ORTEC ‘spc’ format in version 3.3.

Click on this button to start the measurement. It will invoke the MCA
emulator.

Click on this button to cancel the measurement and return to FRAM’s
main menu.

If you invoke the MCA emulator, note that it requires being connected to a recognized data acquisition
system. If such a system is not present, the following dialog box will appear.

Answering NO causes the Measure Sample dialog box to disappear. FRAM’s main menu will then

become active again. Answering Yes allows for simulation of a live acquisition using an existing
spectral data file. This file must contain spectral data stored ORTEC’s ‘chn’ format. The purpose of

this simulation is for development and testing purposes.

If you are connected to a recognized MCA or if you have chosen to simulate one, the window shown
below will appear on the screen. This window can be maximized, minimized, and even resized to a
larger window if the size of the screen permits.
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< Back Click on this button to return to the Measure Sample dialog box. This button is
initially disabled and can only be enabled by stopping the acquisition of data.
Start Click on this button to restart the acquisition of data. This button is initially
disabled. It is enabled when the stop button is pushed.
Stop Click on this button to stop the acquisition of data. After doing so, this button
will be disabled until the start button is pushed.
Cancel Click on this button to cancel the acquisition of data, to return to the Measure

display regions

X<—>

X —><—

Sample dialog box, and to continue with the analysis of the data that has already
been acquired.

Check this box to have the regions specified in the parameter set displayed. The
background points will be shown in green while the peak regions will be shown
in red.

Click on this button to increase the scale horizontally. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.

Click on this button to decrease the scale horizontally. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.
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Y <—> Click on this button to increase the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.

Y —><— Click on this button to decrease the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse. -

log plot Click on this radio button to display the data on a log scale.

linear plot Click on this radio button to display the data on a linear scale.

time: This displays the elapsed time and the preset time.

cycle: This displays the current cycle number and the number of cycles requested.

3.5.2. Measure | Measure Sample

This option governs all aspects of a sample measurement including operator and sample identification,
data acquisition, data analysis, output, and spectral data and results file generation. The following
dialog box will appear on the screen. Its defaults are set under the Measure Sample Defaults
option in the Edit menu.
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input

Sampile ID: You must enter a character string (up to 15 characters in length)
identifying the sample being measured.

26




PC/FRAM-UM-006

PC/FRAM User Manual February 23, 1999

Operator ID:

Sample Power (watts):

Date of Power Msmt:

Parameter Set:

Pu242:

You must enter a character string (up to 15 characters in length)
identifying the operator of the system.

Enter the wattage from a previous calorimeter measurement. If no
calorimeter measurement is available or if the sample is uranium, leave
the sample power box at 0.0. If you enter the wattage and date,
PC/FRAM will calculate and display the sample’s total plutonium mass
on the date of the calorimetry measurement.

Enter the date of the calorimeter measurement. This must conform to
the date format as displayed. The date template string controls how
dates are displayed, and you can change this in the Edit | General
Defaults option.

You must select a named set of analysis parameters from the list of the
parameter sets in the database.

Choose whether Pu242 is to be calculated by a correlation or whether a
known value (in units of wt% relative to total plutonium) is to be
entered by the operator. The correlation used is of the form

Pu242 = A*[(Pu238)® * (Pu239)C * (Pu240)° * (Pu241 + Am241)F)

acquire
Count time (s):

Number of Cycles:

output

Comment:

Print Resuits

where the constants A, B, C, D, and E are Application Constants in the
selected parameter set and are entered or changed in the Change
Parameter Utility. Ignore these entries for uranium measurements.

Enter the data acquisition time in seconds. Choose either live time or
true time.

Enter the number of repeated data acquisition-data storage-data
analysis cycles (a number between 1 and 99) to be repeated without
operator intervention. More than one cycle is typically called an
Autocycle.

Enter a comment (a character string up to 59 characters in length) that
is reproduced on the output. Comments are optional.

Check the Print Results box if you wish to have the output
automatically printed at the end of each analysis. You must then
choose the level of detail (Short, Medium, or Long) desired in the
output. Details of the various outputs will be presented later but the
general features are these.

Short yields a half page printout, giving the final plutonium (or
%gnium) isotopic fractions, errors, specific power in Watts/gPu,

Pugr fraction, Time since Chemical Separation, and ratios of other
designated isotopes to plutonium.
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Save Spectra ...

Save Results ...

Start

Medium yields a seven or eight page output containing, in addition to
a complete short output; results of the internal calibration of FWHM,
energy, and peak shape; complete diagnostics relating to energy
calibration, FWHM calibration, shape calibration, and interferences;
goodness of fit results for each region; results from relative efficiency
curve fitting; final activity ratios for all isotopes; a summary of peak
areas, relative éﬁiciencies, and heterogeneity factors for all peaks; and
diagnostic checks on the sample type.

Long adds a complete channel-by-channel summary of the fitting
results for each region to the medium output. A long output may be
25-30 pages in length depending on the characteristics of the parameter
set and the number of regions analyzed.

Check this box if you want the spectral data saved to disk. The file
name for the spectral data should be a legal DOS file name with a
maximum of § characters. If the measurement is an autocycle
(Number of Cycles > 1) the last two characters of the extension to
the file name will be replaced by a two-digit cycle number. If you do
not supply an extension, the letter s will be used for the first character.
The default path shown above the box is set during installation and
may be changed in the General Defaults option under the Edit

menu. The data storage format will be determined by the type of MCA
connected to your system. If the MCA is a Canberra S100, the format
will be the S100 format. If the MCA is a LANL M?CA, the format will
be the NIS-5 Standard. If the MCA is an ORTEC MCB the format will
be the ORTEC ‘chn’ format in version 3.2 and the ORTEC ‘spc’
format in version 3.3.

Check this box if you wish to save the results of an assay in the
indicated directory. A results file is a complete record of the entire
analysis, essentially a text file containing a long printout. The file name
for the spectral data should be a legal DOS file name with a maximum
of 8 characters. If the measurement is an autocycle (Number of
Cycles > 1) the last two characters of the extension to the file name
will be replaced by a two-digit cycle number. If you do not supply an
extension, the letter r will be used for the first character. The default
path shown above the box is set during installation and may be changed
in the General Defaults option under the Edit menu. This file can be
viewed on the monitor by choosing the Display Results option in the
Options menu. The use of this feature is intended mainly for
debugging and development work. A typical results file takes nearly

100kb of disk space.

As an additional quality assurance feature, a copy of the parameter set
used in the analysis is appended to the resuits file.

Click on this button to start the measurement. It will invoke the MCA
emulator.
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Exit Click on this button to cancel the measurement and return to
PC/FRAM’s main menu.
“status” Just below the Start and Exit buttons the program will display

messages concerning the progress of the analysis. If there is an error
during the analysis a message box will be displayed on the screen and
you will be asked to choose between continuing the analysis or
terminating the analysis.
If you invoke the MCA emulator, note that it requires being connected to a recognized data acquisition
system. If such a system is not present, the following dialog box will appear.

| = FRAM Message ]

Cannotchnnectto MCA - -
- Do youwish tosimuléte one?

¥

Answering No or Cancel causes the Measure Sample dialog box to disappear; FRAM’s main
menu will then become active again. Answering Yes allows for simulation of a live acquisition using
an existing spectral data file stored in the ORTEC’s ‘chn’ format. The purpose of this simulation is for
development and testing purposes.

If you are connected to a fecogm’zed MCA or if you have chosen to simulate one, the following
window will appear on the screen. This window can be maximized, minimized, and even resized to a
larger window if the size of the screen permits.
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Click on this button to return to the Measure Sample dialog box. This button is
initially disabled and can only be enabled by stopping the acquisition of data.

Click on this button to restart the acquisition of data. This button is initially
disabled. It is enabled when the stop button is pushed.

Click on this button to stop the acquisition of data. After doing so, this button
will be disabled until the start button is pushed.

Click on this button to cancel the acquisition of data, to return to the Measure
Sample dialog box, and to continue with the analysis of the data that has already
been acquired.

Check this box to have the regions specified in the parameter set displayed. The
background points will be shown in green while the peak regions will be shown
in red.

Click on this button to increase the scale horizontally. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.

Click on this button to decrease the scale horizontally. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.
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Y <—> Click on this button to increase the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the

mouse.

Click on this button to decrease the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse. -

Y —><—.

log plot Click on this radio button to display the data on a log scale.

linear plot Click on this radio button to display the data on a linear scale.

time: This displays the elapsed time and the preset time.

cycle: This displays the current cycle number and the number of cycles requested.

When the acquisition is done, this window disappears and the Measure Sample dialog box returns. At
this point the spectrum will be analyzed. The results of the analysis will be automatically displayed on
the screen. An example of a results window is shown in section 3.6.4. To dismiss this window you
need to click on the X in the upper right hand cormner of the window or press the key combination
Ctrl+F4.

3.5.3. Measure | Analyze Data

This option allows you to analyze spectral data files stored on disk. The following dialog box will
appear on the screen. Its defaults are set under the Analyze Data Defaults option in the Edit menu.

| 3 Analyze Data _ I ! _ i

_'nput /A:; f"i~3t.“;;:la "' x::{\»« : A e ::’ =L ~‘ :“:Ji, = e’ = ‘,,)‘ ’ ;,L;\ :A M:T i; N ,. ] ’ B »“A
i~ File: ﬂ _ . -

B e e e S

SErSs

Storage Format

NIS-S standard

coax8k1 25

: Paramgater Set“

‘*\W&§ 3*1, &

Daté of Power Msmi,

= | P
I 3—Feb—1 999 W

Storage Format:

Enter the file to be analyzed, including complete path and extension.

You may click on the Browse... button and use the standard
Windows dialog to search for the file to be opened.

""You must select the data storage format of the selected file from the
choices given. If the wrong format is chosen an error message will
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Parameter Set:

Number of Cycles:

Sample Power (watts):

Date of Power Msmt:

Pu242:

appear in the upper right hand cormer of the dialog box when the
program attempts to read the data from the file.

You must select an analysis parameter set from the choices given.
They represent the sets that currently exist in the database. If you
select an inappropriate parameter set, you may encounter difficulties in
the analysis.

The number of files with sequential filename extensions to be analyzed
starting with the file entered above.

Enter the wattage from a previous calorimeter measurement. If no
calorimeter measurement is available or if the sample is uranium, leave
the sample power box at 0.0. If you enter the wattage and date,
PC/FRAM will calculate and display the sample’s total plutonium mass
on the date of the calorimetry measurement.

Enter the date of the calorimeter measurement. This must conform to
the date format as displayed. The date template string controls how
dates are displayed, and you can change this in the Edit | General
Defaults option.

Choose whether Pu242 is to be calculated by a correlation or whether a
known value (in units of wt% relative to total plutonium) is to be
entered by the operator. The correlation used is of the form

Pu242 = A*[(Pu238)® * (Pu239)C * (Pu240)° * (Pu241 + Am241)F]

output

Comment:

Print Results

where the constants A, B, C, D, and E are Application Constants in the
selected parameter set and are entered or changed in the Change
Parameter Utility. Ignore these entries for uranium measurements.

Enter a comment (a character string up to 59 characters in length) that
is reproduced on the output. Comments are optional.

Check the Print Results box if you wish to have the output
automatically printed at the end of each analysis. You must then
choose the level of detail (Short, Medium, or Long) desired in the -
output. Details of the various outputs will be presented later but the
general features are these.

Short yields a half page printout, giving the final plutonium (or

lz%mium) isotopic fractions, errors, specific power in Watts/gPu,
Puegr fraction, Time since Chemical Separation, and ratios of other

designated isotopes to plutonium. )

Medium yields a seven or eight page output containing, in addition to
a complete short output; results of the internal calibration of FWHM,
energy, and peak shape; complete diagnostics relating to energy
calibration, FWHM calibration, shape calibration, and interferences;
goodness of fit results for each region; results from relative efficiency
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Save Results ...

OK

Exit

“status”

curve fitting; final activity ratios for all isotopes; a summary of peak
areas, relative efficiencies, and heterogeneity factors for all peaks; and
diagnostic checks on the sample type.

Long adds a complete channel-by-channel summary of the fitting
results for each region to the medium output. A long output may be 25-
30 pages in length depending on the characteristics of the parameter set
and the number of regions analyzed.

Check this box if you wish to save the results of an assay in the
indicated directory. A results file is a complete record of the entire
analysis, essentially a text file containing a long printout. The file name
for the spectral data should be a legal DOS file name with a maximum
of 8 characters. The default path shown above the box is set during
installation and may be changed in the General Defaults option under
the Edit menu. The use of this feature is intended mainly for debugging
and development work. A typical results file takes nearly 100kb of disk
space.

As an additional quality assurance feature, a copy of the parameter set
used in the analysis is appended to the results file.

Click on this button to start the analysis. If you had chosen the
ORTEC “spc’ storage format, a message box will appear on the screen
asking whether you want to load parameter set information from the
data file. If you answer yes, the parameter set information in the data
file will be loaded into memory and used to perform the analysis. If
you answer no, the parameter set you selected from the drop-down list
will be retrieved from the database and used to perform the analysis.

Click on this button to cancel the analysis and return to FRAM’s main
menu. If you click on this button while the analysis is in progress, the
following dialog box will appear on the screen.

= FRAM Message |

Sk
et W o YB3

‘When it does, you must verify whether you wish to abort the analysis
or have it continue.

Just below the OK and Exit buttons the program will display messages
concerning the progress of the analysis. If there is an error during the
analysis a message box will be displayed on the screen and you will be
asked to choose between continuing the analysis or terminating the
analysis.
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When the analysis is done, the Analyze Data dialog box will disappear and the results of the analysis
will be automatically displayed on the screen. An example of a results window is shown in section
3.6.4. To dismiss this window you need to click on the X in the upper right hand corner of the window
or press the key combination Ctrl+F4.

3.6. Options
The Options menu can be expanded by clicking on the word Options with the mouse or by pressing the
key combination Alt+Q. This menu controls a variety of utility functions that allow you to easily examine
the quality of the analysis. You can view the spectral data and fits. You can display the results on the
screen at any chosen print level. You can print the results at any chosen print level. You can decay correct
the isotopic composition of any sample.

| -PiotEfiiciencies

i_B_lsplay Resuits %
* Print Results <. [

3.6.1. Options | Plot Spectrum

This option allows you to view the raw spectral data from within the PC/FRAM program in a flexible
display format similar to that of a multi-channel analyzer. You may examine data in the office without
needing the multi-channel analyzer hardware and software to carry out the viewing functions. The
following window will appear on the screen. This window can be maximized, minimized, and even
resized to a larger window if the size of the screen permits.
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The spectrum plotted is either the last spectrum that was analyzed or a spectrum that was opened under
the Open option in the File menu depending on whichever action was the most recent.

The first click in the spectrum window selects the window and makes it active. A thick border around
the window denotes an active window. If the window is active the next click of the cursor places a
cursor cross hair in the spectrum at the x coordinate of the cursor. The cursor may be moved through
the spectrum with the <— and —> keys. The cursor location and channel counts are displayed at the
bottom of the window.

Exit Click on this button to return to PC/FRAM’s main menu.

log plot Click on this radio button to display the data on a log scale.

linear plot Click on this radio button to display the data on a linear scale.

display... Click on this button to see the choices for spectrum overlays. This option is
explained below.

Print Click on this button to send a copy of this spectral plot to the printer.

Printer... Click on this button to bring up a standard Windows dialog box, which allows

you to modify the properties of your printer.

X<—> Click on this button to increase the scale horizontally. In order for this to be

effective, you must first select the plot window by clicking inside of it with the

mouse. When this is selected a horizontal scroll bar appears at the bottom of the
screen. You can use this along with the arrow keys to scroll through the
spectrum.
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X—><— Click on this button to decrease the scale horizontally. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.

Y<—> Click on this button to increase the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse. When this is selected a vertical scroll bar appears on the right of the
screen.

Y —><— Click on this button to decrease the scale vertically. In order for this to be
effective, you must first select the plot window by clicking inside of it with the
mouse.

Display Choices

Click on the display... button and the following dialog box will appear on the screen. The five radio
buttons at the left of the screen control what is plotted in addition to the spectrum itself. Select one of
the radio buttons then click on the OK button.

{5 Display Choices

> H
=

spectrum

regions

ecal peaks

fcal peaks

scal peaks

Only the spectrum will be displayed.

Select this radio button to highlight the peak and background regions from a
selected parameter set on the plotted spectrum. You will be asked to choose a
parameter set. The peak regions will be displayed in red and the background
regions of interest will be displayed in green. This allows you to judge the
appropriateness of the region data for the chosen parameter set. For example,
you might scan through the spectrum and note whether the defined background
regions of interest truly represent the background continuum and are not on top
of an unexpected peak. Furthermore, the default energy calibration in the
parameter set is used to calibrate the x-axis. Both the channel number and
energy of the cursor now appear at the bottom of the plot window

Select this radio button to highlight the peaks that are designated to determine
the energy calibration. You will be asked to choose a parameter set. The region
where the peak is expected will be highlighted in red.

Select this radio button to highlight the peaks that are designated to determine
the full width at half-maximum calibration. You will be asked to choose a
parameter set. The region where the peak is expected will be highlighted in red.

Select this radio button to highlight the peaks that are designated to determine
the shape calibration for the contribution of the tailing on the low energy side of
each peak. You will be asked to choose a parameter set. The region where the
peak is expected will be highlighted in red.
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If you select any of the buttons except spectrum, the following dialog box will appear on the screen.
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Select a parameter set from the list of parameter sets that are present in the database then click on the
OK button.

3.6.2. Options | Display Fits

This option allows you to display the fitting results still in memory from the most recent spectrum
analyzed. Below is a sample of the dialog box that appears on the screen. This dialog box can be
maximized, minimized, and even resized to a larger one if the size of the screen permits.

['\fram32'5.calx30.1 01 &. coax8k1 125)

”Regmnﬁﬂﬂ __»

L _Bxt _l% | ©leg ptot

Py

D'l Plotcomponents

, Enrft 1 ,Pnnter.. | X<~ |

TN =e o

o \
1013 , 1067 |

Reglon1 Channel 1013 Energy 126 643 keV Counts 19952

On a color monitor, the peak fit is in red and the background fit is in green. The display controls work
in the same manner as described for the Plot Spectrum option. The first click in the spectrum
window selects the window and makes it active. A thick border around the window denotes an active
window. If the window is active the next click of the cursor places a cursor cross hair in the spectrum
at the x coordinate of the cursor. The cursor may be moved through the spectrum with the <~ and —
keys. The cursor location (in channels and in energy) is displayed at the bottom of the window along
with the channel counts.
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Exit
log plot
linear plot

Region

Print

Printer...

X <—>

X —><—

Y <—>

Y —><—

Plot components

Click on this button to return to PC/FRAM’s main menu.
Click on this radio button to display the data on a log scale.
Click on this radio button to display the data on a linear scale.

Use this horizontal scroll bar to select the region to be displayed. The
plot will extend from the lowest channel of the region or background to
the highest channel of the region or background.

Click on this button to send a copy of this plot to the printer.

Click on this button to bring up a standard Windows dialog box, which
allows you to modify the properties of your printer.

Click on this button to increase the scale horizontally. In order for this
to be effective, you must first select the plot window by clicking inside
of it with the mouse. When this is selected a horizontal scroll bar
appears at the bottom of the screen. You can use this along with the
arrow keys to scroll through the specttum. There will be no response
to this button if fewer than 128 channels are being displayed in the plot
window.

Click on this button to decrease the scale horizontally. In order for this
to be effective, you must first select the plot window by clicking inside
of it with the mouse. Once the maximum number of channels for the
region is displayed, clicking this button will have no effect on the
display.

Click on this button to increase the scale vertically. In order for this to
be effective, you must first select the plot window by clicking inside of
it with the mouse. When this is selected a vertical scroll bar appears on
the right of the screen.

Click on this button to decrease the scale vertically. In order for this to
be effective, you must first select the plot window by clicking inside of
it with the mouse.

Check this box to have each individual peak contributing to the
response function in this region plotted.

3.6.3. Options | Plot Efficiencies

Selection of this option produces a screen plot of the relative efficiency data points and the fit of the
relative efficiency curve to them. At the bottom of the screen the ratio of the fit and the data points is
displayed. Below is a picture of what this dialog box might look like. This dialog box can be
maximized, minimized, and even resized to a larger one if the size of the screen permits.

38



PC/FRAM-UM-006

PC/FRAM User Manual February 23, 1999

N Plot efficiencies

H R

Fea 1

i
[ |
:

PRI . 2

Relative Efficiencies
for cAfram32\calx30.101 with coax8k125

1.0

0.8f--------

b o

: ! : :
| 0Bpeeebeee fooecoene- orenoenees oot domeneoees doomenoen doeeennnas
3 : : : : : :
| ) — — U<l KN R NS S
. ; : : : : Isotopes
| (Y S—— R R e et r
i g ; g g 4 Pu24i
i 0.0 ] : ] ] ;
gi‘ 250 300 350 400 450

1.03

| [ D R U T T N
i 0.97 : E P . E E S
1 100 150 200 250 300 350 400 450 500
Energy (keV)

Exit " Click on this button to return to PC/FRAM’s main menu.

Print Click on this button to send a copy of this plot to the printer.

Printer... Click on this button to bring up a standard Windows dialog box, which allows

you to modify the properties of your printer.
3.6.4. Options | Display Results

This option allows you to display, on the screen, the results from the most recent analysis still in
memory from any previously saved results file. The following dialog box will appear on your screen.
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Cancel
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Use most recent results Click this radio button to have the results of the most recent
analysis displayed on the screen.

Use previously saved results Click this radio button to have the results of a previously
saved analysis displayed on the screen. If you select this

choice, the Browse... button will be activated.

Browse... Click this radio button to invoke the standard Windows dialog
box for opening a file. If you use this dialog to select a file,

its path and name will appear in the File: edit box.

File: If you have chosen to use previoﬁsly saved results, please
enter the name of the file containing the results that you wish
to display. You may use the Browse... button to help you

select a file.

print level Choose one of the three print levels: Short, Medium, or Long.

Display parameters? Check this box if you want to have a listing of the parameter
set displayed at the end of the results.

OK Click on this button to have the results displayed in a special
text window.

Cancel Click this button to cancel the display and return to
PC/FRAM’s main menu.

A display of results using a short printout is shown below.
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! 5 Analysis Results 7
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PC FRAM (V3.2) Isotopic Analysis 31-Aug-1998 08:04:18
(Fized tlsgergy Response function Analysis with Hultiple efficiencies) q
Systen : i ] d

spectrun source: c:“\ramn32\cbnmstd.I01l
spectrun date: 15-Jul-1994 16:25:36
live time: 3157 s .

true time: 3600 s

num channels: 4096
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parameter set: widerange6 (1998.08.31 07:39}

General Purpose, Homo. Am/Pu, Equilibrium, 3-25% 240
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diagnostics passed.

{By Corr) (ug/gPu)

Pu238 Pu239 Pu240 Pu241 Pu242 Am241 ]

mass’ 1.18569 63.25856 25.12757 5.33509 5.09307 28247 .4 ;

{ signa .01688 .88229 .44008 .07456 1.34159 402.8 )
: ZRSD 1.42% 1.39% 1.75% 1.40% 26.34% 1.43% ;
|

z bt
| 4TotPwr: 51.2025 9.2834 13.5404 1.3846 .0449 24 .5440 i
§ Specific Power (W/gPu): ( 13.1431 +/— .1120)e-003 ( 0.85%) d

Effective Pu240 fraction: ( 36.6718 +/- 2.2968)e-002 ( 6.26%) {

Time since chemical separation: 3232.48 +/— 7.79 days ( 0.24%)

36363663636 36-36-36-36-36- 3636363633636 363696 3636 36 I6IEIE IE I 6
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To dismiss the text window you need to click on the X in the upper right hand corner of this window or
press the key combination Ctrl+F4.

3.6.5. Options | Print Results

This option provides the same choices as the Display Resuits option discussed in section 3.6.4
except that the results are directed to the printer, rather than the screen. In addition there is 2
Printer... button which allows you to invoke the standard Windows dialog box for modifying the
properties of your printer.
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3.6.6.

Options | ISOPOW

This option allows you to decay correct the isotopic ratios, including *'Am, of a plutonium sample
from any arbitrary date to any other date, either forward or backward in time. The following dialog

box will appear on your screen.

N -

IN[EN

100000 ] - total

T

T

grains Pu

T ae - s

SN

Ssoew g

p.00gnon |

>
Z 3

e

Wik

U
R-R
-

S

~Initiel Pudets [15-Jan-195

nitel A dete’ [i5-Jan-1995 | |-

Final date [11-Dec-1988 J{} | -
. PR :‘f .'; ; :;“ j‘:’::"‘}, o :‘:;«:;-‘i::%::,v\ COV LR " g - < <’ '

In the initial column, you need to enter the starting values of the Pu isotopic ratios in wt%, the *'Am
ratio in parts per million with respect to total Pu, and the total amount of Pu in grams, if known.
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Default values are provided from the most'recent analysis. If the total amount of Pu is not known, a
nominal value of 100 will suffice. Decay-corrected values for all these quantities will appear in the

final 'cohllmn.

Initial Pu date

Initial Am date

Final date

OK

Print
Cancel

Printer...

Sample ID
Specific Power

Sample Power

Percent Pu240 Effective

Enter the date of the values in the column labeled initial. The date
format is governed by the template string specified in the Edit |
General Defaults option.

Enter the date of the **' Am value in the column labeled initial. This
date may be different from that for the Pu isotopic. The date format is
governed by the template string specified in the Edit | General
Defaults option.

Enter the final date for decay correcting the ratios. The date format is
governed by the template string specified in the Edit | General
Defaults option.

Click on this button to perform the decay corrections. The results for
the Final date will appear in the column labeled final. The sum of
the initial Pu isotopic ratios will appear in the status box in the lower
right hand corner of the window. If this sum deviates from 100% by
more than 1%, an error message will appear in this box, and you should
check the initial values.

Click on this button to print out the results of the decay corrections.

Click on this button to dismiss the ISOPOW"’ dialog box and return to
PC/FRAM’s main menu.

Click on this button to bring up a standard Windows dialog box, which
allows you to modify the properties of your printer.

Enter a string of up to 15 characters which will identify the sample.
This string will appear on a print out if you click on the Print button.
Otherwise it is ignored. .

‘This box will be filled in with the computed value of the specific power
for the sample on the final date. The units are milliWatts per gram of
Pu.

This box will be filled in with the computed value for the total power
of the sample (in Watts) on the final date based on the value for the
total grams of Pu. It is the product of the specific power and the final
value for the total amount of Pu.

This box will be filled in with the computed value for the effective
#%py fraction.

Shown below is an example of what gets displayed after the decay-correction calculations.
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3.6.7. Options | Language

This option allows you to select one of two languages for displaying information on the screen. The
following dialog box will appear on the screen.

E Chmce of Language %]

Ffffngnshx“tﬁ:

(‘ Russran;‘ .

""*t‘ R AR

USRI

The distribution kit comes with support for two languages, English and Russian. These are the two
choices that are present in the dialog box above. If you select the radio button labeled Russian, the
dialog box will change to the following.

i E Hsux unTepoeiica

e, A,

If you click on the “Exit” button, the user interface henceforth will be in Russian. The menus, the
dialog boxes, the display of analysis results, and the printouts of analysis results will all be in Russian.
If you exit the program and restart PC/FRAM, the interface will again be in Russian. You can change
back to English by selecting the “Options | Language* option as shown below.
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When the dialog box for choice of language appears on the screen, select “English” and click on the
Exit button.

3.7. Help

The Help menu can be expanded by clicking on the word Help with the mouse or by pressing the key
combination AIt+H. At the present time the Help menu has only one option. :

3.7.1. Help | About

The About option under Help in the main menu displays a screen with the name, version number,
and release date for this product along with copyright information.
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4.

Change Parameter Utility

The Change Parameter Utility gives you access to all the parameters that control an analysis. A complete group
of parameters necessary for an analysis is called a Parameter Set. All parameter sets are stored in a single
database, which resides.in the default PC/FRAM directory.. This utility allows you to augment the database
with a new parameter set, delete a parameter set from the database, or modify the values in any parameter set.
The utility also allows you to export the information in a parameter set to a text file and subsequently import
that information back into the database. This allows for sharing of parameter sets between different PC/FRAM
systerns.

Each parameter set has a name; however, it does NOT have to conform to the DOS conventions for file names.

The Change Parameter utility is password protected.

Startup Instructions To enter the change parameter utility select Edit from the main menu, then select the
Parameters option. Once the User Validation screen is correctly completed with the name and password
of an account which has been granted supervisory access, the title of the application window will change to
Change Parameter Utility and a new menu system will become active. Below is a picture of what you will

see.

4.1. File

The File menu governs the manipulation of parameter sets in the parameter set database. The word File in
the menu does not refer to spectral data files. The following pictures illustrate the options available under
this menu. The picture on the left shows the options that are active when no parameter has been opened.

The picture on the right shows the options that are active only when a parameter has been opened.
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4.1.1. File | New

This option allows you to create a new parameter set that will iniiially be empty. The following dialog
box will appear on the screen. oo :

f'—‘ New Parameter Set

L

Name for parameter set: Enter a name (up to 30 characters in length) for the new parameter set.
The string may be any combination of characters, including spaces.

Description: Enter a description for the new parameter set. This serves as a short
description of the type of spectral data this parameter set is designed to
handle. This string of characters must fit within the edit box.

OK Click on this button to create the new parameter set and dismiss this
dialog box. If you did not enter a name, an error message will appear
in the status box in the lower right-hand corner of the window. If you
entered a name that matches the name of another parameter set in the
database, an error message will appear in the same status box.

Cancel Click on this button to dismiss the dialog box without creating a new
parameter set.
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The parameter set can be edited as soon as it is created, but will not exist in the database until it is
saved using the Save or Save as option. Instead of creating a completely new parameter set, you
may find it easier to follow these steps: 1) open an existing parameter set or import an existing

parameter file, 2) save it with a new name using the Save as option, 3) close the existing parameter
set, then 4) open the parameter set with the new name. You are now ready to edit the new parameter
set. -

4.1.2. File | Open

This option allows you to open an existing parameter set and read it into memory, either for editing, or
for use as a basis for a new parameter set as described above. The following dialog box will appear on
the screen.

5 Open Parameter Set

B P

PR T e S IR Sl

Parameter Set:  Select one of the parameter set from the drop-down list. These are the
parameter sets that currently reside in the database.

OK Click on this button to open the selected parameter set and dismiss this dialog
box. Opening a parameter set causes its information to be transferred from the
database to a worksheet in memory. After a parameter set is opened, its name
will be displayed in the title bar of the window. Only one parameter can be
open at any one time.

Cancel Click on this button to dismiss the dialog box without opening any parameter
set.

4.1.3. File | Close

This option will erase the contents of the current worksheet and remove the name from the window's
title bar. If the contents of the worksheet have been altered, the following message box will appear on
the screen.

[SFRAM Mossoge )
t o . A w:?: : - 4eXy N : g L

No Click on this button to dismiss the dialog box without saving the changes in the current
worksheet to the database.
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Yes Click on this button to dismiss the dialog box and have the changes in the current
worksheet saved in the database.

4.1.4. File | Save

This option writes the contents of the worksheet to the database replacing the old records for this
parameter set with new ones. The contents of the worksheet remain unaltered.

4.1.5. File | Save As

This option makes a copy of the current worksheet and writes it to the database as a parameter set with
the name and description specified by you. The following dialog box will appear on the screen.

E Save Parameter Set B2 I

0T e’ o s mam BN SRR

5 Namefarpaxameterset I

P JE R ~
;’Descnn’aon R P SEEE {
T~ ST

%]General Purgose Homo AmfPu Egumbnum 3-25%2 l e i
l;': : ;”Zf :f{ f," e SN o N N A 1 “’f;:y ‘U ’ e N

Name for parameter set: Enter a name (up to 30 characters in length) for the new parameter set.
The string may be any combination of characters, including spaces.

Description: Enter a description for the new parameter set. This serves as a short
description of the type of spectral data this parameter set is designed to
handle. This string of characters must fit within the edit box.

OK Click on this button to save the parameter set and dismiss this dialog
box. If the name you gave matches the name of a parameter set already
in the database a message box will appear on the screen with the
message: This parameter set already exists in the database.
Do you want to continue? If you click on the Yes button, the
current worksheet will replace that parameter set in the database. If
you click on the No button, the save operation will be cancelled.

Cancel Click on this button to dismiss the dialog box without saving the
worksheet in the database.

NOTE! Saving a worksheet with a new name creates a copy of that worksheet in the database
with that name. This operation does not destroy the contents of the current worksheet nor change the
name associated with the parameter set information in the worksheet. The “old” parameter set is still
“active”. If you continue to edit the parameter set and then save its contents, the new information will
be stored in the “old” parameter set. This is in contrast to the way most word processing programs
work
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4.1.6.  File | Print

This option will write the contents of the worksheet to a text file and then have that file printed on the
system printer. The following dialog box will appear on the screen.

FBAM Message X -

Yes Click on this button to dismiss this dialog box and have the information printed.
No Click on this button to dismiss this dialog box without printing the information.

An example of a printout is shown in section 4.3 of this manual.

4.1.7. File | Remove

This option removes all the information in a single parameter set from the database. This option can
also be used to remove all the information from the database. That would result in the creation of a
new database with no parameter sets in it.

! = Remove Parameter Set

Remove all parametersets

i

[N
., PREP PN

Parameter Set: Select the parameter set from this drop-down list. These are
the parameter sets that currently reside in the database.

Remove all parameter sets Check this box if you want to delete all the parameter sets and
create a new database.

OK Click on this button to dismiss the dialog box and remove the
selected parameter set. If you chose to remove all the
parameter sets, a message box will appear on the screen with
the message: This will destroy all the data in the
database. Do you want to continue? Click on the Yes

button to create the new database. Click on the No button to
cancel the operation.

Cancel Click on this button to dismiss the dialog box without
changing the database.

4.1.8. File | Rename

This option allows you to change the name of a parameter set in the database. The following dialog
box will appear on the screen.
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Sy

+ g ey o g gt 1

Rename Parameter Set

S Rerame ParsneterSel et

Old Name:

New Name:

OK

Cancel

Select the parameter set from this drop-down list. These are the parameter sets
that currently reside in the database.

Enter a name (uphio 30 characters in length) for the parameter set. The string
may be any combination of characters, including spaces.

Click on this button to dismiss the dialog box and have the parameter set
renamed. If you specify a new name that matches the name of another
parameter set in the database, and error message will appear in the status box in
the lower right-hand corner of the window.

Click on this button to dismiss the dialog box without renaming the parameter
set.

4.1.9. File | Export

This option takes the contents of the current worksheet, formats the information, then writes it to a text
file on the disk. This can be used to transfer parameter sets between different PC/FRAM systems.
The following dialog box will appear on the screen.

meter Set

R " S S
= e T N T e TR BN L N Sy TLARS

5 Export Para B l

=

Browse...
OK

Cance!

Enter the name of the file, including complete path and extension, where the
parameter set information will be stored. The default file name appearing in the
box is constructed by taking the first eight characters of the parameter set name
followed by an extension of .pst. The directory is the default PC/FRAM
directory.

Click on this button to invoke the standard Windows dialog for opening a file.

Click on this button to dismiss the dialog box and have the parameter set
information stored in textual form.

Click on this button to dismiss the dialog box without save the parameter set
information.
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4.1.10.  File | Import

This option reads the information present in a text file resulting from a previous Export command and
places it in the current worksheet. The following dialog box will appear on the screen.

P

1

File: Enter the name of the file, including complete path and extension, where the
parameter set information is stored.

Browse... Click on this button to invoke the standard Windows dialog for opening a file.

OK Click on this button to dismiss the dialog box and have the parameter set
information retrieved from the text file.

Cancel Click on this button to dismiss the dialog box without retrieving the parameter
set information.

NOTE! A parameter file that has been imported into the worksheet in memory must be saved into

the database with the Save As command to preserve it as a parameter set.

4.1.11.  File | Exit

This option destroys the window and returns control to the main PC/FRAM menu unless the worksheet
has been changed. In this case, the following dialog box will appear on the screen.

f — FRAM Message ‘

N g SR b e el

| Percimetor siiss o iodits
gl Do youwish to save it?::.. .
{ ’l Lt 5;‘ B o .

Yes Click on this button to dismiss this dialog box and have the information saved.

No Click on this button to dismiss this dialog box without saving the information.

If the worksheet was changed and you attempt to exit from PC/FRAM by clicking on the X in the
upper right-hand comer of the window or by double clicking on the small box in the upper left hand
corner of the window, the following message will appear on the screen.
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E FHAH Hessage <] I

You must exit from the Change Parameter Utility first, then exit from PC/FRAM.

42. Edit

The choices that appear when the Edit option in the menu is selected refer to various groups of parameters
in the open parameter set. These choices are illustrated in the picture below.

In order to view and/or edit any of the values in a parameter set, one must first place that information in the
worksheet. This is accomplished via the Open or the Import options under the File menu option.

42.1. Edit | Fitting Parameters

This option displays the default parameters used to describe the energy calibration and the peak
shapes. It also displays a description of the parameter set. The following dialog box will appear on
the screen.
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E Edit Fitting Parameters - mderangeB l

= z*

; =¥ ﬁ}é}»"
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PRI TR

The software is fairly tolerant regarding these initial values. Appropriate starting values for use here
may be obtained from the medium (or long) printouts from a successful analysis. The starting values
that are provided with the existing parameter sets should be adequate for nearly all purposes.

It is important that the Default Energy Calibration constants be accurate. This enables the code to
find the peaks selected for the final energy calibration and to convert from channel number to energy

for setting region boundaries. The default energy calibration should predict the actual peak positions
to within 10 chaunnels.

The Default FWHM constants use a formula with the final result fwhm(ch) in units of channels
whereas the input energy values are in keV. The parameters above are for a good resolution planar
detector at a gain of 0.1 keV/channel. The first two terms in the formula for fwhm(ch) are physics
based, while the last term is an empirical correction to account for the observation that many curves of
FWI-IM2 vs. energy deviate from a straight line at low energy.

The Default tailing constants describe an exponential tail on the low energy side of the peak and
allow for both the amplitude and slope of the tail to be a linear function of energy. We have observed
that these tail parameters are not easily parametrized, with their observed behavior depending on the
type of detector and even the detector manufacturer. Therefore we typically set the constant T4 to zero
and use the customary form where the amplitude is a linear function of energy and the slope is a
constant.

NOTE! One may encounter conditions where good peaks, for the internal calibration of the shape
parameters, are not available in the spectrum. The program allows you to fix the parameters at their
default values, which can be obtained from a previous analysis with good statistical precision. This
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may be the best procedure for very weak spectra with poor counting statistics. If the parameters are to
be fixed, it is best to obtain the fixed values from a spectrum acquired under conditions as near as
possible to those from the acquisition of the unknown. The FWHM constants, in particular, will be

count rate dependent. We find it very useful to fix the tailing constants for poor quality spectra. 1t is
| usually not necessary to fix the FWHM constants.

422.  Edit | Peak Info

This option displays, in a new window in tabular form, necessary information about the peaks to be
used in an analysis. An example of such a table appears below.

E Edlt Peak Informallon - w:derangeB

[ Cance[ form iigerion, delstion.s
;[j'n Am241| 150110 | 000 |7200000007 |11 |0 D 131
"|_J14|Pue3s | 152720 | 000 8.98300e006 |0 |0 |[_] 11
[_J1s|Puear 159955 | ooo  |esosooesos |19 o | ][ D11 1C]
[|_J16|puzas {16010 | oo fe20000e008 18 |0 |[ ([ ]I J1[JIC]
iZDW Pu240 |160.308 | 0.00 3s4200e-006 {0 | o |[ B0
1] 18|Pu23a [ 161482 | 000 118400e006 o (o [P |11

| 19{Pu241 | 164597 | 0.00 as4100e007 [0 |0 |[X] | XX X
|1 20jamea1 { 164507 | 0.0 6.26000e-007 |19 |19 |[_J | BX) | [ |[d | =]

When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <—, —, T, and | keys. You can replace the contents of a selected cell by typing new
characters into that cell. You can edit the string in a cell by first double clicking on that cell to select
the entire string inside that cell and then clicking again to establish the position of the cursor. While
you are editing the string in a cell you can use the <— and —> keys to move around in the cell; the T
and { keys will be inactive. You can exit the cell by pressing the Tab key or the Enter key. You may
use the vertical scroll bar at the right of the screen to view more of the table.

The first column displays an index for each gamma ray that serves as a row number for the table.

isotope This column displays the name of the gamma ray’s assigned isotope
in the form XXnnn where XX is the standard two letter abbreviation
for the isotope and nnn is its atomic mass number. A peak does not
have to have an isotope assignment; this column may be left blank.
This is sometimes done for unidentified interference peaks that are left
free in the fitting. A peak without an assigned isotope must be a free
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peak energy

line width

branching ratio

peak and can not be used as a reference for fixing another peak. An
unassigned peak may be used for energy, shape, and FWHM
calibrations.

This column displays the energy of each gamma ray in keV. The
starting values for most of the gamma ray energies have been taken
from the work of Gunnink, Evans, and Prindle, “A Reevaluation of the
Gamma-Ray energies and Absolute Branching Intensities of 27U,
28239240241y and 2*' Am,” Lawrence Livermore Laboratory report
UCRL-52139, October 1976. Some of the values have been adjusted
from the published data because the adjusted values gave better fits. It
is appropriate to adjust published values if it improves the fitting
results. Because energy calibrations are done on a piecewise linear
basis, system nonlinearity and the exact choice of energy calibration
peaks may force this adjustment. One can use Display Fits under
Options in PC/FRAM’s main to examine the peak fits to see if this is
necessary.

This column displays the line width in eV of x-ray peaks. We have not
tested x-ray fitting with this version of PC/FRAM. This column should
be filled with zeros.

This column displays the branching ratio of each gamma ray which is
the fraction of all decays of the assigned isotope that yield the gamma
ray in question. For parent-daughter gamma rays, you should consider
all branches between the parent and daughter if you wish the daughter
to represent the parent. For example, the #”U branching ratios for
gamma rays at 164, 208, 267 keV and other energies, are the product of
the branching ratio of the decay of 27U to Z’Np and the alpha decay
branching fraction of 2.46e-5 for the decay of >'Pu to 2’U. These
gamma rays are labeled as 2*'Pu in the widerange6 parameter set
example because of the assumed decay equilibrium between **'Pu and
B’U.

Fixing and summing of peak areas

Columns six through nine display information about how the peaks are used in the analysis.

fix areato

This column indicates when a peak area is to be determined by ratio of
relative efficiency, branching ratio, and activity from a second peak
rather than being determined as a free parameter in the response
function fitting. Such a process is used to extract interfering peaks
from a complex of several peaks by reference to a more easily
determined peak nearby. Peaks fixed to another peak in the same
region are used together in a-composite response function. Peaks that
are fixed to another peak outside the region are subtracted or stripped
from the net count array before the response function fitting is
performed. An example is shown in the previous window. Peaks 15-
17 form an unresolved complex containing the important 2°Pu peak at
160.308 keV (peak 17). The closeness of the three peaks might yield
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sum area with

used for eff

used for act

inaccurate results from the response function fitting process if all three
peaks were free. Therefore, we use peak 18 at 161.482 keV as part of
the #°Pu response function to determine the 2’Pu peak at 160.190 keV
and use peak 19 at 164.597 (in a different region) to strip the 159.955
keV peak from the complex. The stripping process leaves only data
from the 160.308 keV peak and the ?Pu peaks to be fitted with two
response functions. Peaks fixed to other peaks should not be used for
activity peaks. Enter the peak number of the peak to be fixed to or a
zero if the peak is free.

This column indicates which peaks are to be used together in the final
determination of activity ratios. Here we sum the areas of the
coenergetic peaks, typically from *'Pu-*’U and **'Am, (see peaks 19
and 20 in previous window, for example) in the least squares equations
allowing the resolution of the components in the least squares process.
Enter the peak number of the peak to be summed with or a zero if the
peak is not summed.

This column designates the peaks to be used in the relative efficiency
curve calculation. One typically chooses a series of strong peaks from
a single isotope that spans the range of the analysis. Peaks from other
isotopes can also be included, although, because of normalization,
additional isotopes must have two or more peaks to contribute. The

principal isotope in the relative efficiency calculation is usually the first
isotope in the isotope list (see later discussion on the isotope list). We
usually use Z°Pu and #*'Pu->"U peaks for the relative efficiency curve
in the 120-450 keV range. If you want to use the peak in the efficiency
calculation and the box is empty, click on the box to place a check in it.
If you do not want to use the peak in the efficiency calculation and the
box is checked, click on the box to remove the check.

This column designates the peaks to be used in the calculation for
relative activity. We do not use all of the peaks from a given isotope
for relative activity determination. Only the strongest peaks will
contribute significantly in the weighted least squares process used.
Also, we do not use peaks that have been fixed to other peaks in this
analysis because the fixed peaks are not independent. If you want to
use the peak in the activity calculation and the box is empty, click on
the box to place a check in it. If you do not want to use the peak in the
activity calculation and the box is checked, click on the box to remove
the check.

Internal Calibration Peaks

The last three columns indicate the selection of peaks used for the internal calibrations. It is not
necessary for these peaks to belong to a particular isotope, or to have any isotope name at all. These
peaks typically are clean, single, well-resolved peaks with good statistics. While different peaks may
be used for these calibrations, one usually uses many of the same peaks for all the calibrations.
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used for ecal This column indicates the selection of peaks used for the energy
calibration. While any peak in the list may be used, the peak should be
strong, have good counting statistics, a well-defined peak position, a
well-known energy, and be free from neighboring interferences over
the range from 75% of the peak maximum on the low energy side to
25% of the maximum on the high energy side. Ata minimum, two
energy calibration peaks are needed. When more peaks are used, the
calibration is a piecewise linear calibration between adjacent
calibration peaks. If you want to use the peak in the internal energy
calibration and the box is empty, click on the box to place a check in it.
If you do not want to use the peak in the internal energy calibration and
the box is checked, click on the box to remove the check.

used for fcal This column designates the peaks to be used for the full-width-at-half-
max (FWHM) vs. energy calibration. The peaks used for this internal
calibration need to have the same characteristics as those used for the
energy calibration. At least three FWHM peaks must be specified. If
you want to use the peak in the internal FWHM calibration and the box
is empty, click on the box to place a check in it. If you do not want to
use the peak in the internal FWHM calibration and the box is checked,
click on the box to remove the check.

used for scal This column designates the peaks to be used for the shape calibration,
(the determination of the peak tailing parameters). The peaks used
must be free of interferences in the range from 0.5 FWHM to 1.5
FWHM on the low energy side of the peak. If you want to use the peak
in the internal shape calibration and the box is empty, click on the box
to place a check in it. If you do not want to use the peak in the internal
shape calibration and the box is checked, click on the box to remove
the check.

If a sufficient number of high quality peaks are not available for ecal, fcal, or scal, those parameter
values may be fixed at the default values. Do this by invoking the Change Parameter Utility, opening
the appropriate parameter set, then selecting the Edit, Fitting Parameters option. In the window
that comes up, click on the appropriate check box on the left-hand side, which is labeled Fixed.

422.1. Row Operations

In this table, you may add, delete, or shift the rows. Click on the yellow box to the left of a row
number. The following dialog box will appear.

F': Row Uperatlon l

T e e

i f'“ 4nsertanev}rov{ :

: f" o2 Moveth:srowup L
| C}Movethis mwdown ‘

59




PC/FRAM-UM-006 PC/FRAM User Manual February 23, 1999

If you click on the Cancel button, this window will disappear and the rows will remain the same.
If you want to change the rows, click on one of the radio buttons, then on the OK button. Note
that inserting a new row is the default action. If you insert a new row, remember that it is inserted
above the row selected. If any of these row operations cannot be performed, a message box will
appear on the screen with the appropriate error message.

Editing the peak list is special since the code will automatically reorder the peaks by energy when
you exit the table. This means that using the Move this row up and Move this row down
options will have no effect in the end.

NOTE! 1o change the database, you must click the OK button to preserve the changes made on
the screen into the worksheet. Then you must choose the Save option from the File menu to write the
contents of the worksheet into the database.

4222, Expanding the Number of Rows Displayed

You may reach a point during a process of entering many new rows where the table is full and no new

rows may be added. The vertical scroll bar will not scroll to give you any more empty rows. To
obtain more empty rows, you need to close the table, save it to the database, close the parameter set,
and then reopen the parameter set. Every time the parameter set is opened the table is given ten empty
rows in addition to the rows already in use. You should follow these instructions.

1. Click on the OK button to close the table window and save the changes.

2. Choose the File | Save option to store the worksheet information into the database.

3. Choose the File | Close option to close the current worksheet. If you neglected to save the
worksheet in step 2, you will be prompted to save any changes at this point.

4. Choose the File | Open option. Then in the dialog box entitled ‘Open Parameter Set’ select the
same parameter set. Now when you choose an edit option that displays a table in table form, your
table will have ten additional blank rows at the bottom.

423. Edit | Regions by channel & Edit | Regions by energy

Selection of these options opens a new window displaying in tabular form all the information about the
regions (groupings of peaks) to be used in an analysis. Region parameters are displayed in channels or
energy units, depending upon the chosen option. An example of pair of such tables (by channel and
by energy) appears below.
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When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <—, —>, T, and 4 keys. You can replace the contents of a selected cell by typing new
characters into that cell. You can edit the string in a cell by first double clicking on that cell to select
the entire string inside that cell and then clicking again to establish the position of the cursor. While
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you are editing the string in a cell you can use the <— and —> keys to move around in the cell; the T
and ¥ keys will be inactive. You can exit the cell by pressing the Tab key or the Enter key. You may
use the vertical scroll bar at the right of the screen to view more of the table.

The first column displays an index for each region, which serves as a row number for the tables. The
start and end of each region are displayed in the next two columns. The start and end of each of four
background regions are displayed in the next 8-columns. The units of the display are channels or
energy (keV), depending on the chosen option. The shape of the background continuum to be
extrapolated undemeath the peaks in the region is displayed in the last column.

These boundaries may be displayed in either energy units (keV) or channel units. The software

converts between the two using the default energy calibration. The example directly above shows the
display in energy units. The values are always stored in the database in energy units. A switch in
energy calibration will update the Region info (channels) the next time the option is brought up.

NOTE! The default energy calibration can be changed by choosing the Edit | Fitting
Parameters option. It is important that this energy calibration be as accurate as possible.

When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <—, —>, T, and 4 keys. You can replace the contents of a selected cell by typing new
characters into that cell. You can edit the string in a cell by first double clicking on that cell to select
the entire string inside that cell and then clicking again to establish the position of the cursor. While
you are editing the string in a cell you can use the ¢— and —> keys to move around in the cell; the T
and { keys will be inactive. You can exit the cell by pressing the Tab key or the Enter key. You may
use the vertical scroll bar at the right of the screen to view more of the table.

Up to four different “sub regions” labeled BKG #1 through BKG #4 can be used to define the
background continuum underneath the region. The background regions may be placed anywhere in
the spectrum, inside or outside the peak region. The placement of the background regions must be
done carefully with full cognizance of interferences that may appear in other spectra to be analyzed
with the same parameter set. The wide intensity variation of peaks from © Am must especially be
recognized in this regard.

NOTE! The selection of the proper parameters for the peak and background regions may be the
most important set up feature in the code.

Region Numbers:  Regions are analyzed in the order they are presented in the table. The regions
need not be in order of energy and, indeed, it is sometimes desirable to have
them out of order so a region having a peak that a second region fixes to is
analyzed first. Note the discussion in Appendix A. The regions are not
reordered when the window is reentered.

Background Type: Click on the arrow at the right hand side of this box to display a list of the
permissible background types. Select one of the eight choices in the list. Here
is a brief description of the background types.
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none no background subtraction
flat a straight line with zero slope
linear a sloping straight line
quadratic use with care as poor background ROI choices may produce
an unphysical background
exponential  gives a mildly curving background
flat step a smoothed step function with zero slope at the ends
linear step a smoothed step function superimposed on a sloping straight
line
bilinear step  a linear step with different sloping straight lines allowed
above and below the region (use with care)
reference not applicable to PC/FRAM
To judge the appropriateness of a particular background form for a particular
region, perform an analysis using this parameter set, then use the Display Fits
option under Options on the main PC/FRAM menu to view the computed
backgrounds.
Row Operations:  Rows may be added, deleted, or shifted in the region list. See section 4.2.2.1 for

information on doing this. When editing the region information, the Move this
row up and Move this row down commands can be used to rearrange the

regions. See section 4.2.2.2 for instructions on increasing the number of rows in
this table.

NOTE! To change the database, you must click the OK button to preserve the changes made on
the screen into the worksheet. Then you must choose the Save or the Save As option from the File
menu in the Change Parameter utility to write the contents of the worksheet into the database.

4.2.4. Edit | Isotopes

Selecting this option opens a new window and displays in tabular form all the necessary information
about the isotqpes to be used in an analysis. An example of such a table appears below.
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! “SompeN R o ‘zfrwg) ‘ fw%l;f?;gnt “function j

1 |Pu233  |241190e+004 |yeers |238.05220 | 1.92880 0.0000 1

] 2 [Puear  |1.43480e+001 |years |241.05880 | 3.41120 0.0000 1

;|:] 3 |Am241 |4.33600e+002 |years |241.05673 |114.20000 | 0.0000 1

B_]| 4 1Pu23s [8.77400e+001 |years |238.04361 |567.57000 | 25200 1

E] 5 |Pu240 |656400e+003 |years |240.05380 | 7.08240 1.0000 1

]l 6 |Puza2  |3.76300e+005 |years | 24205874 | 0.11530 1.6800 1

D 7 years

D 8 years

=

When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <—, =, T, and 4 keys. You can replace the contents of a selected cell by typing new
characters into that cell. You can edit the string in a cell by first double clicking on that cell to select
the entire string inside that cell and then clicking again to establish the position of the cursor. While
you are editing the string in a cell you can use the <— and — keys to move around in the cell; the T
and ¥ keys will be inactive. You can exit the cell by pressing the Tab key or the Enter key. You may
use the vertical scroll bar at the right of the screen to view more of the table.

The first column displays an index for each isotope, which serves as a row number for the table.

isotope This column displays the name of the isotope in the form XXnnn
where XX is the standard two letter abbreviation for the isotope and
nnn is its atomic mass number. The first isotope in the list is important
because all the other isotopes ratios are calculated relative the first one.
Thus, in the example above, the fundamental isotopic ratios calculated
by the code are *'Pu/”*Pu, 'Am/®°Pu ... Z'U/#°Pu. (Actually **Pu is
calculated from a correlation, in a manner different from the
calculation of the other ratios. However, its presence is still needed in
the isotope list for its required constants.)

half-life The values of the half-life used are those from ANSIN15.22-1987,
American National Standard for Nuclear Materials -- Plutonium-

Bearing Solids--Calibration Techniques for Calorimetric Assay.
units This is a read only field. The half-life units must always be “years”.
mass The Atomic Mass in AMUs.
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power (mW/g) This is the specific power of the isotope in milliWatts/g isotope used
for interpretation of calorimetry results. The values also come from
ANSIN15.22-1987.
pu240 coefficient This parameter is the coefficient multiplying the isotope mass in the

expression for *°Pu effective mass, (or effective fraction) used to
interpret neutron coincidence counting. Currently accepted values are
highlighted below.

240py (mass) = 2.52**Pu(mass) + 1.00¥**°Pu(mass) + 1.68****Pu(mass)

efficiency function

Row Operations:

A different efficiency function is given to isotopes in a different
matrix or isotopes that suffer different attenuation at the same gamma
energy than the first isotope in the list. The number of efficiency
functions is not limited, but we only have experience with two
functions.

Rows may be added, deleted, or shifted in the isotope list. See section
4.2.2.1 for information on doing this. When editing the isotope
information, the Move this row up and Move this row down
commands can be used to rearrange the isotopes. See section 4.2.2.2

for instructions on increasing the number of rows in this table.

NOTE! To change the database, you must click the OK button to preserve the changes made on
the screen into the worksheet. Then you must choose the Save or the Save As option from the File
menu in the Change Parameter utility to write the contents of the worksheet into the database.

4.2.5. Edit | Application Constants

Selecting this option opens a new window and displays in tabular form all the information about the
application constants to be used in an analysis. These constants, for the most part, govern the
diagnostic tests performed in PC/FRAM. These tests are flexible and can be added, deleted, or
customized to suit specific measurement conditions.

An example of such a table appears below.
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= Edit Application Constanis - widerangeb
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) pu242_correlati6n 994
2 inum_ecal 2
3 jecal_energy[1] (keV) 129.294
4 {ecal_channelf1] 1193.00
5 jecal_limit[1] (channels) 25
)
7
8
9

T —
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ecal_energy[2] (keV) 413.714
ecal_channelf2] 4037.12
ecal_limiff2] (channels) {.25

num_fwhmcal 2
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‘When the table first appears, the focus is placed on the OK button. Pressing the Tab key shifts the
focus to the Cancel button. You can use the mouse to select a cell in the table by clicking on it. If you
do, a dark black border will appear around that cell. You can now navigate between cells by using the
Tab, Shift+Tab, <—, —>, T, and { keys. You can replace the contents of a selected cell by typing new
characters into that cell. You can edit the string in a cell by first double clicking on that cell to select
the entire string inside that cell and then clicking again to establish the position of the cursor. While-
you are editing the string in a cell you can use the <— and —> keys to move around in the cell; the T
and { keys will be inactive. You can exit the cell by pressing the Tab key or the Enter key. You may
use the vertical scroll bar at the right of the screen to view more of the table.

The first column displays an index for each application constant, which serves as a row number for the
table.

name This column contains a string, which is the name of the application constant.
The program, when searching for a constant name examines only the characters
in the column up to the first blank. You may append other information such as
assumed units to the name as long as there is one or more blanks separating the
two.

value This column contains a string which can be decoded into the value for that
constant.

Row Operations:  Rows may be added, deleted, or shifted in the application constants list. See
section 4.2.2.1 for information on doing this. When editing the application
constants information, the Move this row up and Move this row down
commands can be used to rearrange the constants. See section 4.2.2.2 for
instructions on increasing the number of rows in this table.

Many of the constant names have indices. You are permitted to test as many peaks or quantities as
desired. The indices must be entered in braces [...]. Parentheses will not work.
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Tests may be added to or deleted from the list to suit the analysis characteristics of the specific

parameter set.

A description of the permitted Application constant names follows.

pu242_correlation

pu238_exponent

pu239_exponent
pu240_exponent

pu241_exponent
FRAM_SUMMARY_TYPE

num_ecal
ecal_energyl.]

ecal_channell[.]

ecal_limit[.]

The correlatior constant A in the expression for the >*Pu correlation,
which has the form

242Pu = A*[(BSPu)B * (7.39Pu)CB % (140Pu)D * (241Pu + 241 Am)E]

The units are mass fraction. Am-241 is added back to the **'Pu as
shown before the correlation is calculated. This correlation can be
tailored to most any of the specific models that have been published in
the literature.

The value of B in the #**Pu correlation above.

The value of C in the #2Pu correlation above.

The value of D in the 2**Pu correlation above.

The value of E in the >*?Pu correlation above.

Tailors the summary or short printout for plutonium or uranium
analyses. Acceptable values are PLUTONIUM or URANJUM. This
test is case sensitive so use uppercase entries as shown.

The number of peaks to be checked for peak centroid position. This
check assures that the energy calibration has been maintained. Failure
is usually not a problem unless the peaks are so far out of position that
the internal energy calibration routine can not find them.

The energy in keV of a peak to be checked for peak centroid position.
This energy should appear in the peak list.

The channel number including decimal fractions, if desired, of the peak
centroid for the peak at ecal_energy [.].

The allowable deviation in channels of the observed peak position of
the peak at ecal_energy from its specified location at
ecal_channel. If the observed peak centroid position is outside the

region from location minus limit to location plus limit, a warning
message will be printed.

Example: The acceptable peak positions for ecal_energy[1] at 129.294 keV lie between channels
1192.75 and 1193.25 in the above table.
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= Edit Application Constants - widerangeb
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1] 10itcal_energy1] (kev) 129.294 _
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| 12jfcal_energy2] (keV) 413.714 =il
] 13jtcallimitz] (V) 1080.
H_] 14lnum_ssilfract 2
fD 15{scal_energy[1] (keV) 129.294
gg 16{scal_limit[1] m(percen‘t)‘ 4;0
2,;

num_fwhmcal The number of peaks to be checked for Full Width at Half Maximum
(FWHM). This test is usually performed to see that the detector
resolution is within reasonable bounds.

fcal_energyl[.] The energy in keV of a peak to be checked for FWHM. This energy
should appear in the peak list.
fcal_limit[.] The FWHM of the peak at fcal_energy(.] must be less than this limit,

in eV or a warning message will be printed.

num_tailfract The number of peaks to be used to check for the percentage of the total
peak area falling in the tail. This test is performed to look for possible
neutron damage causing excessive peak tailing.

scal_energyl[.] The energy in keV of a peak to be checked for its tailing percentage.
This energy should appear in the peak list.

scal_limit The percentage of the total peak area permitted to fall under the tail. A
warning message will be printed if the tail percentage is greater than
this number.
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= Edit Application Constants - widerange6 l
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D 19 num_intf

i D 20{intf_1st energy[1] (keY) }185.720
D 211intf_2nd_energy[1] (keV) [203.545
[ ] 22fintt_limitf1] (ratic) 050

INE

intf_msg[1]

**possible presence of U235 ™*

|| 24)intt_1st_energyl2] (keV) [228.140
{|_] 25|inti_2nd_eneray[2] (kev) |203545
intf_limit[2] (ratio) 025

num_intf

intf_1st_energyl.]
intf_2nd_energy[.]
intf_limit[.]
intf_2nd_energyl[.].
intf_limit[.].
intf_msgf.]

The number of interference peaks to be checked. Interference peaks
are peaks that are somewhat likely to appear in a spectrum but are not
accounted for in the parameter set. Their presence, when not
accounted for in the parameter set, may bias the analysis.

To check for the presence of an interference peak we search for

the peak at intf_1st_energy[.] and ratio its gross area including
background to that of an expected peak at intf_2nd_energy[.].

The peak area ratio must be less than intf_limit[.]. The peak at
intf_2nd_energy[.] must be in the peak list. The intf_limit{.]’s are
set empirically. When a peak interference is found, the text from
intf_msgl[.] is printed. The message should be less than 80 characters

If this diagnostic is triggered one should visually examine the spectrum
and, if necessary, reanalyze the spectrum with another parameter set,
which includes the appropriate interference peaks.
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num_samptype

type_1st_peak[i] (pk.no)

12

type_2nd_peak(1] (pk no)

19

type_lower_limit[1] (ratio)

0.96

type_upper_limif[1] (ratio)

1.04

type_msg[1]

Possible non-equilibrium or heterogeneous sample.

type_l1st_peak[2] (pk.no.)

WS
R

o
'?’s':% 4

num_samptype
type_1st_peakl.]
type_2nd_peak|.]
type_lower_limit[.]
type_upper_limit[.]
type_msgl[.]

Example:

The type test checks peak activity ratios and can be used for various
diagnostic tests. An activity ratio is the isotopic activity for the
type_1st(2nd)_peak[.] ratioed to the activity for the first isotope
in the isotope list. When this activity ratio is formed for two type
peaks and ratioed, one has formed a ratio between the activities found

from the two type peaks. This ratio must be between
type_lower_limit{.] and type_upper_limit[.] or the type_msg[.]
will be printed.

From the parameter set Edit Application Constants listing above we note from row

34 that the 1st peak being compared is peak no. 12 in the peak list which is a %*!Pu peak at 148.6 keV.
From row line 35 we see that the 2nd peak being compared is peak no. 19 at 164.6 keV from the ?’U
daughter of *'Pu. If the ratio of the activities found from these two peaks is outside the range from
0.96 to 1.04, the warning message Possible non-equilibrium or heterogeneous sample is

printed.

Example:

The second comparison is between peak 5, 2*' Am at 125.3 keV with that of peak 44,

*1Am at 335.4 keV. If the activity ratio of these two peaks is not in the range from 0.93 to 1.07, the
message Possible heterogeneous (Am/Pu) sample is printed. The reason is that the Am gamma
rays may be suffering different attenuation than the plutonium gamma rays.

The structure of this test is flexible enough that you may find applications other than those illustrated.

fix_bad_bkg

This parameter can be set to TRUE or FALSE. It controls whether the
background fitting is redone with an alternate function if the program
senses that an unphysical background has been calculated. The default
value is TRUE which means that the backgrounds are automatically
recalculated even if this parameter is omitted from the Application
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Constants list. For example, a linear step background (section 4.2.3)
applied to a region with a positively sloping background continuum
will produce unphysical smoothed steps for the calculated background.
The program will recalculate the background with a linear background

- if the fix_bad_bkg parameter is TRUE or if the fix_bad_bkg
parameter is omitted from the list. If the fix_bad_bkg parameter is
FALSE the designated background fit is not changed.

NOTE! To change the database, you must click the OK button to preserve the changes
made on the screen into the worksheet. Then you must choose the Save option from the File menu to
write the contents of the worksheet into the database.

4.2.6. Edit | Postpone Editing

This option returns control immediately to FRAM’s main menu, keeping the open parameter set
active. You may perform an analysis or any other activity and then return to the editing of this set by
selecting the Parameters option in the Edit menu. Whenever you postpone the editing and choose a
menu option that requires the selection of a parameter set, you will be forced to use the one that is
active. If you try to exit FRAM, you will be reminded that a parameter set is still open. You must
close the editing session before exiting from FRAM.

4.3. Parameter Set Listing

The contents of a parameter set may be listed by:

1. Enter the Change Parameter Utility by choosing Edit, then Parameters from the main PC/FRAM
menu. Correctly complete the User Validation screen.

2. Open the desired parameter set by choosing Open under the File menu in the Change Parameter
Utility window.

3. Choose Print under the File menu to print the parameter set on the printer.

A printer listing of the parameter set widerange6 follows.

Parameter set: widerange6
Description: Planar, .1 keV/ch, Homo. Am/Pu, Equilib. 3-25% 240
Printed: 14-Dec-1995 16:49:42 Last modified: 14-Dec-1995 16:32:36

Initial values of calibration constants:
GAIN = 0.100020 kev/channel
ZERO offset = 9.985000 kev
These constants are FREE; they will be redetermined.

Initial FWHM constants for formula:
FWHM(ch) = SQRT (Al + A2*E + A3/E)

Al = 2.241700 (ch**2)
A2 = 0.019000 (ch**2/kev)
A3 = 3307.000000 (ch**2*kev)
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These constants are FREE; they will be redetermined.

Initial tailing constants for formula:
TAIL(J) = HT*EXP[(T1l + T2*E)+ (T3 + T4*E)*(J-X0)]1*[1 - EXP(-0.4*C* (J-X0)**2)]

T1 = -3.508100 ()

T2 = 0.003740 (1l/kev)

T3 = 0.220030 (1l/channel) _
T4 = 0.000000 {l/channel**2)

These constants are FREE; they will be redetermined.
Peak Parameters for widerange6

fix sum used used used used used

iso- peak line branching area area for for for for for
pk rg tope energy width ratio to with eff act ecal fcal scal
1 0 Am241 122.994 0.00 1.000e-005 5 0 N N N N N
2 0 Pu239 123.620 0.00 1.970e-007 6 0 N N N N N
3 1 Pu239 124.510 0.00 6.130e-007 6 0 N N N N N
4 1 Pu239 125.210 0.00 5.210e-007 6 0 N N N N N
5 1 Am241 125.292 0.00 4.190e-005 0 0 N Y N N N
6 2 Pu239 129.294 0.00 6.260e-005 0 0 Y Y Y Y Y
7 3 Pu239 141.657 0.00 3.200e-007 9 0 N N N N N
8 3 Pu239 143.350 0.00 1.730e-007 9 0 N N N N N
9 3 Pu239 144.211 0.00 2.840e-006 0 0 N Y N N N
10 3 Pu239 146.077 0.00 1.190e-006 9 0 N N N N N
11 3 Am241 146.557 0.00 4.610e-006 0 0 N N N N N
12 3 Pu24l1 148.567 0.00 1.832e-006 0 0 Y Y Y Y N
13 3 Am241 150.110 0.00 7.200e-007 11 0 N N N N N
14 4 Pu238 152.720 0.00 8.983e-006 0 0 N Y N N N
15 6 Pu24l 159.955 0.00 6.803e-008 19 0 N N N N N
16 6 Pu239 160.190 0.00 6.200e-008 18 o N N N N N
17 6 Pu240 160.308 0.00 3.842e-006 0 0 N Y N N N
18 6 Pu239 161.482 0.00 1.184e-006 0 0 Y Y N N N
19 5 Pu241 164.597 0.00 4.541e-007 0 0 Y Y Y Y Y
20 S5 BAm241 164.597 0.00 6.260e-007 19 19 N Y N N N
21 5 Am241 165.930 0.00 2.320e-007 0 0 N N N N N
22 7 Bm241 169.567 0.00 1.630e-006 0 0 N N N N N
23 7 Pu239 171.372 0.00 1.085e-006 0 0 Y Y N N N
24 0 Pu239 179.190 0.00 6.310e-007 0 0 N N N N N
25 0 187.960 0.00 0.000e+000 0 0 N N N N N
26 0 Pu239 189.320 0.00 7.870e-007 0 0 N N N N N
27 0 Pu239 195.660 0.00 1.090e-006 0 0 N N N N N
28 0 Pu239 196.870 0.00 3.700e-008 0 0 N N N N N
29 8 Pu239 203.545 0.00 5.570e-006 0 0 Y Y N N N
30 9 Pu24l 208.000 0.00 5.250e-006 0 0 Y Y Y Y Y
31 9 Am241 208.000 0.00 7.540e~006 30 30 N Y N N N
32 10 Pu239 255.380 0.00 7.925e-007 0 0o Y Y N N N
33 11 Pu239 263.930 0.00 2.610e-007 0 0 N N N N N
34 11 264.850 0.00 0.000e+000 0 0 N N N N N
35 11 Pu239 265.700 0.00 1.580e-008 33 0 N N N N N
36 11 Pu24l 267.540 0.00 1.793e-007 0 0 Y Y Y b4 N
37 11 Am241 267.540 0.00 2.630e-007 36 36 N Y N N N
38 12 Pu239 311.740 0.00 2.580e-007 49 0 N N N N N
39 12 311.878 0.00 0.000e+000 0 0 N N N N N
40 14 Pu241 332.387 0.00 2.935e-007 0 0 N Y N N N
41 14 Am241 332.387 0.00 1.450e-006 40 40 N Y N N N
42 14 Pu239 332.845 0.00 5.060e-006 49 40 N Y N N N
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43 14 ©Pu24l 335.422 0.00 2.354e-008 0 0 N Y N N N
44 14 Am241 335.422 0.00 4.830e-006 43 43 N Y N N N
45 14 Pu239 336.096 0.00 1.134e-006 49 43 N Y N N N
46 14 337.720 0.00 0.000e+000 0 0 N N N N N
47 13 340.450 0.00 0.000e+000 0 0 N N N N N
48 13 Pu239 341.495 0.00 6.620e-007 49 0 N N N N N
49 13 Pu239 345.011 0.00 5.593e-006 0 0 Y Y Y Y Y
50 15 Pu239 367.036 0.00 8.650e-007 -0 0 N N N N N
51 15 Pu239 368.536 0.00 9.030e-007 50 0 N N N N N
52 15 Pu24l1 368.605 0.00 1.034e-008 0 0 N Y N N N
53 15 Am241 368.605 0.00 2.120e-006 52 52 N Y N N N
54 15 Pu24l 370.934 0.00 2.672e-008 0 0 N Y N N N
55 15 Am241 370.934 0.00 5.200e-007 54 54 N Y N N N
56 16 372.450 0.00 0.000e+000 0 0 N N N N N
57 16 Pu239 375.042 0.00 1.570e-005 0 0 Y Y Y Y N
58 16 2Am241 376.590 0.00 1.330e-006 0 0 N N N N N
59 17 Pu239 380.170 0.00 3.050e-006 0 0 N Y N N N
60 17 Pu239 382.743 0.00 2.587e-006 0 0 N Y N N N
61 17 Am241 383.740 0.00 2.820e-007 0 0 N N N N N
62 18 BAm241 390.540 0.00 5.900e-008 0 0 N N N N N
63 18 Pu239 392.545 0.00 1.934e-006 64 0 N Y N N N
64 18 Pu239 393.120 0.00 3.609e-006 0 0 N Y N N N
65 19 Pu239 411.150 0.00 6.800e-008 66 0 N Y N N N
66 19 Pu239 413.712 0.00 1.489%e-005 0 0 Y Y Y Y Y
67 18 414.870 0.00 0.000e+000 0 0 N N N N N
68 19 415.760 0.00 0.000e+000 0 0 N N N N N

Peak infomation summary for widerangeb

Peaks used for efficiency determination:
eff fn.

6
12
18
19
23
29
30
32
36
49
57
66

Peaks used for relative activity determination:

energy
129.2
148.5
161.4
164.6
171.3
203.5
208.0
255.3
267.5
345.0
375.0
413.7

9
7
8
0
7
5
0
8
4
1
4
1

isotope
Pu239
Pu24l
Pu239
Pu241
Pu239
Pu239
Pu241
Pu239
Pu241l
Pu239
Pu239
Pu239

energy isotope
125.29 Am241
129.29 Pu239
144.21 Pu239
148.57 Pu241
152.72 Pu238
160.31 Pu240
161.48 Pu239
164.60 Pu241
164.60 Am241
171.37 Pu239
203.55 Pu239
208.00 Pu241
208.00 Am241

L S
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32
36
37
40
41
42
43
44
45
49
52
53
54
55
57
59
60
63
64
65
66

255.
267.
267.
332.
332.
332.
335.
335.
336.
345.
368.
368.
370.
370.
375,

380.
382.
392.
393.
411.
413.

38
54
54
39
39
85
42
42
10
01
61
61
93
93
04
17
74
55
12
15
71

Pu239
Pu241
Am241
Pu241
Am241
Pu239
Pu241l
Am241
Pu239
Pu239
Pu241l
Am241
Pu241l
Am241
Pu239

Pu239
Pu239
Pu239
Pu239
Pu239
Pu239

Peaks used for energy calibration:
energy

129.
148.
164.
208.
267.
345.
375.
413.

29
57
60
00
54
01
04
71

isotope
Pu239
Pu241
Pu241
Pu241
Pu241
Pu239
Pu239
Pu239

Peaks used for fwhm calibration:
energy

6
12
19
30
36
49
57
66

129.
148.
164.
208.
267.
345.
375.
413.

29
57
60
00
54
01
04
71

isotope
Pu239
Pu241
Pu24l
Pu241l
Pu241l
Pu239
Pu239
Pu239

Peaks used for shape calibration:
energy

6
19
30
49
66

129.
164.
208.
345.
413.

29
60
00
01
71

isotope
Pu239
Pu241
Pu241
Pu239
Pu239

Region Parameters in kev. for widerange6

region region

BKG BKG BKG BKG BKG BKG BKG BKG
#1 #1 #2 #2 #3 #3 #4 #4
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start stop start stop start stop start stop start stop type
1 124.0 130.3 126.4 127.1 130.7 131.4 132.5 133.2 0.0 0.0 linear step
2 128.0 130.3 126.8 127.3 130.9 131.4 132.7 133.2 0.0 6.0 linear step
3 141.0 150.8 139.8 140.2 140.4 140.8 142.3 142.7 150.9 151.3 linear step
4 151.8 153.6 151.2 151.7 153.8 154.3 0.0 0.0 0.0 0.0 linear
5 163.3 166.6 162.4 162.8 166.6 167.0 167.0 167.4 0.0 0.0 linear step
6 159.0 162.2 158.7 159.2 162.4 162.9 - 0.0 0.0 0.0 0.0 linear
7 168.8 172.2 168.2 168.7 172.3 172.8 0.0 0.0 0.0 0.0 linear
8 202.0 204.7 201.8 202.2 204.7 205.1 0.0 6.0 0.0 0.0 linear
9 206.7 209.3 204.9 205.6 209.9 210.6 211.6 212.3 0.0 0.0 linear step
10 254.2 256.5 252.7 253.1 253.7 254.1 256.7 257.1 0.0 0.0 linear step
11 262.7 269.0 261.2 261.5 262.2 262.5 269.1 269.4 270.1 271.4 linear step
12 310.4 313.1 309.3 309.8 313.8 314.3 0.0 0.0 0.0 0.0 linear
13 339.6 346.6 327.7 328.2 328.6 329.1 347.5 348.0 348.7 349.2 flat step
14 330.2 338.6 327.7 328.2 328.6 329.1 347.5 348.0 348.7 349.2 flat step
15 365.6 372.0 363.2 363.7 364.0 364.5 385.2 385.7 385.9 386.4 flat step
16 372.1 377.8 363.2 363.7 364.0 364.5 385.2 385.7 385.9 386.4 flat step
17 378.4 384.2 363.2 363.7 364.0 364.5 385.2 385.7 385.9 386.4 flat step
18 389.5 394.7 387.5 387.9 388.4 388.8 396.5 396.9 397.3 397.7 flat step
19 409.9 417.0 408.1 408.8 409.0 409.7 417.5 418.2 0.0 0.0 flat step
Region Parameters in channels for widerange6
BKG BKG BKG BKG BKG BKG BKG BKG
region region #1 @ #1 $#2  #2 #3  #3 #4  #4 background
start stop start stop start stop start stop start stop type
1 1140 1203 1164 1171 1207 1214 1225 1232 0 0 linear step
2 1180 1203 1168 1173 1209 1214 1227 1232 0 0 linear step
3 1310 1408 1298 1302 1304 1308 1323 1327 1409 1413 linear step
4 1418 1436 1412 1417 1438 1443 0 0 0 0 linear
5 1533 1566 1524 1528 1566 1570 1570 1574 0 0 linear step
6 1490 1522 1487 1492 1524 1529 0 0 0 0 linear
7 1588 1622 1582 1587 1623 1628 0 0 0 0 linear
8 1920 1947 1918 1922 1947 1851 0 0 0 0 linear
9 1967 1993 1949 1956 1999 2006 2016 2023 0 0 linear step
10 2442 2465 2427 2431 2437 2441 2467 2471 0 0 linear step
11 2527 2590 2512 2515 2522 2525 2591 2594 2601 2614 linear step
12 3004 3031 2993 2998 3038 3043 0 0 0 0 linear
13 3295 3365 3177 3182 3186 3191 3374 3379 3386 3391 flat step
14 3202 3285 3177 3182 3186 3191 3374 3379 3386 3391 flat step
15 3555 3619 3531 3536 3539 3544 3751 3756 3758 3763 flat step
16 3620 3677 3531 3536 3539 3544 3751 3756 3758 3763 flat step
17 3683 3741 3531 3536 3539 3544 3751 3756 3758 3763 flat step
18 3794 3846 3774 3778 3783 3787 3864 3868 3872 3876 flat step
19 3998 4069 3980 3987 3989 3996 4074 4081 0 0 flat step
Isotope Parameters for widerangeé6
power pu240 eff
name half-life units mass (mw/g) coef. function
1 Pu239 2.41190e+004 years 23%9.0522 1.9288 0.00 1
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2 Pu241  1.43480e+001 years 241.0569 3.4112 0.00 1
3 Am241 4.33600e+002 years 241.0568 114.2000 0.00 1
4 Pu238 8.77400e+001 years  238.0496 567.5700 2.52 1
5 Pu240 6.56400e+003 years 240.0538 7.0824 1.00 1
6 Pu242 3.76300e+005 years  242.0587 0.1159 1.68 1

Application Specific Constants for widerange6

name value
pu242_correlation .994
pu238_exponent 0.
pu239_exponent -2.0
pu240_exponent 1.0
pu24l_exponent 1.0
FRAM SUMMARY TYPE PLUTONIUM
num_ecal 2
ecal energy(1l] (keV) 129.294
ecal_channel (1] 1193.00
ecal limit (1] (channels) .25
ecal_energy(2] (keV) 413,714
ecal_channel[2] 4037.12
ecal limit[2] (channels) .25
num_fwhmcal 2
fcal _energy(l] (keV) 129.294
fcal limit{1] (eV) 630,
fcal energyl[2] (keV) 413.714
fcal_limit([2] (eV) 1080.
num_tailfract 2
scal_energyl[l] (keV) 129.294
scal_limit([1] (percent) 4.0
scal_energy(2) ( (keV) 413.714
scal limit[2] (percent) 15.0
num_intf 3
intf_ lst_energy (1} (keV) 185.720
intf 2nd energy(1} (keV) 203.545
intf limit([1] (ratio) .050
intf msg[1) ** possible presence of U235 **
intf_1lst_energy(2] (keV) 228.140
intf 2nd energy[2] (keV) 203.545
intf limit([2] (ratio) .025
intf msg[2] ** possible presence of Np239 **
intf_ lst_energy[3] (keV) 311.890
intf 2nd_energy[3) (keV) 345.011
intf limit[3] (ratio) 2.000
intf msg({3] ** possible presence of Np237 **
num_samptype 2
type_1lst_peak[1] (pk. no.) 12
type_2nd_peak[1] (pk. no.) 19
type_lower limit(1] (ratio) 0.96
type upper limit(1] (ratio) 1.04
type_msg[1] Possible non-equilibrium or heterogeneous sample.
type lst_peak(2] {(pk. no.) 5
type_2nd_peak[2] (pk. no.) 44
type lower limit[2] (ratio) 0.94
type_upper limit[2] (ratio) 1.06

type_msg([2]
fix_bad bkg

Possible heterogeneous (Am/Pu) sample.

TRUE
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5.  Output Listings

Three levels of printer output (Short, Medium, and Long) are available to users on a system with a printer.
These three print levels are inputs in dialog boxes associated with the Measure | Measure Sample option

and the Measure | Analyze Data option. A screen copy of the short printout is sent to the monitor after each
analysis no matter what print level is selected. -

Under the Options menu, you can print or display results from the latest analysis or a previously saved results
file at any of the above levels.

5.1. Short Output

A typical short output is shown below.

******************************************************************************
PC FRAM (V3.2) Isotopic Analysis 12-Jan-1999 15:06:52

(Fixed energy Response function Analysis with Multiple efficiencies)

System ID: My system

spectrum source: Test (ORTEC MCB: )
spectrum date: 12-Jan-1999 15:06:42
live time: 2817 s

true time: 3600 s

num channels: 8192

parameter set: coax8kl125 (1999.01.12 07:38)
Coax .125 kev/ch, Homo. Am/Pu, Equ., 3-25% Pu240,<460 keV
spectrum file: c:\fram32\spectra\Test.ssp

results file: c:\fram32\results\Test.res
******************************************************************************

hkdkkhkkdhkhhhhhhkhhhhdkhkdhhkdhkhkdrhhdhhhhhhkhhkhkhkdhohhkhhkhhkdhdhrhhhhhbhkhkdhhkhkhhhdhdrdhkhhrdddkx

diagnostics passed.

(By Corr) (ug/gPu)

Pu238 Pu239 Pu240 Pu241 Pu242 Am241
mass$% .00672 93.79265 5.99797 .17806 .02458 1846.3
sigma .00110 .15581 .15601 .00036 .00614 32.1
$RSD 16.39% 0.17% 2.60% 0.21% 25.01% 1.74%
$TotPwr: 1.5336 72.6827 17.0671 .2440 .0011 8.4713
Specific Power (W/gPu): ( 2.4889 +/- .0135)e-003 ( 0.54%)
Effective Pu240 fraction: ( 6.0562 +/- .1560)e-002 ( 2.58%)
Time since chemical separation: 5429.97 +/- 68.16 days ( 1.26%)

dddkkdkhkdehkhkhkhkdhdhkhkhkdkrhhhhkhhhhhhhhhkhkhkdkhdhhhhkhkhkdkhdbhdbhbhkhdhkhkhrhhhhdbhhkdhhhkhrhbkhrhkdhhhkhxdkhk
hkkkhkhkhhhkhkhkihkhkkhhkhkhhkdhkhkhhkhkhkkhhkhkhkhhkhhkhkhkhhkhhkhkhkhkhkkhkhkhhkhhkhkhkdkdkkhkdkdhkhhkhkhkhhhkhhhhhkhdh
total Pu: 403.082 g
sample power: 1.0000 W
specific power: 2.4808 mW/gPu
date: 28-Feb-1998

& & Kk g T de Fe g Kk K g g ke e ke e e de g sk gk ok ke ke ke ke e ke e ke e ke ok de ok e ke e e ke ke %k g ok sk gk ke ok ke Xk gk ok ok gk ke e ke ke ke ke ke ke ok ke e ke ke e e ok

Header Block Information The first information printed is information about the sample,
measurement system, measurement conditions, and data storage information.
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diagnostics passed A report from any failed diagnostic tests as established in the
Application Constants list is appended here. The report includes the value of
the tested parameter and the limits compared against.

Pu242 This is labeled as (By Corr) from the correlation specified in the Application
Constants in the parameter set used for the analysis, or (OpEntry) as entered
by you in the dialog boxfor the Measure options.

Am241 This isotopic ratio is expressed as pg/gPu or ppm with respect to the total
plutonium. Multiply this value by 10~ to convert to mass percent.

mass% The isotopic percentage by weight relative to total plutonium.

sigma The absolute uncertainty representing one standard deviation propagated from

counting statistics, closely representing the standard deviation that is observed
from repeated measurements.

% RSD The relative standard deviation expressed as a percentage. It is calculated as
(sigma/mass%) *100

$TotPwr The percentage of the total power (Watts) from the sample that is contributed by
the indicated isotope. It is calculated from the known Watts/gram for each
isotope weighted by the measured fraction of that isotope in the sample. This

parameter is listed only for information purposes.

Specific Power (W/gPu) The sum over all heat producing isotopes of the product of the
Watts/gram for each isotope times the measured isotope fraction in the sample.
It is used to interpret a calorimetry measurement of the total sample power in
Watts.

Effective Pu240 fraction 2.52*mass%(Pu238) + 1.00*mass%(Pu240) + 1.68*mass%(Pu242)
This parameter is used to interpret neutron coincidence counting measurements of
Effective Pu240 mass in terms of total plutonium mass. The coefficients in this
equation are entered as pu240 coef. through the Edit | Isotopes option in the
Change Parameter Utility.

Note the exponents on the Specific Power: and Effective Pu240
fraction:. The uncertainties for these quantities are absolute (within the first
parentheses) and one relative standard deviation expressed as a percentage (in the
second parentheses).

Time since chemical separation The time in days since the last chemical separation of
#1Am and ®’U from the sample. It is calculated from the equation

time(days) = 7819.176*In(0.9669335*R + 1)
where R is the *' Am/**'Pu abundance ratio.

Calorimetry Report (optional) If you enter a calorimeter wattage and date in the dialog box
associated with the Measure | Measure Sample or the Measure | Analyze
Data option, we append a report of the total plutonium mass in the sample as of
the date of the calorimetry measurement. If a calorimetry wattage is not
entered, this report is not printed.
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5.2. Medium Output

A medium printout shown below appends about a half dozen pages before ending with the short printout

previously shown. Description of some of the features of this output follows the example. The short
output that is normally at the end of the medium output is not shown here.

******************************************************************************
PC FRAM (V3.2) Isotopic Analysis 12-Jan-1999 15:06:52

(Fixed energy Response function Analysis with Multiple efficiencies)

System ID: My system

spectrum source: Test (ORTEC MCB: )
spectrum date: 12-Jan-1999 15:06:42
live time: 2817 s

true time: 3600 s

num channels: 8192

parameter set: coax8kl125 (1999.01.12 07:38)
Coax .125 kev/ch, Homo. Am/Pu, Equ., 3-25% Pu240,<460 keV

******************************************************************************

Table used for energy calibration:

centroid energy
1 1034.213 129.294
2 1188.432 148.567
3 1316.732 164.597
4 1664.000 208.000
5 2140.408 267.540
6 2760.013 345,011
7 3000.379 375.042
8 3309.668 413.712
9 3611.813 451.474

e d de K e g de g d de F kg o kK ok g e gk ek % ok gk gk ok ek ke gk g e ek e ke ok ke ok ok e gk e ok ke ke ok ok 3k o ke ok ok e e e ke e e e ok ek ok e ok ke ke e ke ok ok

FWHM parameter in the formula:
fwhm = SQRT( Al + A2*E + A3/E )

Al = 4.695017e+001 sigma = 8.652252e+000
A2 = 1.473442e-001 sigma = 1.564259e-002
A3 = 4.008763e+002 sigma = 9.807882e+002
Qfit = 6.792e+000 R**2 = .97798 Cond = 7.260e+005
interp. fitted
energy centroid fwhm fwhm error formula ratio
1 129.294 1034.221 8.3996 8.3096 .42% 8.3127 .9996
2 148.567 1188.375 8.5242 8.3889 1.41% 8.4580 .9918
3 164.597 1316.651 8.9219 8.9181 2.13% 8.5812 1.0392
4 208.000 1664.021 8.9762 8.9242 .27% 8.9176 1.0007
5 345.011 2760.024 9.8625 9.8780 .27% 9.9472 .9930
6 413.712 3309.683 10.5373 10.4648 .11% 10.4344 1.0029
7

451.474 3611.845 10.7840 10.5934 .28% 10.6939 .9906

% %k Kk Kk Fe k& g K deodke de g de g de e ke ke ke ok g ek g e g e g ek e gk e e gk e T e ek ok ke e ke ke ke e ke de e g de ke ke ke de e de e e e e e e ke de ke e de e de ke ke ke

Shape parameters in the formula:
log(tail(j)/hght/roll off) = (T1+T2*E) + (T3+T4*E)* (x-x0)

T1
T2

-2.035781e+000 sigma
-2.430535e-003 sigma

0.000000e+000
0.000000e+000
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T3 = 2.187396e-001 sigma = 0.000000e+000
T4 = 0.000000e+000 sigma = 0.000000e+000
Qfit = 6.792e+000 R**2 = .97798 Cond = 7.260e+005
energy amp slope
1 129.294 9.536585e-002 2.187396e-001
2 164.597 8.752421e-002 2.187396e-001
3 208.000 7.876139%9e-002 2.187396e-001
4 345.011 5.645324e-002 2.187396e-001
5 451.474 4.358228e-002 2.187396e-001

Fhkikkdkhdkkhhhhhhdhhhkhhhkhhkhkhhhhhdhhhhhkhhhhdhhdhhhhhdhkhkhhhhdhdhhohdhhhkrhhdbhhhrhrhhkhhkhdhh

Calibration Diagnostics:

check energy calibration:

1 at 208.000 kev, centroid = 1663.994 [ 1663.500 < ? < 1664.500]
2 at 662.456 kev, centroid = 5299.119 [ 5297.900 < ? < 5300.900}
check fwhm calibration:
3 at 413,714 kev, fwhm = 1304.3 ev [? < 1500.0]}
check shape calibration:
4 at 413.714 kev, tail fraction = .43% [? < 5.00%]
check for interferences:
S ( 185.719, 203.545) peak area ratio = 1.446e-002 [? < .050]
6 ( 228.140, 203.545) peak area ratio = 1.035e-003 [? < . 025}
7 ( 311.887, 345.011) peak area ratio = 9.839e-002 [? < 2.000]

dhkkkdkhhhkdhhkhkhdhhdhhkhhhkhhkhhhhhkdhkdhhhhhkhhhhhhkhhkhhhdhkkhkdhkdhdkhhrhkhkkhdhdhdhhhhhkhhdkhk

Results of efficiency calculations:

coefficient error
2.7205%e+001 2.52286e-001 (Pu239)
-2.06876e-002 1.36124e-002 (L/E**2)
1.87696e+000 8.18336e-001 (log(E})
1.38282e+000 7.73372e~-001 (log (E) **2)
5.56068e-001 3.06374e-001 (log (E) **3)
1.15415e+000 5.44325e-003 (Pu241)
Qfit = 4.634e+000 R**2 = .99985 Cond = 2.783e+004
pk isotope energy area error branch log(A/Br) predicted exp(dif)
1 6 Pu239 129.294 712347 0.16% 6.2600e-005 23.155 23.155 .9998
2 12 Pu241 148.567 134405 0.62% 1.8320e-006 25.018 25.016 1.0021
3 18  Pu239 161.482 39913  2.09% 1.1840e-006 24.241  24.216 1.0247
4 19 Pu241 164.597 50424 1.67% 4.5410e-007 25.433 25.445 .9878
5 23 Pu239 171.372 44924 1.86% 1.0850e-006 24.446 24.441 1.0053
6 24 Pu239 203.545 392456 0.25% 5.5700e-006 24.978 24.979 .9986
7 25 Pu241 208.000 1244624 0.11% 5.2500e-006 26.191 26.191 1.0003
8 27 Pu239 255.380 92027 0.76% 7.9250e-007 25.477 25.488 .9891
9 31 Pu241 267.540 70437 0.91% 1.7930e-007 26.696 26.725 .9715
10 44 Pu239 345.011 1020602 0.11% 5.5930e-006 25.929 25.930 .9993
11 52 Pu239 375.042 3149942 0.06% 1.5700e-005 26.024 26.023 1.0012
12 61 Pu239 413.712 3292167 0.06% 1.4890e~005 26.121 26.123 . 9986
13 64 Pu239 451.474 456620 0.15% 1.8900e-006 26.210 26.206 1.0039
isotope beta
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Pu239 0.00000
Pu241l 0.00000
Bm241 0.00000
Pu238 0.00000
Pu240 0.00000
Pu242 0.00000

dd Ak hkhdkdddk gk d ok kg kg ok gk k ok ok gk ok gk kg gk ok Kk ok kg dod ook ok ek sk ke sk ok ke e ok ke ke ok ek do e e e ok ke ok ok ke ke e ke ke ke ok

Results of activity calculations:

isotope

ratio
Pu239/Pu239
Pu241/Pu239
Am241/Pu239
Pu238/Pu239
Pu240/Pu239
Pu242/Pu239

ofit = 1.

activity

ratio
1.00000e+000
3.16485e+000
1.08588e-001
1.97943e-002
2.33997e-001
0.00000e+000

Individual ratios:

pk isotope

6 Pu239

9 Pu239
18 Pu239
23 Pu239
24 Pu239
27 Pu239
44 Pu239
52 Pu239
54 Pu239
55 Pu239
59 Pu239
61 Pu239
64 Pu239
12 Pu241l
19 Pu241l
25 Pu241
31 Pu24l
35 Pu241l
38 Pu241
47 Pu24l
49 Pu241
5 Am241
20 Am241
26  Am241
32 Am241
36 Am241
39 Am241
48 Am241
50 Am241
14 Pu238
17 Pu240

mass
ratio

1.00000e+000
1.89850e~003
1.96852e-003
7.17056e-005
6.39493e-002
0.00000e+000

467e+001 R**2 = .99998
energy area = error
129.294 712347 0.16%
144.211 55907 1.38%
161.482 39913 2.09%
171.372 44924 1.86%
203.545 392456 0.25%
255.380 92027 0.76%
345.011 1020602 0.11%
375.042 3149942 0.06%
380.170 628651 0.14%
382.743 536128 0.15%
383.120 758668 0.12%
413.712 3292167 0.06%
451.474 45662C 0.15%
148.567 134405 0.62%
164.597 50424 1.67%
208.000 1244624 0.11%
267.540 70437 0.91%
332.387 155879 0.41%
335.422 13991 3.50%
368.605 7245 6.15%
370.934 17632 2.62%
125.292 43282 1.74%
164.597 2365 1.61%
208.000 60817 0.06%
267.540 3515 0.83%
332.387 26201 0.34%
335.422 97670 4.10%
368.605 50539 6.82%
370.934 11674 2.58%
152.720 4677 16.39%
160.308 29354 2.77%

2.77%
>99.99%

Cond =

activity
ratios

9.9989%¢e-001
9.79444e-001
1.02476e+000
1.00537e+000
9.98625e-001
9.89116e-001
9.99398e-001
1.00125e+000
1.01396e+000
1.01232e+000
9.98978e-001
9.98603e-001
1.00397e+000

3.17817e+000
3.13283e+000
3.17257e+000
3.08096e+000
3.04175e+000
3.36637e+000
3.56222e+000
3.33205e+000

1.09964e-001
1.0658%e-001
1.07%41e-001
1.04824e-001
1.03490e-001
1.14534e-001
1.21198e-001
1.13367e-001

1.98051e-002

2.34125e-001
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1.798e+308

mass
ratios

9.9989%e-001
9.79444e-001
1.02476e+000
1.00537e+000
9.98625e-001
9.89116e-001
9.99398e-001
1.00125e+000
1.01396e+000
1.01232e+000
9.98978e-001
9.98603e-001
1.00397e+000

1.90650e-003
1.87930e-003
1.90314e-003
1.84818e-003
1.82466e-003
2.01939%e-003
2.13688e-003
1.99880e-003

1.99346e-003
1.93227e-003
1.95678e-003
1.90028e-003
1.87609e-003
2.07631e-003
2.19711e-003
2.05514e-003

7.17448e-005

6.39842e-002
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Summary of peak information:

Pk

isotope
Am241
Pu239
Pu239
Pu239
Am241
Pu239
Pu239
Pu239
Pu239
Pu239
Am241
Pu241
Am241
Pu238
Pu241
Pu239
Pu240
Pu239
Pu241
Am241
Am241
Am241
Pu239
Pu239
Pu241
Am241
Pu239
Pu239

Pu239
Pu241l
Am241
Pu239

Pu241
Am241
Pu239
Pu241
Am241
Pu239

Pu239
Pu239
Pu239
Pu239
Pu241
Am241
Pu241
Am241

Pu239
Am241
Pu239
Pu239
Am241
Am241
Pu239

energy
122.99%4
123.620
124.510
125.210
125.292
129.294
141.657
143.350
144.211
146.077
146.557
148.567
150.110
152.720
159.955
160.190
160.308
161.482
164.597
164.597
165.930
169.567
171.372
203.545
208.000
208.000
255.380
263.930
264.850
265.700
267.540
267.540
311.740
311.887
332.387
332.387
332.845
335.422
335.422
336.096
337.720
340.450
341.495
345.011
367.036
368.536
368.605
368.605
370.934
370.934
372.449
375.042
376.590
380.170
382.743
383.740
390.540
392.525

area

0

0

5570
3142
43282
712347
5775
3309
55907
24897
10680
134405
1861
4677
6418
2156
29354
39913
50424
2365
1258
7018
44924
392456
1244624
60817
92027
32182
0

1971
70437
3515
41404
57088
155879
26201
883974
13991
97670
200500
4426
5329
119333
1020602
169478
177716
7245
50539
17632
11674
5455
3149942
42031
628651
536128
5138

0
405930

error
>99.99%
>99.99%
0.10%
0.10%
1.74%
0.16%
1.31%
1.31%
1.38%
1.35%
7.01%
0.62%
7.06%
16.39%
1.67%
1.99%
2.77%
2.09%
1.67%
1.61%
63.42%
11.40%
1.86%
0.25%
0.11%
0.06%
0.76%
1.93%
>99.99%
1.84%
0.91%
0.83%
0.11%
1.00%
0.41%
0.34%
0.11%
3.50%
4.10%
0.11%
10.92%
8.93%
0.06%
0.11%
0.36%
0.36%
6.15%
6.82%
2.62%
2.58%
8.21%
0.06%
1.04%
0.14%
0.15%
7.15%
>99.99%
0.10%

eff
.0847
0874
.0912
.0944
.0947
.1138
.1843
.1953
.2009
.2135
.2168
.2308
.2418
.2609
.3166
.3185
.3195
.3289
.3544
.3544
.3655
.3963
.4118
.7055
.7472
.7472
1.1740
1.2455
1.2530
1.2600
1.2750
1.2750
1.6078
1.6088
1.7460
1.7460
1.7490
1.7655
1.7655
1.7698
1.7801
1.7974
1.8039
1.8258
1.9578
1.9665
1.9669
1.9669
1.9803
1.9803
1.9890
2.0038
2.0126
2.0327
2.0471
2.0527
2.0902
2.1010
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hfac mass ratios
1.0000 0.0000e+000
1.0000 0.0000e+000
1.0000 9.9535e~-001
1.0000 9.9612e-001
1.0000 1.9935e-003
1.0000 9.9990e-001
1.0000 9.7893e~-001
1.0000 9.7929%e-001
1.0000 9.7944e-001
1.0000 9.7971e-001
1.0000 1.9368e-003
1.0000 1.9065e-003
1.0000 1.9373e-003
1.0000 7.1745e-005
1.0000 1.8803e-003
1.0000 1.0249e+000
1.0000 6.3984e-002
1.0000 1.0248e+000
1.0000 1.8793e-003
1.0000 1.9323e-003
1.0000 2.6883e-003
1.0000 1.9696e-003
1.0000 1.0054e+000
1.0000 9.9862e-001
1.0000 1.9031e-003
1.0000 1.9568e~-003
1.0000 9.8912e-001
1.0000 9.8999%e-001
1.0000 0.0000e+000
1.0000 9.9000e-001
1.0000 1.8482e-003
1.0000 1.9003e-003
1.0000 9.9808e-001
1.0000 0.0000e+000
1.0000 1.8247e-003
1.0000 1.8761e-003
1.0000 9.9884e-001
1.0000 2.0194e-003
1.0000 2.0763e-003
1.0000 9.9900e-001
1.0000 0.0000e+000
1.0000 0.0000e+000
1.0000 9.9924e-001
1.0000 9.9940e-001
1.0000 1.0007e+000
1.0000 1.0008e+000
1.0000 2.1369%9e~003
1.0000 2.1971e-003
1.0000 1.9988e-003
1.0000 2.0551e-003
1.0000 0.0000e+000
1.0000 1.0012e+000
1.0000 2.8465e-003
1.0000 1.0140e+000
1.0000 1.0123e+000
1.0000 1.6091e-003
1.0000 0.0000e+000
1.0000 9.9897e-001

Lo s L B ]

EA QWT

EA

EA OWT
AFS
EA

F
EA Q
AFS
F

A
AFS
FS
A
AFS
FS

F
EA QWT

F
A
AFS
A
AFS

EA Q

A
a
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Pu239 393.120 758668 0.12% 2.1043 1.0000 9.9898e-001 A
Pu239 411.150 14944 0.01% 2.2006 1.0000 9.9865e-001 F
Pu239 413.712 3292167 0.06% 2.2140 1.0000 9.3860e-001 EA QW
414.870 26175 1.16% 2.2201 1.0000 0.0000e+000
415.760 18493 1.50% 2.2247 1.0000 0.0000e+000
Pu239 451.474 456620 0.15% 2.4064 1.0000 1.0040e+000 EA  QWT

Efficiencies are divided by 1.0e+011 .

HE0o P E

.

this peak is used to determine relative efficiencies.
this peak is used to determine relative activities.

. this peak is fixed to another peak.

this peak is summed with another peak.

this peak is ued to determine the energy calibration.
this peak is used to determine the fwhm calibration.
this peak is used to determine the shape calibration.

hhhkdhhkhkhkhkhkhkhhkhkdhhhhkhkhkdhkdhhhohhkhhkhkhkhhhkhkhkhkhhkkhkhkhkhkhkkhkhkhkhkhdhhkdhkdhkhkhkkhkhkdhdhkhkhkhkhkkhkhkkkhkk

Check sample types:

1
2

1.014e+000 [ .950 < ? < 1.050]
9.601e-001 [ .930 < ? < 1.070]

( 148.567, 164.597) mass ratio
( 125,292, 335.422) mass ratio

Table used for energy calibration:

This table lists the centroid in channels of the peaks designated as energy calibration peaks. The energy
calibration is a piecewise linear calibration between adjacent pairs of energy calibration peaks.

FWHM parameters in formula:

In the table displaying the results of the FWHM fitting, the heading width gives the FWHM from a
simple linear interpolation and is used only as a check on the other values.. £whm lists the values from the
FWHM fitting which are input to a least squares fit to obtain the formula. formula gives the value from
the formula and fitted parameters A1 . . . A3. The formula values are used in the response function fitting.
ratio is fwhm divided by formula. The units of the formula coefficients are such that FWHM is in
channels when E (energy) is in keV.

Shape parameters in formula:

We customarily set T4 to zero in the expression for parametrizing the energy dependence of the tailing
parameters.

Calibration Diagnostics:

This section displays the results from some of the diagnostic tests set up in the Application Constants
dialog. If any of these tests fail, the complete diagnostic will be displayed on the short output listing.

Results of efficiency calculations:

The coefficients correspond to the constants in the expression for the relative efficiency given in Appendix
A. The first coefficient represents the first isotope in the isotope list. All relative activity calculations are
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performed relative to this isotope. predicted is the fitted value of log (A/Br) where A is the peak
area and Br is the branching ratio and ratio is log (A/Br) /predicted.

The Qfi t value will seldom be near unity (even though it is in this example) because the empirical
relative efficiency formula is not an exact match for the physical processes governing the shape of the
relative efficiency curve.

beta will be nonzero only for isotopes declared in the isotope list to have a different relative efficiency
curve from that for the first isotope.

Results of Activity Calculation:

This section gives the calculated results for the fundamental quantities computed in PC/FRAM

PC/FRAM may be used to measure isotopic ratios other than from plutonium. While a dedicated printout
format can be designated for uranium (Application Constants FRAM_SUMMARY _TYPE, URANIUM)
no such formal output exists at this time for other than uranium and plutonium. The final answers for
measured isotopic ratios for samples without uranium or plutonium would be obtained here.

The remainder of this section shows the individual activity ratios for each peak designated as an activity
peak. All the peaks for a given isotope should have the same activity ratio, within statistical uncertainties,
for all gamma rays. A peak consistently out of conformance with others from the same isotope may
indicate the need for a branching ratio adjustment or close examination of the fitting parameters in that
region. It could also indicate the presence of an unidentified interference.

Summary of Peak Information:

This section presents the final peak areas and uncertainties (error at the one RSD level), scaled relative
efficiency values (ef£), and the heterogeneity factor (hfac = exp(B/E)). mass ratios are given for
all peaks whether or not they were designated as an activity peak. The letter codes at the right are keyed at
the bottom of the section.

Check Sample Types:

Displays the results from some of the diagnostic tests set up in the Application Constants dialog. If any of
these tests fail, the complete diagnostic will be displayed on the short output listing. The tests listed in this
section can diagnose nonequilibrium #*'Pu-#?U decay and Am/Pu heterogeneity.

Shert output

A Medium printout ends with the short output on the last page. This is not shown here.

5.3. Long Printout

A long printout inserts a Summary of the Results for each Region into the Medium
printout previously shown. This section displays statistical parameters from the response function fit to
each region. Normally one expects Qfit to be near unity for a good fit. For very intense peaks Qfit will
often be >> 1 representing our inability to perfectly model the peak shape within counting statistics.  R?
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will be near unity for a good fit. Cond is a parameter that describes the nearness to singularity of the
inverted matrix. The larger the number, the more nearly the matrix is to being singular. This section also
provides information about each of the peaks in the given region. The following information is listed: peak
index, name of the associated isotope, energy, centroid, full-width at half-max, tailing amplitude, tailing
slope, area, error associated with the area, the group index of the peak, and the area factor. Each free peak
is assigned a unique group index while the other peaks are assigned the group index of the free peak that
they are fixed to. The area factors are the weights assigned to the functional form of each peak when
constructing a composite response for all the peaks in a single group.

J¢ F Fe de kg de Fe e e e de e gk de ek e ke e de e e g de g e e de e o g e de de ke kg e e e de ok ke ke Tk Kk ke ke ke ke e e ok ke ke e S vk g vk ke e ke ok ke e gk ke ke e e e ke ke e

Summary of the results for each region:

region 1 from channel 1021 to 1048

(

127.600 kev to

131.000 kev)

total net counts = 710519.6
Qfit = 1.020e+000 R**2 = .99990 Cond = 1.000e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
6 Pu239 129.294 1034.221 8.312 .095 .218 712523 0.16% 1 1.0000
region 2 from channel 992 to 1048 ( 124.000 kev to 131.000 kev)
total net counts = 761288.6
ofit = 6.348e-001 R**2 = .99992 Cond = 1.502e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
3 Pu239 124.510 995.932 8.277 .096 .218 5570 0.10% 2 .0078
4 Pu239 125.210 1001.534 8.282 .096 .218 3142 0.10% 2 .0044
5 Am241 125.292 1002.190 8.283 .096 .218 43282 1.74% 1 1.0000
6 Pu239 129.294 1034.221 8.312 .095 .218 712347 0.16% 2 1.0000
region 3 from channel 1126 to 1208 ( 140.800 kev to 151.000 kev)
total net counts = 232897.9
Qfit = 6.198e-001 R¥**2 = .99793 Cond = 1.386e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
7 Pu239 141.657 1133.140 8.405 .092 .218 5775 1.31% 1 .1032
8 Pu239 143.350 1146.687 8.418 .092 .218 3309 1.31% 1 .0591
9 Pu239 144.211 1153.576 8.424 .091 .218 55907 1.38% 1 1.0000
10 Pu239 146.077 1168.508 8.439 .091 .218 24897 1.35% 1 4453
11 Am241 146.557 1172.348 8.442 .091 .218 10680 7.01% 2 1.0000
12 Pu241 148.567 1188.375 8.458 .091 .218 134405 0.62% 3 1.0000
13 Am241 150.110 1200.782 8.469 .090 .218 1861 7.06% 2 .1742

region 4 from channel 1213 to 1232

151.600 kev to
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total net counts = 4359.0

Qfit = 4.213e-001 R**2 = .67055 Cond = 1.000e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
14 Pu238 152.720 1221.672 8.489 .090 .218 4677 16.39% 1 1.0000
region 5 from channel 1305 to 1335 ( 163.100 kev to 166.900 kev)

total net counts = 53226.7

Qfit = 3.365e-001 R¥*2 = .99595 Cond = 1.131e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
19 Pu241 164.597 1316.651 8.581 .087 .218 50424 1.67% 1 1.0000
20 Am241 164.597 1316.732 8.581 .087 .218 2365 l1.61% 1 .0469
21 Am241 165.930 1327.397 8.591 .087 .218 1258 63.42% 2 1.0000
region 6 from channel 1270 to 1300 ( 158.700 kev to 162.500 kev)

total net counts = 70444.3

Qfit = 6.353e~001 R**2 = .98754 Cond = 1.288e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
15 Pu241 159.955 1273.579 8.545 .088 .218 6418 1.67% O .1272
16 Pu239 160.190 1281.459 8.547 .088 .218 2156 1.99% 2 .0540
17 Pu240 160.308 1282.404 8.548 .088 .218 29354 2.77% 1 1.0000
18 Pu239 161.482 1291.800 8.557 .088 .218 39913 2.09% 2 1.0000
region 7 from channel 1348 to 1382 ( 168.500 kev to 172.700 kev)

total net counts = 52026.6

Qfit = 4.227e-001 R**2 = .99142 Cond = 1.042e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
22 Am241 169.567 1356.497 8.619 .086 .218 7018 11.40% 1 1.0000
23 Pu239 171.372 1370.939 8.633 .086 .218 44924 1.86% 2 1.0000
region 8 from channel 1614 to 1641 ( 201.800 kev to 205.100 kev)

total net counts = 390594.8

Qfit = 7.147e-001 R**2 = .99980 Cond = 1.000e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
24 Pu239 203.545 1628.355 8.883 .079 .218 392456 0.25% 1 1.0000

86




.

PC/FRAM-UM-006 PC/FRAM User Manual February 23, 1999

region 9 from channel 1646 to 1686 ( 205.800 kev to 210.800 kev)
total net counts = 1306174.8
Qfit = 2.998e+000 R**2 = .999%0 Cond = 1.000e+000

pk isotope energy centroid fwhm tamp tslp area error fn factor

25 Pu241 208.000 1664.021 8.917 .078 .218 1244624 0.11% 1 1.0000

26 Am241 208.000 1664.000 8.917 .078 .218 60817 0.06% 1 .0488
region 10 from channel 2031 to 2055 ( 253.900 kev to 256.899 kev)
total net counts = 91378.9
Qfit = 7.903e-001 R**2 = .99780 Cond = 1.000e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
27 Pu239 255.380 2043.110 9.281 .070 .218 92027 0.76% 1 1.0000
region 11 from channel 2101 to 2156 ( 262.600 kev to 269.500 kev)
total net counts = 106675.7
Qfit = 8.923et+001 R**2 = .99705 Cond = 1.,798e+308
pk isotope energy centroid fwhm tamp tslp area error fn <factor
28 Pu239 263.930 2111.523 9.346 .068 .218 32182 1.93% 1 1.0000
29 264.850 2118.884 9.353 .068 .218 0 >99.99% 2 1.0000
30 Pu239 265.700 2125.686 9.359 .068 .218 1971 1.84% 1 0612
31 Pu24l1 267.540 2140.408 9.373 .068 .218 70437 0.91% 3 1.0000
32 Am241 267.540 2140.408 9.373 .068 .218 3515 0.83% 3 .0499
region 12 from channel 2481 to 2510 ( 310.100 kev to 313.700 kev)
total net counts = 56576.2
Qfit = 9.217e-001 R**2 = .99433 Cond = 1.000e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
33 Pu239 311.740 2493.915 9.704 .061 .218 41404 0.11% O .0405
34 311.887 2495.091 9.705 .061 .218 57088 1.00% 1 1.0000
region 13 from channel 2714 to 2778 ( 339.300 kev to 347.300 kev)
total net counts = 1144747.9
Qfit = 1.557e+000 R¥*2 =  ,99991 Cond = 2.180e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
42 340.450 2723.535 9.914 .057 .218 5329 8.93% 1 1.0000
43 Pu239 341.495 2731.893 9.921 .056 .218 119333 0.06% 2 .1169

44 Pu238 345.011 2760.024 9.947 .056 .218 1020602 0.11% 2 1.0000
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region 14 from channel 2642 to 2712 ( 330.300 kev to 339.000 kewv)

total net counts = 298544.4

Qfit = 1.268e+000 R**2 = .99829 Cond = 1.154e+001
pk isotope energy centroid fwhm tamp tslp area error fn factor
35 Pu241 332.387 2659.048 9.855 .058 .218 155879 0.41% 1 1.0000
36 Am241 332.387 2659.048 9.855 .058 .218 26201 0.34% 1 1680
37 Pu239 332.845 2662.711 9.858 .058 .218 883974 0.11% O .8661
38 Pu241 335.422 2683.321 9.877 .057 .218 13991 3.50% 2 1.0000
39 Am241 335.422 2683.321 9.877 .057 .218 97670 4,10% 2 6.9809
40 Pu238 336.096 2688.712 9.882 .057 .218 200500 0.11¢ O .1964
41 337.720 2701.701 9.8%94 .057 .218 4426 10.92% 3 1.0000
region 15 from channel 2922 to 2983 ( 365.300 kev to  372.900 kev)

total net counts = 437264.6

Qfit = 1.980e+000 R**2 = .99928 Cond = 7.455e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
45 Pu239 367.036 2936.300 10.105 .053 .218 169478 0.36% 1 1.0000
46 Pu239 368.536 2948.306 10.116 .053 .218 177716 0.36% 1 1.0486
47 Pu241 368.605 2948.858 10.116 .053 .218 7245 6.15% 2 1.0000
48 Am241 368.605 2948.858 10.116 .053 .218 50539 6.82% 2 6.9757
49 Pu241 370.934 2967.499 10.133 .053 .218 17632 2.62% 3 1.0000
50 Am241 370.934 2967.499 10.133 .053 .218 11674 2.58% 3 .6621
51 372.449 2979.633 10.144 .052 .218 5455 8.21% 4 1.0000
region 16 from channel 2984 to 3025 ( 373.000 kev to 378.100 kewv)

total net counts = 3193027.8

Qfit = 1.031le+001 R**2 = .99992 Cond = 3.447e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
52 Pu239 375.042 3000.379 10.162 .052 .218 3149942 0.06% 1 1.0000
53 Am241 376.590 3012.761 10.173 .052 .218 42031 1.04% 2 1.0000
region 17 from channel 3026 to 3086 { 378.200 kev to 385.800 kev)

total net counts = 1172914.7

Qfit = 4.389e+000 R**2 = .99978 Cond = 1.916e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
54 Pu239 380.170 3041.394 10.199 .051 .218 628651 0.14% 1 1.0000
55 Pu239 382.743 3061.973 10.217 .051 .218 536128 0.15% 2 1.0000
56  Am241 383.740 3069.947 10.224 .051 .218 5138 7.15%¢ 3 1.0000
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region 18 from channel 3115 to 3170 ( 389.400 kev to 396.300 kev)
total net counts = 1170181.9
Qfit = 1.024e+003 R**2 = .99987 Cond = 1.798e+308
pk isotope energy centroid fwhm tamp tslp area error fn factor
57 Am241 3590.540 3124.335 10.272 .050 .218 0 >599.99% 1 1.0000
58 Pu239 392.525 3140.211 10.286 .050 .218 405930 0.10% 2 .5350
59 Pu239 393.120 3144.970 10.290 .050 .218 758668 0.12% 2 1.0000
region 19 from channel 3274 to 3345 ( 409.200 kev to 418.100 kev)
total net counts = 3354384.1
Qofit = 1.946e+001 R¥*2 = .99996 Cond = 6.546e+000
pk isotope energy centroid fwhm tamp tslp area error fn factor
60 Pu239 411.150 3289.176 10.416 .048 .218 14944 0.01% 1 .0045
61 Pu239 413.712 3309.683 10.434 .047 .218 3292167 0.06% 1 1.0000
62 414.870 3318.933 10.442 .047 .218 26175 1.16% 2 1.0000
63 415.760 3326.054 10.448 .047 .218 18493 1.50% 3 1.0000
region 20 from channel 3592 to 3628 ( 449.000 kev to  453.500 kev)
total net counts = 456331.6
Qfit = 2.335e+000 R**2 = .99985 Cond = 1.000e+000
pk isotope energy centroid- fwhm tamp tslp area error fn factor
64 Pu239 451.474 3611.845 10.693 .043 .218 456620 0.15% 1 1.0000
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Appendix A. Analysis Methods

The analysis of a gamma-ray pulse-height spectrum by the PC/FRAM code can be conveniently described in
two parts, 1) The Internal Calibration, 2) The Analysis of the spectral data

The discussion below assumes that the spectral data is in computer memory.

A.l. Internal Calibration

The internal calibration uses selected peaks in the spectrum under analysis to provide an internal
calibration of energy vs. channel, FWHM vs. channel, and peak shape (tailing parameters) vs. channel.
This means that the analysis does not depend on parameters determined from other measurements that may
have been taken with different conditions of count rate, resolution, or electronic adjustment. The internal
calibration is performed with the same unknown spectrum that is under analysis.

There may be special cases where the spectral quality or the absence of strong peaks to use for calibration
precludes using the unknown spectrum for its own peak calibrations. In these cases one can fix the peak
calibration parameters to their initial values in the parameter set. The appropriate portion of the internal
calibration is bypassed in this case.

Al.l

Al2.

A13.

Energy Calibration:

The first portion of the internal calibration procedure calibrates energy vs. channel number from a list
of peaks, usually strong singlets, in the parameter set. A piecewise linear calibration between pairs of
peaks is used for the energy calibration. The peaks are located using the default gain (keV/ch) and
zero (keV at channel 0) in the parameter set. The algorithm locates the peak at the maximum count

found in a region of 10 channels on either side of the default peak position. This position is found
using the default gain and zero.

The centroid is found using a least squares fit of a quadratic function to the logarithm of the counts. If
there is an error in the calculation the peak is not used in the calibration. Calibration outside the range
of the peaks in the parameter set is extrapolated from the nearest two points.

Initial Background:

A background is now calculated for all peak regions defined in the parameter set using the background
shape for each region that is specified in the parameter set.

FWHM Calibration:

The full width at half maximum (FWHM) of the FWHM peaks in the parameter set is calculated from
the net data after a channel by channel subtraction of the initial background. The FWHM is calculated
from a least-squares fit of a quadratic to logarithm of the net counts. The fit is over a range of
channels in which the counts exceed 75% of the peak maximum on the low-energy side and exceed
25% of the peak maximum on the high-energy side. This fit also yields the peak centroid and if there
is a match with an energy calibration peak (very likely) the centroid of the energy calibration peak is
updated.
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The FWHM as a function of energy used in calculating the response function of an arbitrary fitted
peak is found from a least squares fit to the function

FWHM(E) = SORT[A] + (A2 *E) + A3/E]

A.1.4. Shape /Tail Calibration

The shape of a gamma-ray peak in the spectrum is described by a central Gaussian component with a
single exponential tail on the low energy side of the peak.

" Y(J) = Ht*exp[a*( - x0)2] + Tail(J)

where

Y(J) is the net count in channel J

Ht is the peak height at the peak centroid xQ

o= 2.77259/FWHM2 the peak width parameter
and the tailing parameter Tail(J) is given by

Tail()) = Ht*exp[(TI+T2*E) + (T3+T4*E)*(J=xg)] * [ 1 - exp(-0.4*a*(J-xp)?]

Here we have allowed both the amplitude and slope of the tailing function to be a function of energy.
In practice we set T4 to zero reducing the number of unknowns to three. Afier subtracting the
Gaussian portion of the peak (known because we have calibrations for energy and FWHM), we
combine the data from all the FWHM peaks on the low energy side of the peak from 0.5 to 1.5
FWHMs from the peak center to determine the slope and amplitude constants in a least squares fit.

At this point we have completed the internal calibration and have all the parameters necessary to
calculate the shape of a gamma ray peak at any location in the spectrum.

A.2. Analysis of the Spectral Data

The analysis proceeds on a region-by-region basis in the order that the regions are presented in the
parameter set. The program makes three passes or iterations through all the regions. The regions are
generally analyzed in order of increasing energy, however, if a region has a peak fixed to a second peak
outside of the region, it is desirable to analyze the second region first so all peaks fit in 2 given region use
the most current data. You do this ordering when constructing the regions in the parameter set.

The analysis starts by subtracting the background to get the net counts in a region. The background for the
first iteration is available from the initial background calculation done during the calibration phase.

These are the steps taken during each iteration of the analysis phase:

91



PC/FRAM-UM-006 PC/FRAM User Manual February 23,1999

A.2.1. Calculate Peak Areas
For each of the regions defined in the parameter set being used, perform the following:
Establish the start of the region, the end of the region, and the number of peaks in the region.
Make sure that a background has been calculated for the region that uses all the latest information.

Allocate enough dynamic memory for a least squares fitting of the response functions. Then initialize
all the arrays used in this analysis. In particular, set the values of the output array to the net counts in
the region.

Construct a set of response functions by examining each peak that contributes to this region. There
will be as many response functions as there are free peaks in the region, and each one of the response
functions will have the form

X fiRi(%)

where each R; is a unit area function describing the shape of a photo peak and fj is the associated area
factor. One of the terms in this sum will correspond to a given free peak; its area factor is set to one.

The other terms in the sum will correspond to peaks, which are fixed to this free peak. If peakiis
fixed to peak j, the area factor will be

fi = (Bri/BR))(RE{/RE) (RARA)

where BR = branching ratio, RE = relative efficiency, and RA = relative activity. This defines the
ratio of the area of peak i to the area of peak j. The relative activity is the ratio of the activity of the
given isotope to that of the first isotope in the isotope list in the parameter set. The relative activity
ratio above is set to unity for the first iteration.

If a peak in the region is fixed to one outside the region, its photo peak function R(x) is multiplied the
product of the area factor and the previously determined area of that other peak. These values are then
subtracted from the values in the output array. Thus, this peak is effectively stripped off or removed
from the spectrum.

Compute the final weights to be used in the least squares fitting.

Perform the weighted least squares fitting of the response fingerprints for the free peaks to the adjusted

(adjusted for stripped peaks) net counts. If the area of any of the peaks turn out to be negative,
perform another least-squares analysis, forcing them to be zero this time around. The coefficients
resulting from the analysis will be the areas of the free peaks.

Calculate the predicted responses and save for display and output.
Calculate from the coefficients the areas of all the peaks and appropriate values for their errors.

If this is not the last iteration, use the results so far to update the background offsets.
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A.2.2. Calculate Relative Efficiencies

From the parameter set determine how many peaks are to be used in calculating the relative efficiency
curve. This will be the number of data points used in the least-squares analysis.

Determine the number of isotopes, N, represented by the above peaks. Determine the number of
efficiency functions, M, represented by these isotopes. The number of parameters used in the least
squares analysis will be 5 + (N-1) + (M-1).

Set up the arrays for a least-squares analysis.

The design matrix is constructed to reflect the model
In(Area/BR) = cj + c)/E2 + c3(InE) + c4(lnE)2 +c5(InE)3 +¢; + cj/E

where E is the energy in MeV. Each c; is associated with isotopes beyond the first one; i ranges in
value from 6 to 5+(N-1). Each j is associated with an efficiency function beyond the first one; j

ranges in value from 6+(N-1) to 5+(N-1)+(M-1)

Each weight is set to the reciprocal of the square of the relative error in the associated peak area.
Each output array value is the logarithm of the associated peak area divided by its branching ratio.
Perform the least-squares analysis.

For every peak in the parameter set, compute a relative efficiency by using the first 5+(N-1) terms in
the above model. In addition, if a peak is associated with an isotope which is assigned an efficiency
function other than one, compute its heterogeneity factor, h = exp(cJ-/E), then multiply its relative
efficiency by h.

A.2.3. Calculate Relative Activities

From the parameter set determine how many peaks are to be used in calculating the relative activities.
This will be the number of data points used in the least-squares analysis. The number of parameters
will be the number of isotopes in the parameter set.

Set up the arrays for a least-squares analysis.

The design matrix is constructed to reflect the model
Area= 2 ci 2 (BR)(RE)

where the outer sum ranges over the isotopes and the inner sum includes the peak belonging to that
isotope and any other peaks summed with it.

The weights are the reciprocals of the sum of the squares of the errors associated with the peak areas.
The outputs are the areas of the peaks.

Perform the least-squares analysis. The resulting coefficients are the relative activities. From these
and the half lives and atomic masses of the isotopes, compute relative masses for each isotope.
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A.2.4. Calculate Isotopic Fractions

After the third iteration is complete the final relative masses (relative to the first isotope in the isotope
list) are combined to give the absolute isotopic fractions without 242py. The fractions are
renormalized accounting for 242Pu computed by correlation or fixed by operator entry. Non Pu
isotopes are quantified relative to total Pu when analyzing Pu-bearing samples. For samples (except
uranium only) containing no plutonium the final results are the relative masses themselves.

Auxiliary results such as effective specific power and effective 240py fraction are computed from the
plutonium isotopic fractions and appropriate constants in the parameter set.
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Appendix B. Files for PC FRAM

This appendix describes all the important files associated with PC/FRAM.

B.1. Input Files -

This section describes all the files that are created external to the software but are used by the software.

B.1.1. pefram.ini

Configuration file: This file is provided in the distribution kit. Initially it contains a minimal amount
of information about the system. Every time the general defaults are modified and saved, however,

this file gets overwritten with the most recent settings.

This file is also used to store default responses for all the major dialog boxes presented to you when
invoking menu options. Every time these defaults are modified and saved, this file gets overwritten

with the most recent values.

Reprinted below is an example of what is contained in this file:

/* pcfram.ini configuration file for PC FRAM */

[general]

disk low = 5

disk _critical = 4

language choice =1

max_channels. = 8192

max iterations = 3

mca_type = "ORTEC"

mcb _det_id =1

mchb_det_desc = ""

mcb_log errors = 1

mcb_log path = "c:\fram32\mcberr.log"
pcfram path = "c:\fram32"
save_spectrum path = "c:\fram32\spectra"
save_results path = "c:\fram32\results"
system_id = "My System"

date_template = "dd-MMM-yyyy"
m3ca_high voltage = 0

[file_open]
filespec = ""
format_index = 1

[file save]
filespec = ""
format_index = 1
separator = 0
num_cols = 10

[autocyclel]
num_cycles = 1
filespec = ""
format_index = 0
pu242 opentry = 0
pu242 weight = 0
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operator id = ""
save_results = 0
results_file =
print_results = 0

print_level =1

pset_name = ""

sample power = 0

sample_date = "" -

[acquire]
count_time = 60
live_time = 1

num cycles = 1
pset_name = ""
save_spectrum = 0
spectrum file = "

[measure]
sample_id = ""
operator_id = ""
comment = "
‘pu242 opentry = 0

pu242 weight = 0
sample power = 0
sample date = "9"
count_time = 100

live_time = 0

num cycles = 1
print results = 0
print level =1
pset name = "
save_spectrum = 0
spectrum file = ""
save results = 0
results_file = "*

B.1.2. pcfprms.con

Database file: this file contains all the records storing information about the application constants for
each parameter set.

B.13. pcfprms.fit

Database file: this file contains all the fitting parameters for each parameter set.

B.1.4. pcfprms.iso

Database file: this file contains all the records storing information about the isotopes for each
parameter set.

B.1.5. pefprms.pks

Database file: this file contains all the records storing information about the gamma-ray peaks for
each parameter set.
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B.1.6. pcfprms.zrgs

Database file: this file contains all the records storing information about the regions of interest for
each parameter set.

B.1.7. Parameter files

-

Each of these files contains a sample set of parameters. Each one is a text file and has an extension of
“pst”. In order to get the information in a file into the database, you need to make use of the import
option in the change parameter utility.

B.1.8. Language files

The character strings that are displayed on the screen or sent to the printer are stored in either the
primary language file, pcfram. 1st or the secondary language file pcfram.2nd. The distribution
kit contains a pair of these files with English strings in the primary language file and Russian strings in
the secondary language file. Each line that identifies a string consists of 2 name beginning with sz
then a comma, then the corresponding string. A string that consists of several parts will be enclosed
within quotation marks.

Reprinted below is a listing of what is contained in the primary language file in the distribution kit.

[generall],

szCpuTitle,Change Parameter Utility
szFirstLanguage, English

szFramTitle, PC/FRAM

szMonthsInYear, JanFebMarAprMayJunJulAugSepOctNovDec
szNotImplemented, Not implemented.

szSecondLanguage, Russian

[dialogs],

szDbxAbort,Abort

szDbxAcquire, acquire
szDbxAm241Fraction, ppm Am241/Pu
szDbxAmStartDate, Initial Am date
szDbxARTitle,Analysis Results

szDbxBack, <&Back

szDbxBrowse, &Browse...

szDbxCancel, &Cancel

szDbxCEATitle, Edit Application Constants
szDbxCECTitle, Edit Region Information (by channel)
szDbxCEETitle, Edit Region Information (by energy)
5zDbxCEFTitle, Edit Fitting Parameters
szDbxCEITitle,Edit Isotope Information
szDbxCEPTitle, Edit Peak Information
szDbxCFATitle, Save Parameter Set
szDbxCFETitle, Export Parameter Set
szDbxCFITitle, Import Parameter Set
szDbxCFMTitle, Remove Parameter Set
szDbxCFNTitle, New Parameter Set
s5zDbxCFOTitle, Open Parameter Set
szDbxCFRTitle, Rename Parameter Set
szDbxCheckSum, checksum:
szDbxCommaSeparator,Comma separator
szDbxComment , Comment :

szDbxContinue, &Continue
szDbxCountTime, Count Time (s):
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szDbxCycle, cycle:

szDbxDate, Date

szDbxDates,dates

szDbxDateTemplate,date template:
szDbxDefaultPath, PC FRAM default path:
szDbxDeleteRow, Delete this row

szDbxDescription, Description:

szDbxDFTitle,MCB - Dummy File -
szDbxDiagnosticPrint, Diagnostic information
szDbxDiscard, Discard

szDbxDiskCritical,Disk critical level (Mb):
szDbxDiskWarning,Disk warning level (Mb):
szDbxDisplay, &display.. .

szDbxDisplayPrms, Display parameters?
szDbxDspEcalPeaks,ecal peaks
szDbxDspFcalPeaks, fcal peaks

szDbxDspRegions, regions

szDbxDspScalPeaks, scal peaks

szDbxDspSpectrum, spectrum

szDbxDspTitle,Display Choices

szDbxEGTitle,Edit General Defaults
szDbxEnergyCalibration, Default Energy Calibration
szDbxExit, E&xit
szDbxFcalAl, Al
szDbxFcalA2,A2
szDbxFcalA3,A3
szDbxFile,File:
szDbxFileName,File Name:
szDbxFinal, final
szDbxFinalDate, Final date
szDbxFixed, Fixed
szDbxFOTitle,File Open
szDbxFSTitle,File Save As

szDbxFwhmFormula, fwhm(ch) = sgrt( Al + A2*E + A3/E )

szDbxFwhmPrms, Default FWHM constants
szDbxGain,Gain (kev/chan) =
szDbxHATitle, About PC/FRAM
szDbxHLTitle, Choice of Language
szDbxInitial,initial

szDbxInput, input

szDbxInsertRow, Insert a new row
szDbxIsoSum, sum of fractions
szDbxLastModified, Last modified on
szDbxLinearPlot, linear plot
szDbxLiveTime,Live Time

szDbxLoadPrms, Do you want to load parameter information from

szDbxLogPlot, log plot

szDbxLong, Long

szDbxLongPrint, Long -\region details
szDbxM3CATitle,M3CA defaults
szDbxManager,Edit User List
szDbxMATitle, Acquire Data
szDbxMaxChans, Maximum number channels:
szDbxMaxIter, Maximum number iterations:
szDbxMCA, MCA

szDbxMCATitle,MCA Emulator
szDbxMcaType, MCA type

szDbxMcbDefault, Default MCB
szDbxMcbDetector, MCB detector:
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szDbxMcbLogErrors, Log errors
szDbxMcbLogFile,Log file:

szDbxMCBTitle, MCB defaults

szDbxMDTitle,Analyze Data

szDbxMedium, Medium

szDbxMediumPrint,Medium -\eff, act, and peak info
szDbxMMTitle,Measure Sample
szDbxMoveRowDown,Move this row down
szDbxMoveRowUp,Move this row up
szDbxMsgTitle, FRAM. Message
szDbxNegative, negative
szDbxNewName, New Name:
szDbxNewPassword, New Password:
szDbxNext, &Next>

szDbxNo, &No

szDbxNumChan, Number of channels
szDbxNumCols, Number of columns:
szDbxNumCycles, Number of cycles:
szDbx0ODTitle, Display Results
szDbxOETitle, Plot efficiencies
szDbxOFTitle,Display fits
szDbxOITitle, ISOPOW

szDbxOK, &0K

szDbx0OldName, Old Name:

szDbxOpen, &0pen

szDbxOperator, Operator
szDbxOperatorID,Operator ID:
szDbxOPTitle, Plot spectrum
szDbxORTitle, Print Results
szDbxOutput, output
szDbxParameterSet, Parameter Set:
szDbxPassword, Password:
szDbxPlotComponents, Plot components
szDbxPolarity, Polarity:
szDbxPositive,positive
szDbxPowerDate, Date of Power Msmt:
szDbxPrint, &Print

szDbxPrinter, Prin&ter...
szDbxPrintLevel,print level
szDbxPrintPrms, Print parameters?
szDbxPrintPset, Print parameter set
szDbxPrintResults, Print Results
szDbxPsetName, Name for parameter set:
szDbxPsetTitle, FRAM Parameter Sets
szDbxPu238Fraction,wt% Pu238
szDbxPu239Fraction,wt% Pu239
szDbxPu240Effective, Percent Pu240 Effective
szDbxPu240Fraction,wt$% Pu240
szDbxPu24l1lFraction,wt$% Pu24l
szDbxPu242Correlation, Pu242 by correlation
szDbxPu242Fraction, wt$ Pu242
szDbxPu2420pentry, Pu242 by operator entry
szDbxPu242Weight, $ by weight
szDbxPu244Fraction,wt% Pu244
szDbxPuStartDate, Initial Pu date
szDbxRegion, Region

szDbxRegionNum, Region number
szDbxRegions,display regions
szDbxRemoveAll, Remove all parameter sets

-
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szDbxResultsPath, Path for saving results:
szDbxROTitle, Row Operation

szDbxSamplelID, Sample ID:
szDbxSamplePower, Sample Power (W):
szDbxSave, &Save

szDbxSaveResults, Save Results in
szDbxSaveSpectra, Save Spectra in
szDbxScalTl, Tl = =
szDbxScalT2, T2
szDbxScalT3, T3
szDbxScalT4, T4
szDbxShort, Short

szDbxShortPrint, Short -~\summary only

szDbxSimulateMca,Cannot connect to MCA\Do you wish to simulate one?
szDbxSpecificPower, Specific Power (mW/gPu)

szDbxSpectraPath, Path for saving spectra:

szDbxStart, &Start

szDbxStatus, status

szDbxStop, Stoé&p

szDbxStorageFormat, Storage Format:

szDbxSupervisor, Supervisor

szDbxSystemID, System ID:

szDbxTabSeparator, Tab separator

szDbxTailFormula,tail(ch) = H * exp((T1l + T2*E) + (T3 + T4*E)*(ch-x0)) * [1 -
exp (-C* (ch-x0) ~2)]

szDbxTailPrms,Default tailing constants

szDbxTime, time:

szDbxTotalPuy, total grams Pu

szDbxTrueTime, True Time

szDbxUATitle, Access Rights

szDbxUETitle,Edit User List

szDbxUPTitle, Password Change

szDbxUseRecent, Use most recent results

szDbxUserName, User name:

szDbxUseSaved, Use previously saved results

szDbxUVTitle,User Validation

szDbxVerify,Verification:

szDbxVoltage,High Voltage:

szDbxXZoomIn, X <-->

szDbxXZoomOut,X -><-

szDbxYes, &Yes

szDbxYZoomIn,Y <~->

szDbxYZoomQut, Y -><-

szDbxZero,O0ffset (kev) =

[errors],

szErrAbortFram, Abort analysis?

szErrAccessDenied, Access denied.

szErrAlreadyFixed, Another peak is fixed to this one.
szErrAlreadySummed, Another peak is summed with this one.
szErrAnalyze, Do you want to continue with the rest of the analyses?
szErrBadBkg, Suspicious BKG for region
szErrBkgFail,Failed to calculate BKG for region
szErrCancel, analysis cancelled by user.
szExrrCancelBrowse, Browse was canceled.

szErrContinue,Do you want to continue?
szErrCreateDb, New database created.

szErrCreateUaf, User authorization file created.
szErrDataRead, Cannot read this data file.
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szErrDataSave, Cannot save this spectrum.
szErrDiskLow,Warning:\Disk space is low.

szErxrDspEffFail, Cannot display efficiencies.\There is no data.
szErrDspFitFail,Cannot display fits.\There is no data.
szErrDuplicatePset,This parameter set already exists in database.
szErrFileCreate,Cannot create file

szErrFileOpen, Cannot open file

szErrFor, for

szErrFreeSpace, free space (Mb):

szErrFwhmFail, Failed to calculate FWHM for peak
szErrImport, Error while importing parameter set.
szErrInternal, **Internal error in FRAM**

szErrInvalidInput, **Invalid input for FRAM**
szErrInvalidPswd, Invalid password.

szErrInvAmDate, invalid start date for Am

szErrInvDate, invalid final date

szErrInvPeakCh, **Invalid peak channel**

szErrInvPeakFwhm, Invalid FWHM for peak
szErrInvPeakRegion,Invalid region for peak

szErrInvPuDate, invalid start date for Pu
szErrInvPwrDate,invalid date for sample power

szErrInvSum, invalid isotopic fractions

szErrInvTailSlope, Invalid slope for tail at energy
szErrInvTemplate, Invalid date template

szErrLoadCon, Cannot load application constants into memory.
szErrLoadFit,Cannot load fitting parameters into memory.
szErrLoadIso,Cannot load isotope parameters into memory.
szErrLoadPks,Cannot load peak parameters into memory.
szErrLoadPrms,Cannot load parameter set into memory.
szErrLoadRgs, Cannot load region parameters into memory.
szErrLsqFail,Failure in least squares calculations.
szErrNewDatabase, New database {(with no parameters) created.
szErrNoDiskSpace, Insufficient disk space on
szErrNoDrive,No disk drive in the path
szErrNoFileName, File name is missing.

szErrNoMca, This MCA type is not implemented.

szErrNoMcb, No MCB detector!

szErrNoMemory, Insufficient memory available.
szErrNoMorePsets, There is no room for any more parameter sets.
szErrNoPeaks,No peaks found in spectrum.

szErrNoPsetName, Parameter set name is missing.
szErrNoPsets, There are no parameter sets in the database.
szErrNoRegPeak, No peaks in region

szErrNoSampleID, Sample ID is missing.

szErrNoSpectrum, Warning:\there is no spectral data in memory.
szErrNoUser,No such user name in list.
szErrOutputFiles, FRAM output files.

szErrPrint, **print error**

szErrPsetModified, Parameter set has been modified.\Do you wish to save it?
szErrPsetNotOpened, Cannot open parameter set:
szErrPsetNotSaved, Cannot save parameter set:
szErrPsetOpen,Warning:\a parameter set is still open!
szErrPsetRemoved, Removed parameter set:

szErrPsetSaved, Parameter set saved as:

szErrPswdMatch, passwords do not match.

szErrReadUaf,Cannot read user authorization file.
szErrRemoveRll, This will destroy all the datalin the database.
szErrResFail,Failure in computing response function.
szErrResultsFile, results file.
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szErrRowDelete, Cannot delete this row.

szErrRowInsert,Cannot insert a row.

szErrRowMoveDown, Cannot move this row down.

szErrRowMoveUp, Cannot move this row up.

szErrSaveData,Do you wish to save the datalthat has accumulated?
szErrSpecfitFail,Failed to create specfit.dbi

szErrSpectraFile, spectral data file.

szErrTailFail,Failed to calculate tail --will use defaults.
szErrTooFewPeaks, Not enough peaks - will use defaults.

[fonts],

szFonDialog, "MS Sans Serif, 10"
szFonDisplay, Courier
szFonLanguage, English

szFonPlot,MS Sans Serif
szFonPrint, "Courier,8"

[help messages],

szHlpAppconName, Name of this application constant
szH1pAppconNum, Index number for this application constant
szHlpAppconValue, Value for this application constant
szH1pBkglEndCh, Final channel of the first background
szH1pBkglEndEn, Final energy of the first background
szH1pBkglStartCh, Starting channel of the first background
szH1pBkglStartEn, Starting energy of the first background
szH1pBkg2EndCh, Final channel of the second background
szH1pBkg2EndEn, Final energy of the second background
szH1pBkg2StartCh, Starting channel of the second background
szH1pBkg2StartEn, Starting energy of the second background
szH1pBkg3EndCh, Final channel of the third background
szH1pBkg3EndEn, Final energy of the third background
szH1pBkg3StartCh, Starting channel of the third background
szHlpBkg3StartEn,Starting energy of the third background
szH1pBkg4EndCh, Final channel of the fourth background
szHlpBkg4EndEn, Final energy of the fourth background
szHlpBkg4StartCh, Starting channel of the fourth background
szHlpBkgd4StartEn, Starting energy of the fourth background
szH1pBkgType,Which type of background do you want to f£it?
szHlpBranch, Branching ratios (gammas per disintegration)
szH1pCpuEA,Edit the application constants.

szH1pCpuEC, Edit the region information (by channel).
szH1pCpuEE, Edit the region information (by energy).
szHlpCpuEF,Edit the fitting parameters.

szH1pCpuEI,Edit the isotope information.

szH1pCpuEQ, Postpone the edit session.

szH1pCpuEP, Edit the peak information.

szH1lpCpuFA,Write parameter info into database as a new set.
szH1pCpuFC, Destroy the current worksheet.

szH1pCpuFE, Write parameter info in worksheet into a text file.
szH1pCpuFI, Read parameter from a text file into a worksheet.
szH1pCpuFM, Remove a parameter set from the database.
szH1pCpuFN, Create a new worksheet.

szH1pCpuFO, Read a parameter set from the database into a worksheet.
szH1pCpuFP, Send parameter info in worksheet to the system printer.

szH1pCpuFR, Rename a parameter set in the database.

szH1pCpuFS,Write parameter info from worksheet back into database.
szHlpCpuFX, Exit Change Parameter Utility and return to FRAM's menu.

szH1pEA,Modify defaults for the analyze data dialog.
szHlpEditPassword, Change the password for this user
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szH1pEditRights, Change the access rights for this user
szH1pEffFn, "Efficiency function number (1,2,...)"
szH1pEG,Modify the general default settings.

szH1pEM, Modify defaults for the measure sample dialog.
szHlpEnergy, Gamma-~ray energy in kev

szH1pEO,Modify defaults for the file open dialog.

szH1pEP, Invoke the change parameter utility.

szH1pEQ,Modify defaults for the acquire data dialog.
szH1pES,Modify defaults for the analyze spectrum dialog.
szH1pEU,Modify the list of authorized users.

szH1pEV,Modify defaults for the file save dialog.
szH1pFixTo,Which peak is this peak's area fixed to? (0 for none)
szH1pFO,Read spectral data from file.

szH1lpFP,Print contents of this window.

szH1pFS,Save spectral data in file.

szH1pFT, Invoke the dialog for setting printer properties.
szH1pFX, Terminate this program.

szH1pHA, Display version and copyright information.
szHlpHalfLife, Half-life of this isotope )
szH1pHL,Choose the language for screen displays.

szHlpIsotope, Isotope name (xxnnn)

szHlpIsotopeNum, Index number for this isotope

szHlpLineWidth, Intrinsic line width in ev (for X-rays)

szH1pMA, Collect data using MCA.

szHlpMass,Exact mass of this isotope (amu)

szH1pMD,Analyze spectral data from file(s) on disk.

szH1pMM, Collect data using MCA then analyze the spectrum.
szH1pOD,Display results of analysis.

szH1pOE, Plot efficiency curve for the most recent analysis.
szH1pOF, Plot fit results of the most recent analysis.

szH1pOI, Perform isotopic decay corrections.

szH1pOP, Plot most recent spectrum.

szH1pOR, Print results of analysis.

szHlpPassword, Encrypted password for this user
szHlpPeakNumber, Index number for this peak

szHlpPower, Specific power of this isotope (mW/g)
szH1pPu240Coef, Coefficient used to compute effective Pu240 mass
szHlpRegionEndCh, Final channel of the region
szHlpRegionEndEn, Final energy of the region
szHlpRegionNumber, Index number for this region
szHlpRegionStartCh, Starting channel of the region
szHlpRegionStartEn,Starting energy of the region

szHlpRights, Encoded value of the access rights for this user
szHlpRowOperation, "Perform insertion, deletion, shifting of rows"
szHlpSumWith,Which peak is this peak's area summed with? (0 for none)
szHlpUnits, "Units used for the half-life (days,years)"
szHlpUseForAct,Use this peak to construct activity ratios?
szHlpUseForEcal,Use this peak for an internal energy calibration?
szHlpUseForEff,Use this peak to construct efficiency functions?
szHlpUseForFcal,Use this peak for an internal. FWHM calibration?
szHlpUseForScal,Use this peak for an internal shape calibration?
szHlpUserName, Name of the user (maximum of 20 characters)
szHlpUsexrNum, Index number for this user

[menus],

szMenCpuE, &§Edit

szMenCpuEA, &Bpplication constants
szMenCpuEC, Regions by &channel
szMenCpuEE, R&egions by energy
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szMenCpuEF, &Fitting parameters
szMenCpuET, &Isotopes
szMenCpuEO, P&ostpone editing
szMenCpuEP, &Peaks

szMenCpuF, &File

szMenCpuFA, S&ave As
szMenCpuFC, &Close

szMenCpuFE, &Export o
szMenCpuFI, &Import

szMenCpuFM, Re&move
szMenCpuFN, &New

szMenCpuFO, &0pen

szMenCpuFP, &Print

szMenCpuFR, &§Rename

szMenCpuFS, &Save

szMenCpuFT, Prin&ter...
szMenCpuFX,E&xit

szMenE , &Edit

szMenEA, Analyze &Data Defaults
szMenEG, &General Defaults
szMenEM, &éMeasure Sample Defaults
szMenEO, File &Open Defaults
szMenkEP, &Parameters

szMenkEQ, Ackquire Data Defaults
szMenEU, &User List

szMenEV, File Sa&ve Defaults
szMenF ,&File

szMenFO, &Open

szMenFS, &Save As

szMenFX,E&xit

szMenH , &Help

szMenHA, &About

szMenM , &éMeasure
szMenMA, &Acquire Data
szMenMD, Analyze &Data
szMenMM, &Measure Sample
szMenO , &Options
szMenOD, &Display Results
szMenOE, Plot &Efficiencies
szMenOF, Display &Fits
szMenOI, §ISOPOW

szMenOL, &Language
szMenOP, &Plot Spectrum
szMenOR, P&rint Results

[pcfram],

szPcfCalcAct,calculate activities.
szPcfCalcEff, calculate efficiencies.
szPcfCheckCal, check calibrations.

szPcfDone, analysis done.

szPcfEnergyCal, energy calibration.
szPcfFwhmCal, fwhm calibration.
szPcfIsotopics,determine isotopic composition.
szPcflteration,iteration

szPcfPreviewSpectrum, preview spectrum.
szPcfRegion, region

szPcfSetupPeaks, setup peak information.
szPcfSetupRegion, setup region
szPcfSetupRegions, setup region information.
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szPcfShapeCal, shape calibration.

{plots],
szPltChannel, Channel

szPltCounts, Counts
szPltEnergy, Energy
szPltEnergyUnits, keV
szPltFor, for
szPltIsotopes, Isotopes
szPltLiveTime,Live time
szPltRatio,Ratio
szPltRegion,Region
szPltRelEff,Relative Efficiencies
szPltTrueTime, True time
szPltWith,with

[printouts],

szPrtA,this peak is used to determine relative activities.
szPrtActData,Data used for activity calculations
szPrtActivity,activity

szPrtActResults,Results of activity calculations
szPrtAm241Units, (ug/gPu) // abbreviation for micrograms per gram Pu
szPrtAmp,amp // abbreviation for amplitude
szPrtAmplitude, amplitude

szPrtArea, area

szPrtAt, at

szPrtBeta, beta

szPrtBkg,bkg //abbreviation for background
szPrtBkgs,BKG's // abbreviation for backgrounds
szPrtBranch,branch //abbreviation for branching ratio
szPrtCentroid, centroid

szPrtChan,chan //abbreviation for channel

szPrtChannel, channel

szPrtCheckEcal, check energy calibration
szPrtCheckFcal, check fwhm calibration
szPrtCheckInterferences, check for interferences
szPrtCheckSample, Check sample types

szPrtCheckScal, check shape calibration
szPrtCoefficient,coefficient

szPrtComment, comment

szPrtDate,date

szPrtDays, days

szPrtDiagPassed,diagnostics passed.
szPrtDiagTitle,Calibration Diagnostics

szPrtDiff,diff //abbreviation for difference
szPrtDiffSigma,diff/sigma //abbreviation for difference divided by sigma
szPrtE,this peak is used to determine relative efficiencies.
szPrtEcalFixed, Energy calibration fixed with
szPrtEcalTitle, Table used for energy calibration
szPrtEff,eff // abbreviation for efficiency
szPrtEffData,Data used for efficiency calculations
szPrtEffDiv,Efficiencies are divided by
szPrtEffResults,Results of efficiency calculations
szPrtEnergy, energy

szPrtError,error

szPrtEV, ev

szPrtExpDif,exp(dif) // abbreviation for exponential of the difference
szPrtF, this peak is fixed to another peak.

szPrtFactor, factor
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szPrtFail, fail

szPrtFcalFormula, FWHM = SQRT( Al + A2*E + A3/E )
szPrtFcalTitle, FWHM parameter in the formula
szPrtFitCts, fit cts //abbreviation for fitted counts
szPrtFitted, fitted

szPrtFitTo, Fitting to region

szPrtFn,fn // abbreviation for function

szPrtFormula, formula -

szPrtFrom, from

szPrtFwhm, fwhm

szPrtGain, gain

szPrtHfac,hfac //abbreviation for heterogeneity factor
szPrtIndRatios, Individual ratios

szPrtInterp,interp. // abbreviation for interpolated
szPrtIsopowResults, ISOPOW Results

szPrtIsotope, isotope

szPrtKEV, kev

szPrtlLiveTime,live time

szPrtLogABr, log(A/Br) //logarithm of area divided by branching ratio
szPrtMass,mass

szPrtMassPct,mass$

szPrtMassRatio,mass ratio

szPrtMassUnits, g

szPrtNetCts,net cts //abbreviation for net counts
szPrtNoSepTime, cannot compute time since chemical separatlon
szPrtNumChan, num channels

szPrtOperatorID, Operator ID

szPrtPass, pass

szPrtPeak, peak

szPrtPeakAreaRatio,peak area ratio

szPrtPeakSummary, Summary of peak information

szPrtPk,pk // abbreviation for peak

szPrtPowerUnits, W

szPrtPredicted, predicted

szPrtPrmFixed, these parameters have been fixed
szPrtPset,parameter set

szPrtPu240Eff,Effective Pu240 fraction
szPrtPu242Correlation, (By Corr) // abbreviation: by correlation
szPrtPu242Default, (Default)

szPrtPu2420pentry, (OpEntry) // abbreviation: operator entry
szPrtQ,this peak is ued to determine the energy calibration.
szPrtRatio, ratio

szPrtRatios, ratios

szPrtRegion, region

szPrtRegionSummary, Summary of the results for each region
szPrtRelMass, Relative mass

szPrtResultFile, results file

szPrtRSD, $RSD //abbreviation: % relative standard deviation
szPrtS, this peak is summed with another peak.
szPrtSamplePower, sample power

szPrtSaveFile, spectrum file
szPrtScalFormula,log{tail (x) /height/roll_off) = (T1+T2*E) + (T3+T4*E) * (x-x0)
szPrtScalTitle, Shape parameters in the formula
szPrtSeconds, s

szPrtSepTime, Time since chemical separation

szPrtSigma, sigma

szPrtSlope, slope

szPrtSource, spectrum source

szPrtSpecDate, spectrum date
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szPrtSpecificPower, specific power

szPrtSpecPower, Specific Power (W/gPu)
szPrtSPowerUnits, mW/gPu

szPrtSumCts, Sum of the fitted counts

szPrtSystemID, System ID

szPrtT,this peak is used to determine the shape calibration.
szPrtTailFrac,tail fraction

szPrtTamp, tamp //abbreviation for tail amplitude
szPrtTitlel, Isotopic Analysis

szPrtTitle2, (Fixed energy Response function Analysis with Multiple
efficiencies)

szPrtTo, to

szPrtTotal, total

szPrtTotalCounts, total net counts

szPrtTotalPower, $TotPwr

szPrtTotalPu, total Pu

szPrtTrueTime, true time

szPrtTslp,tslp //abbreviation for tail slope

szPrtW,this peak is used to determine the fwhm calibration.
szPrtWeight,weight

szPrtZero, zero

[tables],

szTblBkgEndl, BKG\#1\end
szTblBkgEnd2, BKG\#2\end
szTblBkgEnd3, BKG\#3\end
szTblBkgEnd4, BKG\#4\end
szTblBkgStartl, BKG\#1l\start
szTblBkgStart2, BKG\#2\start

szTblBkgStart3, BKG\#3\start
szTblBkgStart4, BKG\#4\start
szTblBkgType, background\type
szTblBranch, branching\ratio
szTblEffFn,efficiency\function
szTblFixTo, fix\area\to
szTblHalfLife, half-1life
szTblIsotope, isotope
szTblLineWidth, line\width
szTblMass, mass

szThlName, name

szTblPassword, password
szTblPeakEnergy, peak\energy
szTblPower, power\ (mW/g)
szTblPu240Coef, pu240\coefficient
szTblRegionEnd, region\end
szTblRegionStart,region\start
szTblRights, access\rights
szTblSumWith, sum\area\with
szTblUnits,units
szTblUseForAct, used\for\act
szTblUseForEcal,used\for\ecal
szTblUseForEff,used\for\eff
szTblUseForFcal,used\for\£fcal
szTblUseForScal,used\for\scal

szTblUserName, User Name
szTblValue, value

[copyright],

szHACRO1, "This program was prepared by the Regents of the University of"
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szHACRO2,"
szHACRO3, "
szHACRO4, "
szHACROS5, "
szHACROG, "
szHACRO7, "
szHACROS8, "
szHACRO9, "
szHACR10, "
szHATSO01, "
szHATS02, "
szHATSO03, "
szHATS04,"

California at Los Alamos National Laboratory (the University) under”
Contract No. W-7405-ENG-36 with the U.S. Department of Energy (DOE)."
All rights in the program are reserved by DOE on behalf of the U.S."
Government and the University pursuant to the Contract. This program"
should not be copied or distributed outside your organization."
Neither the U.S. Government nor the University makes any warranty,"
express or implied, or assumes any liability or responsibility for the"
use of this program. All copies made of this program must carry"”
this notice."
For technical support of this program contact:"
Thomas A. Kelley, tkelley@lanl.gov"
Thomas E. Sampson, tsampson@lanl.gov"
Safeguards Science and Technology Group”

szHATS05, "Los Alamos National Laboratory."”

B.2. Output Files

This section describes all the files that are generated by the software that are intended to be used by other

software.

B.2.1. saved spectra

When spectral data is stored, it is written to a binary file in the storage format specified by you. If the
data is saved from the ‘acquire data’ option or the ‘measure sample’ option and the number of cycles
was set to one, the name of the file specified by you will be used. If the number of cycles was set to
something larger than one and you specify a name with no extension, the file name will be used, but an
extension of “.snn” will be supplied where nn will be replaced by the cycle number. If, in the latter
case, you supply a name with an extension, the first character of the extension will be used and it will
be appended with the cycle number.

B.2.2.

saved results

When the results of an analysis are stored, they will be stored in a text file. If the results are saved
from the Measure | Analyze Data option or the Measure | Measure Sample option and the
number of cycles was set to one, the name of the file you specified will be used. If the results are saved
from either of these options and the number of cycles was set to something larger than one and you
specified a name with no extension, that file name will be used, but with an extension of “.mn” where
nn will be replaced by the cycle number. If, in the latter case, you supplied a name with an extension,
the first character of the extension will be used and the cycle number will be appended to it.

B.3. Internal Files

In this section we describe all the files created by and used by the software for internal operations.

B.3.1. pcfram.uaf

The user authorization file. This contains information about the users, their passwords, and the
authorizations granted to them.

B.3.2. pcfram.dbi

The results of every analysis are stored in this file. This file is overwritten whenever a new analysis is
performed. This file is used when you ask for a display of the results of the last analysis.

108



PC/FRAM-UM-006 PC/FRAM User Manual February 23, 1999

B.3.3. specfit.dbi
The results of the fitting process during every analysis are stored in this file. This file is overwritten

whenever a new analysis is performed. This file is used when you ask for a display of the fits achieved
in the last analysis.

B.3.4. pcfpset.dbi -

This file stores, in text form, the values of the analysis parameters that were last retrieved from the
database.
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Appendix C. PC/FRAM Parameter Set Descriptions

The versatility of the PC/FRAM code allows it to be used with parameter sets tailored for different applications.
Descriptions of some of the parameter sets in use at Los Alamos follow. They are meant to be illustrative
rather than inclusive and any specific distribution of the code may not include all the files below. Parameter
sets may be found on diskette 3 of the PC/FRAM distribution. Other parameter sets, not listed here, tailored to

specific user applications, may also be available.

Both the DOS filename and the customary parameter set name used at Los Alamos are given for each parameter
set. The “customary parameter set name” may be changed when the file is imported or the parameter set may
be renamed within the PC/FRAM program. It is suggested, however, that the Customary Parameter Set Name
be retained, or, if not, that careful records be retained of the relation between the parameter set name and the

parameter file name. Of course, the parameters may also be changed for the specific application at hand.

New parameter sets, especially for coaxial detector analysis, are under development. Contact the authors for
current information regarding versions of available parameter sets.

C.1. Parameter Sets for Planar Detectors

Parameter sets for planar detectors were the first developed and used for the FRAM code. For historical
reasons, these parameter sets were developed for a gain of 0.1 keV/ch and with an offset of 10 keV (zero
channel = 10 keV). Planar detector parameter sets are now available with a gain of 0.105 keV/channel
with zero offset. These are applicable to a wide range of ADC types including successive approximation
ADCs with only 4000 channels of useful data

A planar detector parameter set with Default Gain of 0.1 keV/ch and a Default Offset of 10 keV can be
easily changed to a Gain of 0.105 keV/ch with and Offset of zero by the following:

Enter the Change Parameter Utility and Open the parameter set to be changed. Save As to a new
name for the new parameter set. Close the old parameter set and Open the newly named parameter
set. Select Edit | Fitting Parameters and under the Default Energy Calibration change the
Gain to 0.105 and the Offset to 0.0.

The only other changes required are to change the channel numbers in the centroid test to match the
new default energy calibration. Select Edit | Application Constants and change
ecal_channel[ i ] to values appropriate for the new default energy calibration.

Typical planar detector specifications are 16 mm dia. by 13 mm deep with a low rate resolution at 122 keV
of <510 eV. Larger planar detectors with 122keV low rate resolution < 570 eV may also be used. There
is little experience with yet poorer resolution planar detectors. We strongly encourage the use of detectors
with the best possible resolution.

Planar detectors have been most widely used with a shaping time constant of 1us, triangular shaping at
count rates up to 40 kHz in conventional analog amplifiers.
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DOS Filename Customary Parameter Set Name at Los Alamos

wro.pst widerange6

Applicability General purpose use for nearly all isotopically homogeneous plutonium-bearing items.
Requires Am/Pu homogeneity and *'Pu-*’U equilibrium.

Detector type: planar -

Default Gain: 0.1keV/ch, Default Offset: 10keV

No. of channels: 4096 (10-420 keV)

24Py range tested: 2-38%

Interference tests: U, *'Np,**Am-*"Np

Sample tests: 241 Am/Pu heterogeneity, Nonequilibrium %'Pu-2"U

Comments: Standard planar detector parameter set for general purpose use. Used for many years
at Los Alamos

DOS Filename Customary Parameter Set Name at Los Alamos

wr6105.pst widerange6.105

Applicability General purpase use for nearly all isotopically homogeneous plutonium-bearing items.
Requires Am/Pu homogeneity and **'Pu-*U equilibrium. Same as widerange6 but
with zero offset and gain = 0.105 keV/ch

Detector type: planar

Default Gain: 0.105keV/ch, Default Offset: 0.0 keV

No. of channels:

24%py range tested:

Interference tests:

Sample tests:

Comments:

DOS Filename

hetero6.pst
Applicability

Detector type:
Default Gain:

No. of channels:

24Py range tested:

4096 (0-430keV)

2-38%

23577, BINp #* Am-*Np

24 Am/Pu heterogeneity, Nonequilibrium **'Pu-*"U

Standard planar detector parameter set for general purpose use. Used for many years
at Los Alamos.

Customary Parameter Set Name at Los Alamos

hetero6

Planar detector for isotopically heterogeneous (Am/Pu) residues. Either equilibrium or
non-equilibrium 2'Pu-2"U.

planar

0.1 keV/ch, Default Offset: 10 keV
4096 (10-420 keV)

4-8%
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Interference tests:

Sample tests:

Comments:

DOS Filename

moxplar.pst

Applicability

Detector type:
Default Gain:
No. of channels:

24Py range tested:

Interference tests:

Sample tests:

Comments:

DOS Filename
eupuplnr.pst
Applicability

Detector type:
Default Gain:
No. of channels:

24%py range tested:

Interference tests:
Sample tests:

Comments:

235U, ?.37Np,243 Am_239Np
None

Uses a second relative efficiency curve for *!Am. Works best for Am > 2000 ppm.
Used to analyze pyrochemical residues with known Am/Pu heterogeneities.

Developed starting with widerange6.

Customary Parameter Set Name at Los Alamos

mox_planar

Planar detector for mixed uranium/plutonium oxides (MOX) with 2*U/Pu ratios less
than ~ 0.3. General purpose use for isotopically homogeneous plutonium and/or
MOX-bearing items. Requires Am/Pu homogeneity and 2'Pu-*"U equilibrium.

planar

0.10 keV/ch, Default Offset: 10.0 keV

4096 (10-420 keV)

6-16%

Z7Np,2*Am-*Np

2! Am/Pu heterogeneity, Nonequilibrium *'Pu-*"U

It is applicable for Z°U/Pu ratios at least as high as 0.3. Biases in the 2*U/Pu ratio
may be present if the two oxides have different particle sizes. For #*U/Pu ratios higher

than ~0.3, use the eupu parameter set.

Customary Parameter Set Name at Los Alamos

eupu_planar

Planar detector for mixed uranium/plutonium oxides (MOX) with 2°U/Pu ratios greater
than ~ 0.3. General purpose use for isotopically homogeneous plutonium and/or
MOX-bearing items. Requires Am/Pu homogeneity and *'Pu-?*"U equilibrium.

planar

0.10keV/ch, Default Offset: 10.0 keV

4096 (10-420 keV)

6%

Z7Np,** Am-*Np

! Am/Pu heterogeneity, Nonequilibrium *'Pu-27UJ

It is applicable for 2°U/Pu ratios greater than 0.15, used for mixed uranium/plutonium
oxides with higher #°U/Pu ratios than the mox_planar parameter set. Biases in the

B5U/Pu ratio may be present if the two oxides have different particle sizes. For 2*U/Pu
ratios lower than ~0.3, use the mox_planar parameter set.
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C.2. Parameter Sets for Coaxial Detectors

Parameter sets for coaxial detectors were developed to tackle problems requiring measurements at higher
energies where the low efficiency of planar detectors does not allow them to be useful. These
measurement problems mainly involve situations where the measured item is placed in a thick-walled
container or shielding for personnel protection has been placed in the container. This attenuates the lower
energy gamma rays (typically those below 200-300 keV) that are often used in plutonium analysis.

Parameters for coaxial detectors have also been developed allowing plutonium analysis starting at ~120
keV, the same range as planar detectors. A coaxial detector can also be used for isotopic analysis of
samples containing only uranium.

Standard measurements with a coaxial detector use 8192 channels with a gain of 0.125 keV/channel and no
offset (spanning a range of 0-1024 keV). This allows the user to measure plutonium in the energy range
from 120-450 keV and 200-800 keV as well as uranium from 0-1024 keV without changing electronics

settings.

Coaxial detectors with an approximate 25% relative efficiency and a low rate energy resolution of <1.75
keV at 1332 keV and < 750 €V at 122 keV have been widely used in these applications.

Coaxial detectors have been most widely used with a shaping time constant of 2ps, triangular shaping at
count rates up to 30 kHz in conventional analog amplifiers.

DOS Filename Customary Parameter Set Name at Los Alamos
coax8k3.pst coax8k125.3
Applicability General purpose use for nearly all isotopically homogeneous plutonium-bearing items

Requires Am/Pu homogeneity and *'Pu-*"U equilibrium. Analyzes gamma rays from
120-450 keV from unshielded or lightly shielded (< ~2 cm steel) items.

Detector type: coaxial
Default Gain: 0.125keV/ch, Default Offset: 0.0 keV
No. of channels: 8192 (0-1024 keV) =

240py range tested: 2-38%
Interference tests:  2°U, ?"Np,**Am-*’Np

Sample tests: 241 Am/Pu heterogeneity, Nonequilibrium 2*'Pu-*"U

Comments: Standard coaxial detector parameter file for general purpose plutonium use. Use
shieldcoax4.2 for samples with more shielding where gamma rays <200 keV are not
present.
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DOS Filename Customary Parameter Set Name at Los Alamos

sc42.pst shieldcoax4.2

Applicability General purpose use for nearly all isotopically homogeneous plutonium-bearing items.
Requires Am/Pu homogeneity and **'Pu-*7U equilibrium. Analyzes gamma rays from
200-800 keV from unshielded or shielded (tested up to 6 mm lead, capability is
probably greater than this) items.

Detector type: coaxial

Default Gain: 0.125keV/ch, Default Offset: 0.0 keV

No. of channels: 8192 (0-1024 keV)

%Py range tested:  2-38%

Interference tests:  2°U, #"Np,?**Am-*’Np

Sample tests: # Am/Pu heterogeneity, Nonequilibrium *'Pu-*"U

Comments: A slight modification of these parameters has been tested on data taken with 13 mm of
lead, analyzing gamma rays from 300-800 keV.

DOS Filename Customary Parameter Set Name at Los Alamos

uloenr.pst U125 _Coax_LowEnrch

Applicability General purpose use for low enriched uranium (up to approximately 50% 2**U), no
plutonium. Measures ?*U, #°U, and *U fractions. Assumes 2*U-**Pa equilibrium.
Works best for enrichments < 20%.

Detector type: coaxial

Default Gain: 0.125keV/ch, Default Offset: 0.0 keV

No. of channels:
35U range tested:
Interference tests:
Sample tests:

Comments:

8192 (0-1024 keV)
0.2-70%

none

none

Coincidence summing losses cause measurement results to be distance dependent for

samples closer than about 5 cm to detector. Use of data acquisition systems with only
8000 channels of useful data require change of default energy calibration to a gain of

0.130 keV/channel.
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Parameter Set Name at Los Alamos

uhienr.pst U125_Coax_HiEnrch
Applicability General purpose use for high-enriched uranium (> 20 % 2°U), no plutonium. Measures

B4y, 50U, and 28U fractions. Assumes **U-2*Pa equilibrium. Works best for
enrichments >20%. Requires the presence of 2*Th gamma rays in the spectrum for
best analysis.

Detector type: coaxial

Default Gain: 0.125keV/ch, Default Offset: 0.0 keV
No. of channels: 8192 (0-1024 keV)

5 range tested:  10-99%

Interference tests: none

Sample tests: none

Comments: Coincidence summing losses causes measurement results to be distance dependent for
samples closer than about 5 cm to detector although this effect is less severe than for
the low enriched parameters.. Use of data acquisition systems with only 8000 channels
of useful data require change of default energy calibration to a gain of 0.130
keV/channel. Uses 2?Th gamma rays in the relative efficiency curve. A known
problem is the severe underestimation of the statistical error of the final results.
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Appendix D. ASCII File Description

You can save spectral data in a text file by selecting the Save as option then choosing ASCII as the storage
format. When doing this, you then must choose either a tab separator or a comma separator. You must also
choose the number of columns that are to be "printed". -

The first 45 lines of such a text file are shown on the next page. This was produced by opening the file
CBNM93B.101 and then saving it as a text file. The tab separator was chosen, and the number of columns was
chosen to be 1. The resulting text file was opened with Microsoft Word, ver. 4.0 and then the first page was
printed.

The first line in the output file displays the name of the file in which the data resides. The next two lines
display information that is usually found in the header portion of the spectral data file. In the second line,
between the commas, are numbers representing the date and time associated with that spectrum. The numbers,
in order, indicate the year, month, day, hour, minute, second, millisecond, and time zone offset. The third line
indicates the live time and true time used in collecting the spectral data. The fourth line is blank. The fifth line
consists of the string “ch” followed by the separator character followed by the string “counts.” The remaining
lines present the spectral data with a channel number followed by one or more columns of channel counts.
Each of the columns in these lines is separated by the special separator character chosen by you (either tab or
comma). The channel number at the left will be the channel number for the first column of counts. If there are
8 columns of counts, for example, the channel numbers will increase in increments in 8.

When you choose to open a data file and selects ASCII as the storage format, PC/FRAM attempts to read the
header information: date, time, live time, and true time. If this fails, it proceeds to the spectral data. Thus, the
header information in lines 1-3 need not be present in the file. But the line with the strings “ch” and
“counts” must be present. PC/FRAM looks for the character between these two strings and assumes that this
will be the delimiter between each column of numbers in the succeeding lines. As the channel counts are being
read the channel numbers actually read are checked against what they ought to be in order to ensure the
integrity of the data.
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Spectral data from C:\PCFRAM\CBNM93B.101l
94,07,15,14,09,44,0000,0

Live time: 3389 True time: 3600
ch counts
0 0 -
1 0

2 12148
3 12067
4 12076
5 11987
6 11889
7 12064
8 12169
9 12630
10 12637
11 12839
12 12974
13 12892
14 12761
15 12875
16 12859
17 12775
18 12643
19 12832
20 12798
21 12489.
22 12769
23 12609
24 12719
25 12775
26 12574
27 12718
28 12581
29 12464
30 12562
31 12534
32 12665
33 12661
34 12785
35 12476
36 12674
37 12584
38 12549
39 12627
40 12410
41 12741
42 12299
43 12756
44 12448
45 12548
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Appendix E. Facility Specific Information

E.1. Introduction

This appendix contains general information that may be used to assist in the operation of a PC/FRAM data
acquisition system in cases where the system has not been provided by Los Alamos and also contains
specific information for one commonly used configuration. As such, the illustrations and descriptions are
meant to be illustrative and are not intended to exclude other implementations of data acquisition systems
that perform to the same standard as illustrated here.

E.2. System Interconnections

Typical electronic system interconnections of a PC/FRAM system are shown on the next page for a
specific installation. While the illustration is for a specific system, other components may also be suitable
as long as the data acquisition formats are compatible with those supported by PC/FRAM. Because
support for various data formats may change with time, please call the authors for information on current
support

The main features of the data acquisition systems we have implemented to date are

* High quality spectroscopy amplifier with baseline restoration, pulse pileup rejection, automatic
Pole-Zero, and available shaping time constants in the range from 1-3 microseconds.

* Fast Analog-to-Digital Converter (450 MHz Wilkinson or < 7 psec fixed)

- Counter-Timer

& Digital Gain and Zero Stabilization

The last two features are not required but increase the assurance of adequate data quality and are highly
recommended.

We have also implemented FRAM with integral digital spectroscopy systems, e.g. ORTEC DSPEC, which
incorporate, in digital form, all of the above components (excluding the counter-timer). Information
obtained to date indicates that the digital systems outperform their NIM module equivalents.

The instruments shown on the next page, as representative of a NIM-based data acquisition system, consist
of standard NIM modules from Canberra (3106D, 2071A) and ORTEC (672, 921) contained in a standard
Nuclear Instrumentation Module (NIM) bin (ORTEC 4001C bin and 4002D power supply or equivalent).
Other combinations of modules of equivalent quality may be used. The MCA shown (921 Spectrum
Master) is one of the MCA’s supported by PC/FRAM. The figure on the next page illustrates how these
modules may be connected.
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Typical System Interconnections
NIM Bin
Front Panel Rear Panel Detector Preamp
HV Output : = ’\\ Bias
H.V. Bias ' HV Inhibit
3106D / Energy
Preamp Power
Inhibit Cable Bundle Test and Timing not used
Linear Input
672 Preamp
Spectroscopy CRM
Amplifier PUR
Busy
Unipolar Uni
] ADCAMIEM
ADC Input :] ?"ual Port
Gate 921 B'ng lngunfg{:ye
Spectrum Computer
Master
Input Dual Port Memory Printer Port
Feed .
Through To System Printer
CRM
2071A
Timer and
B Counter
N Typical
Pu Isotopic System
Interconnections

E.3. System Settings

A description of some typical system settings for plutonium measurements for an 8192 channel, single
coaxial detector system is given on the next page. The maximum count rate for the coaxial detector system
settings on the next page is recommended to be about 30 kHz. The digital stabilizer settings for both
uranium and plutonium are shown. The first settings at 208 and 662.4 keV are recommended because you
can measure most shielded as well as unshielded samples without making any changes. Optional settings

for plutonium when measuring and analyzing data in the 120-450 keV region are also given.

The other widely-used option, a single planar detector system, uses 4096 channels at 0.1 keV/channel with
a 10 keV offset (or 0.105 keV/channel with zero offset in 4000 channels) collecting data from 10-420 keV
(0-420 keV) for plutonium measurements. This gain and offset is historical, allowing an easy conversion
of channel number to energy, and is not required. A slightly lower gain of about 0.105 keV/channel with
zero offset would also work. The planar detector system typically uses a 1ps, triangular shaping time
constant, with zero stabilization at 129 keV and gain stabilization at 413.7 keV for plutonium. Its
maximum count rate is usually limited to < 40 kHz.
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Typical System Settings
(Coaxial detector, 8K ch, 0.125 keV/channel)

H. V. Power Supply
Kilovolts - (see detector requirements)
Polarity: positive (for most coaxial detectors, check
. to be sure)
Voltage dial: 3 (as appropriate)
ORTEC 672 Spectroscopy Amplifier
Coarse Gain: 20
Fine Gain: approx. 11.0
Uni Shaping: Triangle
PZ: Auto
Shaping Time: 2
BLR Rate: Auto
Input: Norm, +
ADC
Gain: 8K
Range: 8K
Offset: 0
Digital Stabilizer
Zero
Peak: 1664 (208 keV) plutonium
Peak: 1034 (129 keV) plutonium (optional)
Peak: 1486 (186 keV) uranium
Gain
Peak: 5299 (662.4 keV) plutonium
Peak: 3310 (413.7 keV) plutonium (optional)
Peak: 8008 (1001 keV) uranium
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E.4. Adjustments for Energy Calibration

The energy calibration should be set at 0.125 keV/channel have a zero offset (channel 0 = 0.0 keV) fora
single coaxial detector system. If this calibration should be disturbed, it may be reset with the following
procedure. (The example is for a coaxial detector with a 0.125 keV/channel gain.)

1. Acquire a spectrum with the digital stabilizer turned off using a source with a wide range of gamma ray
energies up to 1 MeV. A plutonium source is suitable, as is a combination of common radioisotope

sources, such as '*Ba plus ’Cs. Use the MCA emulator for the acquisition without the PC/FRAM

software running.

2. Calculate the correct peak positions for several gamma rays from the sample (or source). The correct
peak positions are calculated by using the known energy of the gamma ray peaks and dividing by 0.125.

peak position in channels = Peak Energy(keV)/(0.125 keV/channel)

3. Use the gain controls on the amplifier to adjust the highest energy peak (preferably in the upper third of
the spectrum) to its proper peak position.

4, Use the zero control on the ADC to adjust the lowest energy peak (preferably in the lower quarter of the
spectrum) to its proper peak position.

5. Iterate on these adjustments, as they are interdependent, until the two peaks are within approximately
one channel of their desired location.

6. When these adjustments are complete, you may turn the stabilizer on.

E.5. Other Manuals

In addition to this manual, the system’s individual modules will have their own manuals. Consult these
manuals for instructions on setting up and using the individual system components.

E.6. Data Acquisition Considerations

Filters

Measurements on plutonium-bearing items usually need filters attached to the front of the detector end cap.
The purpose of the filters is to attenuate the very strong 59.5 keV gamma ray from ' Am, nearly always
present in plutonium, If this peak is too intense random summing with x-rays and gamma rays around 100
keV will disturb the spectrum in the 150-170 keV range. Filters are usually made from Cd or Sn. We find
that 2 mm of Cd is sufficient for nearly all plutorium samples and while thinner filters may be used for
some items, we find it most convenient to use the same thickness for all items. A rule of thumb is that the
height of the 59.5 keV gamma ray from ** Am should be attenuated to approximately the same intensity as
or lower than the intensity of the gamma rays and x rays in the 100 keV region. Thinner filters may be
used for uranium although all uranium measurements should use at least a 0.8 mm thick Cd (or equivalent)
filter. Often a thick container (e.g. UF, cylinders) provides its own filter.
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Shaping Time Constants

The choice of amplifier shaping time constants in systems with analog amplifiers is always a tradeoff
between throughput and resolution. Most HPGe detectors exhibit their best resolution when operated at a
time constant around 6 ps. This time constant is too long to use with plutonium measurements because
throughput suffers unacceptably. The compromises that we suggest are to use 2 us, triangular shaping for
coaxial detector measurements and 1 ps triangular shaping for planar detector measurements. You may
make measurements of resolution and throughput vs. incoming count rate to view these tradeoffs and make
your own choices. For systems without a counter/timer you may make percent dead time your independent

variable. We suggest maximum counting rates of 40 kHz under these conditions for planar detectors and
30 kHz for coaxial detectors.

Shielding

Isotopic measurements must be made with full recognition of the existing background conditions with
shielding being supplied for the detector under most all measurement conditions. FRAM is used best with
significant shielding, especially when carrying out measurements that need high-energy gamma ray
analysis. Shielding thicknesses of 5 cm of lead are routinely used.
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Appendix F.  Test File Data

The following table gives the accepted isotopic values and some sample and data acquisition parameters for the
test spectra enclosed with the manual.

-
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Appendix G. Technical Support

Questions, comments, and trouble reports for this program should be directed to:

Thomas E. Sampson

Group NIS-5, MS-E540

Los Alamos National Laboratory
Los Alamos, New Mexico 87545
USA

phone: 505-667-6968

fax:  505-665-4433

email: tsampson@lanl.gov
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Thomas A. Kelley

Group NIS-5, MS-E540

Los Alamos National Laboratory
Los Alamos, New Mexico 87545
USA

phone: 505-665-5684

fax:  505-665-4433

email: tkelley@lanl.gov
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